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Tutorial Instrument Index
To help you better learn how to work with the Instrument Editor, we have included a 
few tutorial samples for some of the chapters.  Most of these can be found in the “Editor 
Tutorial Files” directory.   For the Pattern Alternator & Legato Mode Rule, you will also be 
referred to the Vienna Symphonic Library (VSL) demo instrument directory.

The following sections will refer you to some tutorial samples.

How to Create Dimensions p.95
Bass-Sustain f folder
Bass-Sustain p folder

How to Map Samples - Advanced p.115
Tutorial Drum Kit folders

How to Use the wizard Tool p.150
Tutorial Electric Piano folders

How to Use the wizard Tool p.156
Tutorial Bass folders

Legato Mode Rule p.361
Example .wav audio files in Legato Mode folder

Legato Mode Rule p.363
Vienna Symphonic Library demo instruments folder

Pattern Alternator Rule p.371
Vienna Symphonic Library demo instruments folder

 Have fun!
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The GigaSutudio Instrument editor is a separate program that works with GigaStudio.
This programallows you to create your own instrument or editexisting Giga 
instruments.

GigaStudio 3.0 Instrument Editor

The Instrument Editor has a bunch of new features for 3.0.  The basic interface looks and 
operates very similar to theearlier versions but it is now allot more convenient to work 
with when editing & designing Instruments.  In this section we will briefly describe
these new features and how to use some of them.  These are all covered in detail in rest 
of this manual. 
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How to open the Instrument Editor:
There are several ways to open the Instrument Editor depending on what you want to 
do and from where you want to launch it.  

Opening the Instrument Editor from the GigaStudio Interface:

1. To open the Instrument Editor with a blank empty gig file, click on the [In-
strument Editor] button.  

The button is in the menu bar in the upper left section of the GigaStudio.

2. If you want to edit a loaded instrument in the Instrument Editor, [right-click] on that 
loaded instrument and choose [Edit…]

The Instrument Editor will open with the selected instrument loaded.  

Note:  The Instrument Editor will have to load the entire .gig file associated with the se-
lected instrument.  If the entire .gig file is not already loaded into the GigaStudio  (buff-
ered into RAM) then the Editor will take the time to load it for you.  This can take a few 
moments if the instrument is large or complex. 
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Opening the Instrument Editor from the Windows Desktop:

You can open and use the Instrument Editor without having the GigaStudio Interface 
running.  This is a good way to work when doing intense instrument construction.

1. You can launch the Editor from the Windows Start Menu. 

2. You can launch the Editor by [double-clicking] on a shortcut on the desktop.  

The installation of GigaStudio will create this shortcut if you select the option that al-
lows it to create a shortcut on the desktop.  

To create a shortcut manually, navigate to the Editor (or 
any application you wish to create a shortcut for) from 
the “Windows Start Menu” Instead of clicking on it and 
launching the program, hold down the [control key] and 
drag it out to the desktop.  You can also right-click and 
choose [create shortcut] from the menu.

You can also drag the shortcut to the Windows toolbar and then launch the Editor with 
a single click on that icon.  
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3. Last but not least, you can launch the Editor by [double-clicking] on a .gig file from the
Windows Desktop.

This will launch the editor and load the selected .gig file.  

You can load multiple .gig files by selecting several of them and hitting the [Enter] key.
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What’s New?

Until now, the note range of a Key-
Switch Dimension was entered 
numerically in the Instrument 
Properties window.  

You can still assign this here but 
it’s much easier to use the new 
Key-Switch Region in the Region 
Window.  

This shows up as a purple col-
ored region that can be moved 
anywhere on the keyboard and 
stretched just like any other re-
gion to assign the Key-Switch note 
range.  

If there are no Key-Switch dimen-
sions, this region is gray. 

New Key-Switch Regions:
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Graphical Wave-Form display with Parameters:
Now you can see the actual sample waveform of any sample you have selected.  Also, 
various editing parameters are displayed on top of this waveform view and many can 
be edited directly from this window.  

This allows you to accurately adjust things like the ADSR envelopes on top of the sam-
ple waveform and visually see where the “in and out points” are on the sample.  

The edit graphics that show up on top of the waveform view will correspond to the edit-
ing parameters that are currently selected in the editor.  

Example: Pitch LFO Parameters Selected.

This feature is enabled or disabled in the View Menu. 

Example: ADSR Parameters Selected.
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Tall Velocity Window:

We now have the option of using a Tall Veloci-
ty Window that spans the height of the whole 
screen for those cases where you have a lot of 
velocity splits.  This is much quicker and more 
intuitive than having to scroll up & down a 
shorter window.  

This feature is enabled or disabled in the 
View Menu.  
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New Status Bar:

The status menus that are part of the Main GigaStudio Interface are now visible with 
the new Status Bar.  

Audio Card

Voice Polyphony & Voice Peak Count

MIDI Port Lights

Amount of RAM used

Temp Space Available

Amount of Temp Space being used

This feature is enabled or disabled in 
the View Menu.
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Easily Switch the order of Dimensions:
You can now easily change the order of Dimension and Velocity Splits using the [Up & 
Down] buttons in the Dimension Controller Windows.  This is much faster than the old 
method of disassembling the instrument and reassembling it in a different order.  

Just open a Dimension Controller Window and select the dimension names and move 
them up & down in the list until they are in the preferred order.

Use [Up & Down] Arrows to change the order:

Key-Switch After Reordering the Dimensions:

Key-Switch Before Reordering the Dimensions:
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Delete Specific Dimensions:
You can now choose any specific dimension or dimensions and Delete them in the Di-
mension Controller Window.

Key-Switch Before Deleting:

Select a split and delete it:

Key-Switch After Deleting:
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Add New Dimensions:
Use the [Add] button to Add new splits.  You can add them one at a time or enter a 
number and then hit the [Add] button.

Split Dimensions:
A very handy tool is the ability to Split a dimension.  This creates a clone dimension with 
identical parameters and samples.  This saves having to manually recreate an identical 
split.  To do this, choose a dimension and then use the [Split] button.
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Naming Dimensions & Dimension Descriptions:
It’s a very good habit to start naming your dimensions and entering descriptions as you 
design instruments.  With 256 potential dimensions to keep up with, labeling is now 
more important than ever.   

Once the dimensions and splits are properly named, these names and descriptions will 
show up as you select various dimensions in the Editor.  This is essential to keeping your 
bearings when designing complex instruments.  See the examples below to see differ-
ence.

Here is the same thing without labels: Impossible to find your way around.

Here is a complex mapping that is well labeled: Very obvious and intuitive.
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Names & Dimension Descriptions are entered in the Dimension Controller Window.
To rename a Dimension Split, select it and click on the [Rename] button.  Then enter a 
new name.  To change the Description name, just back over the text under “Description” 
and replace it with something else. 

In this example, The Dimension Description is set to “Sus-Stacc Switch” indicating that 
this dimension switches between long sustaining notes and short staccato notes.

Here is the result:

The Split names are set to “Sustain” and “Staccato”
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More Dimensions:

One of the biggest new features of GigaStudio 3.0 is a drastic increase in the amount 
of dimensions from 32 to 256.   This allows a lot more velocity, MIDI, Key-Switch & other 
dimension switches to be utilized without running out of dimensions.  

A good example of how more dimensions will really help is found in the Vienna Sym-
phonic Library. Due to the large number of switches needed for the VSL legato instru-
ments, they had to come up with some clever and tedious mapping techniques to get 
their wonderful results.   

They had to use up the whole range of MIDI notes (0-127) to fit the extra samples into
the instrument.   This involved mapping samples beyond the range of most keyboards.

They were limited to one velocity split.  

The loud and soft variations had to be split into separate instruments. 

Now, with so many more dimensions, they can have several velocity splits and use less 
notes on the keyboard.  The following examples show a before and after of this.  

These extra dimensions combined with the ability to stack multiple instruments on a 
MIDI channel leave room for the most complex and creative instruments ever.

Example: 8-Velocities/4 Key-Switch/Release Trigger/Mod Wheel Splits
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Legato Instruments with only 32 Dimensions:

Legato Instruments using 256 Dimensions:
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Use Any Number for Dimension Splits:

You can now use any number for Velocity and Dimension splits in the Editor.  In the 
past, you had to deal with 2-4-8-16 or 32 splits but nothing in between.  

If you wanted 3 velocity splits, you had to create 4 splits and then hide one of them.  
Now you can simply create the amount you wish and not have to keep up with a bunch 
of empty dimensions.

You still use the same resources for dimensions but visually; you will only see the ones 
you want.    

For example, lets say you want 5 splits.  In the past, you would have to use 8 splits and 
then make 3 of them empty or duplicates and ignore them. (Or hide them if they were 
velocity splits)  Now with 3.0, you simply create 5 splits and that is all you see and work 
with.  You still use up 8 splits of resources like before but you don’t have to keep up with 
the extras unused splits now and editing is much less cluttered andmore intuitive.  

Example: 5 Velocity Splits and 3 Key-Switch Dimension Splits
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New dimension: Round Robin
This allows different samples to be triggered each time you play a note.  The order is 
pre-determined based on the order of the dimensions.  

In this example, every time you play a note, the articulation would automatically 
change in the order of the dimension.  (Sus-Stac-Sus-Spicc-Sus-Stac-Stac-Stac)

New dimension: Random
This works like the Round Robin but in this case the samples are triggered randomly 
instead of in sequence.

In this example, we have the same sequence of articulations as we had in the Round 
Robin example.  However, the dimension is set to “Random” As you play notes, these ar-
ticulations will automatically change randomly.  

New dimension: Smart MIDI
The Smart MIDI dimension ties into the Smart MIDI tools that allow a variety of new 
ways to trigger samples.  For example, Smart MIDI is used to access the Pattern Alterna-
tor, Repetition Tool and Legato Mode. 

The iMIDI Rule Manager has to be launched and setup for the Smart MIDI Dimension to 
do anything.  This is a complex tool that is explained in chapter “10-00 Setting Up MIDI 
Rules”
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Release Trigger with Tracking:

This feature dynamically tracks the volume of a sample in real time and plays the re-
lease trigger back at a matching volume.  This way the release trigger plays back at the 
proper volume level no matter when you release the note.  For example, lets take an 
instrument that relies on hall ambience in the release tails.  Some samples are recorded 
with dynamics, swells, crescendos & diminuendos.  If you released one of these samples 
during the quiet part of a swell, the release sample would normally play back too loud.  
If you released during the loud part, the release sample might sound about right.  How-
ever, with this tool, the release sample will playback at a volume level that matches the 
volume of the sample at the time you release the note.  

Track audio signal AND voice parameters:

This mode tracks the volume as described earlier and it tracks the voice parameters like 
the ADSR envelopes.

Track Only the voice parameters: (Ignores audio level)

In this mode, it will ignore the audio level and just track the voice parameters.  

The overall volumes of the release tails can still be adjusted with the attenuation set-
ting on a sample-by-sample basis.   Between this and the tracking, you can have flaw-
less release ambience levels at all times.

This tool has two modes:
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New Parameter Edit Display:

The Parameter Tabs have been replaced with a whole new display that offers several 
advantages.

• It allows a lot more room for complete parameter descriptions & names that had to            
   be cut short or abbreviated in the earlier version.    
• It also provides the ability to add extra parameters for 3.0 and the future. 
• This new system allows numerical entry of the parameter settings as before but now  
   you can also use the mouse by dragging up & down on the parameter settings.  
• You can view all the parameters on a single scrollable screen or in individual sections.
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Interactive Editing Parameters:
There are three main areas where parameter edits can be adjusted.  These three areas 
are locked together so that when make changes in one area, they are also changed in 
real-time in the others.  This way you can see what is happening all at once while you 
make changes to the instrument.

1. The Parameter Edit Display

2. The Waveform Window

3. The Drag Tools in the Region Map

Anytime you select a parameter in one area, it will also select in the other areas.
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In this example, in the Parameter Edit win-
dow, we have the Amp envelope section se-
lected.  

The Attack parameter is highlighted.

The Waveform view displays the ADSR envelope. 

The Drag Tools Menu is also set to the Amp Envelope Attack.

However, if we go back to the 
Parameter Edit window and 
change to the LFO1 section, the 
Waveform View and the Drag 
Tools Menu will change accord-
ingly.  

Waveform View displays LFO graphic.

Drag Tools Menu changes to LFO Frequency
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At this point, the LFO frequency can be edited from any of these three areas and the 
other two areas will also change.  

The LFO Frequency can be typed 
in or dragged up & down with 
the mouse in the Parameter Edit 
window.  

You can drag the little square in the Waveform View to change the LFO Frequency.

You can use the blue dots in the Drag Tools.

Whichever method you use, the other two areas will update to match.  Any parameter 
that you highlight in the Edit Parameter window will be selected in the Drag Tools 
Menu and Vice-Versa.  
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Assign Key-Groups on Multiple Regions at once:
A Key-Group is an advance version of the Hi-Hat note cutoff that has been around on 
samplers for many years.  In the GigaStudio, you can have as many key-groups as there 
are MIDI notes. (Up to 127) Notes assigned to the same key-group will cut each other off 
when played.  

In the past, these had to be assigned one note at a time, which could be very tedious if 
you wanted to have a bunch of regions sharing a Key-group.  Now you can select any 
amount of regions and assign them to a key-group all at once.  

Key-groups are assigned by [right-clicking] on a region or group of selected regions.  
Then enter the desired Key-group.  Zero is the default setting.  Regions assigned to zero 
will not be affected by Key-grouping so you need to use 1-127 for regions groups that 
you want to have cut each other off.

Single Region Key-Group: 

Multiple Regions Key-Group:

In the past, you were limited to combining a maximum of 4 instruments at a time.  
Now, you can combine as many instruments as the dimension resources will allow.  No 
more need to combine instruments and then combine the combinations.  
Also, you can combine odd numbers of instruments together.

Combine more than 4 instruments:
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Jump to Selected Regions:
This has to be hands down one of the nicest features in the editor.  The editor will now 
highlight the samples in the Sample Window whenever you make a selection while ed-
iting.  

To show how helpful this feature is, imagine you want to edit the sample assigned to 
the middle velocity of middle C, Pedal Down on a Piano.  In the past you would have to 
hunt and peck through the Sample Window folders to find it.  If the sample folders &
names are not organized or obvious, this could make it very difficult to find a specific
sample.  

However, with “Jump to Selected Regions” enabled, all 
you have to do is select the C-4 Region.

Select the Pedal Down 
Dimension.

Select the Middle Velocity. The sample then lights up.
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If you select several regions or several dimen-
sions, all the samples used will highlight in 
the Sample Window.  

All the regions are highlighted yellow while 
the most recently selected region (C-4) is or-
ange.  

Notice that all the samples are highlighted in yellow 
but one of them also has an orange border around it.  

This orange border represents the most recently select-
ed dimension.  In this case that is C-4. 

Enable this feature by [right-clicking] in the 
Sample Window and choosing “Jump to Se-
lected Region” 

Also, when you have the MIDI Select feature enabled, the samples will also 
highlight as you play them in real time.  

You can then find samples really fast by just playing the MIDI keyboard and manipulat-
ing MIDI controllers.  
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Find Instance:

This is the opposite of Jump to Selected Regions.  In this case, you select a sample in the 
Sample Window and use this feature to find where it is mapped in the instrument.  

Choose a sample in the Sample window and 
[right-click] on it. 

Select “Find Instance” from the 
menu that comes up.

The exact region, velocity and dimension split that this sample is assigned to will be 
selected in the Editor.  

Repeat this to find the next instance if the
sample is used more than once.  

You can also use the keyboard shortcut.  
[Ctrl] + [F]
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More Layers:

In addition to many more dimensions, we now have more layers as well.  Instead of 
4-stereo or 8-mono layers, you can now have as many layers as there are dimension re-
sources available.

8-way Cross-Fade Layers:

The Cross-Fade layer tool can now handle up to 8 stereo cross-fade layers.  This allows 
for even smoother MIDI controlled crescendo cross-fades.
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Custom Tuning Templates:
You can now save and apply your own custom tuning templates.  This will allow a huge 
variety of possible tunings from equal tempered piano to various micro tuned ethnic 
instruments.  

Simply make fine tuning adjustments to the regions and save the template.  You can
then tune any other instrument you create in the future with these tunings instantly!

Make Fine Tuning Adjustments:

To apply this tuning template to another instrument, load that instrument into 
the Editor.

[Right-click] in Bank Instrument Window and 
Choose Save tuning template:

Give it a name and Save:

[Right-click] in the Bank Instrument Window 
and Choose Apply tuning template:

Choose the desired template from the 
list of available Tuning Templates.

This will set all the fine-tuning settings
to the template tuning.
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Redesigned Open and Save interfaces:

Anytime you choose to Open, Save or Import from the File Menu, you will now get a 
customized Browsing window.  It is very similar to a standard Windows Open and Save 
screen but with some Giga Specific additions.   

You can see a list of all the samples inside a selected .GIG file from here and you can
view them as the descriptive sample names or sample numbers.  

There are also some new saving options specific to the GigaStudio.

You can play the individual samples or hear the audition sample from 
here.
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Separate the Parameters from the Samples: 

There is now an option to save the parameters separately from the samples, creating 
a two-part file.  When this is done, there is no need for the entire instrument to load
when major changes to the file architecture occur.  You still hit the [RELOAD] button the
same way as before but the update is much faster now.  

Most of the instrument parameter edits can be heard in real 
time as you work on the instrument.  
The Load Indicator light would stay green.  
This still works the same in 3.0

A few edits (like changing the note range) will not be heard in 
real time but simply require a quick save.  
The Load Indicator light will turn from Green to Yellow.  
This still works the same in 3.0

Major edits that would change the architecture of the .gig file
would require a complete saving of the whole instrument.
The Load Indicator Light turns Red.  
This will still work the same in 3.0 if the parameters are 
locked into the .gig file.

However, we now have the option to save these parameters separately.  You will still 
need to hit the [RELOAD] button but the save will be very quick.

To do this, you need to re-save the .GIG file a certain way.

Go to File/Save As
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GigaStudio file browser window:

In the new GigaStudio Browser screen, look in the lower left for the check box:
“Keep all waves in extension files for fast editing of instrument definitions”

 Check that box and then Save the file.

This will create two files, a .GIG file (which contains the parameters) and an Extension
file (which contains the samples)

From here on out, you can make major changes to the file in the Instrument Editor and
you will no longer have to wait for the complete .GIG file to save every time.  

Things to keep in mind:
   •This file will load just fine in the main GigaStudio Interface but you need to make       
     sure that both files are together on the hard drive, or this will not work.
   •If you want to simplify things, you can re-save this split file again when you’re done   
     editing. Save it again but with the checkbox “un-checked” and it will merge them   
     back together into a single .GIG file that contains the parameters and the samples
     as before.  This is something that library developers might want to do to keep every  
     thing together and make for a cleaner release.  
   •This is most useful for large .GIG files.  It’s probably not worth the effort for smaller  
     files, which would reload fairly quickly.  
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Audition Samples in Editor:

You can now select a sample in the Sample Window and hear what it sounds like.  

To audition a sample, [right-click] on the 
sample in the Sample window and choose 
“Audition” from this menu.  The sample will 
then play.

Mark as Audition Sample for the Gig File:

This is a new feature that allows you to select a specific sample to be the audition sam-
ple.  This can be a quick demo or even an audio tutorial specific to the .GIG file. From
the GigaStudio interface, Audition Samples can then be played from the Loader before 
loading the instrument to hear what the instrument will sound like.  

If you do not set an audition sample, it will default to the sample with the first
alphabetical name.

To mark a sample as the Audition Sample, [right-
click] on a sample in the Sample Window

Select “Mark as audition sample” from the menu.

The sample will now have a little “A” next to it, indi-
cating that it is now the Audition Sample.  
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Convert Wave Pool Format:

This feature allows you to change convert all the samples in a .GIG file to various sam-
ple rate formats or convert the samples from Stereo to Mono.  This way you can work 
on high resolution uncompressed 24 bit stereo samples and then save various versions 
from uncompressed 24-bit stereo on down to compressed 16-bit mono and anything in 
between.

This is accessible by [right-clicking] in the 
Sample window and choosing “Convert wave 
pool format” in the menu.
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Anatomy of a .GIG File:

Here is a graphic representation of the components of a GigaStudio File.  Getting famil-
iar with these will make it much easier to know what you are doing when editing and 
creating GigaStudio Instruments.

GigaStudio File (.GIG File) Components:

     •Banks-A GIG file can have up to 127 Banks
     •Instruments-Each Bank can have up to 127 Instruments
     •Regions-Each Instrument can have up to 127 Regions (Or notes)
     •Dimensions-Each Region can have up to 127 separate Dimension Splits. (Velocity and   
       Stereo Splits are counted as dimension Splits)
     •Parameters-Each Dimension has a Sample assigned to it and over 100 editing 
       parameters.
     •Samples-Samples consist of standard wave files.
     •Sample Settings-Each sample has a variety of settings including unity note, sample  
       & bit rate and loop points.
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Banks:
A GigaStudio File can hold up to 127 
Banks and each Bank can have up to 
127 Instruments.  

This allows for a potential of 16129 
potential instrument patch changes.  

GigaStudio responds to standard MIDI Bank and Patch changes.  Without Banks, the Gi-
gaStudio would only be able respond to 127 patch changes.  

Banks also help to organize instruments within the Instrument Editor.  They give you a 
folder structure to work with when you have a large number of multiple instruments to 
deal with inside the same GIG File.  

Banks are the top level of the GigaStudio file.

Instruments:

Regions:

The next level is the instrument.  GIG 
files can have many instruments
inside them and these instruments 
can even share common samples 
without using any extra hard drive 
space or sample buffering RAM.  Each 
instrument can have a discrete Bank 
and Patch change.

Each Instrument can contain up to 
127 Regions or keysplits.  However, 
it is more common to use 88 or less 
since most MIDI keyboards don’t go 
beyond 88 notes.  A Region can range 
from a single note or span all the way 
across the whole keyboard and any-
thing in between.  
The gray spaces are blank notes with 
not regions assigned to them.
The purple region represents the 
range of the Key-Switch dimension.
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Dimensions:

Edit Parameters:

Samples:

Sample Properties:

Inside each Region is a number of Dimension 
Splits.  Each Region can have up to 127 splits.  

Dimensions include Stereo L & R splits, Veloc-
ity Splits, Release Triggers, Key-Switches and 
MIDI controlled Splits.  

A Dimension tells GigaStudio what sample to 
trigger based on the position of a variety of 
MIDI controls. 

Each of those Dimensions can have its 
own complete individual set of over 100 
Edit Parameters.

Amplitude & Filter ADSR Amplitude & 
Filter LFOs, 
Pitch Envelopes & LFO
Filter & Velocity Response Mix/Layer & 
Volume assignment & Sample Settings.

Each of these Dimensions with their individual set of param-
eters can have a Sample assigned to them.  

You can have one Sample per Dimension or even have a 
sample mapped to several dimensions but with different 
settings applied to it.  

Each Sample has its own set of properties 
including the Unity Note (or Root Note), 
Sample Rate & Bit Depth, Loop Points & 
Name and Fine Tuning.
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How to open the Instrument Editor:
There are several ways to open the Instrument Editor depending on what you want to 
do and from where you want to launch it.  

Opening the Instrument Editor from the GigaStudio Interface:

1. To open the Instrument Editor with a blank empty gig file, click on the [In-
strument Editor] button.  

The button is in the menu bar in the upper left section of the GigaStudio.

2. If you want to edit a loaded instrument in the Instrument Editor, [right-click] on that 
loaded instrument and choose [Edit…]

The Instrument Editor will open with the selected instrument loaded.  

Note:  The Instrument Editor will have to load the entire .gig file associated with the se-
lected instrument.  If the entire .gig file is not already loaded into the GigaStudio  (buff-
ered into RAM) then the Editor will take the time to load it for you.  This can take a few 
moments if the instrument is large or complex. 
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Opening the Instrument Editor from the Windows Desktop:

You can open and use the Instrument Editor without having the GigaStudio Interface 
running.  This is a good way to work when doing intense instrument construction.

1. You can launch the Editor from the Windows Start Menu. 

2. You can launch the Editor by [double-clicking] on a shortcut on the desktop.  

The installation of GigaStudio will create this shortcut if you select the option that al-
lows it to create a shortcut on the desktop.  

To create a shortcut manually, navigate to the Editor (or 
any application you wish to create a shortcut for) from 
the “Windows Start Menu” Instead of clicking on it and 
launching the program, hold down the [control key] and 
drag it out to the desktop.  You can also right-click and 
choose [create shortcut] from the menu.

You can also drag the shortcut to the Windows toolbar and then launch the Editor with 
a single click on that icon.  
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3. Last but not least, you can launch the Editor by [double-clicking] on a .gig file from the
Windows Desktop.

This will launch the editor and load the selected .gig file.  

You can load multiple .gig files by selecting several of them and hitting the [Enter] key.
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How to open a GIG file:

Opening a .GIG file from the GigaStudio Interface:

1. [Right-click] on a loaded instrument and choose [Edit…]

2. You can load multiple .GIG files by selecting several of them and hitting the
[Enter] key. 

2. The Instrument Editor will open with the selected instrument loaded.  

Note:  The Instrument Editor will have to load the entire .gig file associated with the se-
lected instrument.  If the entire .gig file is not already loaded into the GigaStudio  (buff-
ered into RAM) then the Editor will take the time to load it for you.  This can take a few 
moments if the instrument is large or complex. 

Opening a .GIG file from the Windows Desktop:

1. Browse to any .GIG file and [Double-click] on it.
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Opening a .GIG file from the Instrument Editor:

1. Go to the File Menu and choose Open… [Alt] + [F] + [O] or [Ctrl] + [O]

2. This will bring up the Open Instrument File Window (Below)

3. From this window browse to the file you want to open.

4. Select the file and click on the [Open] button and the file will load into the Editor.

This window is very similar to the “Open File” window in other programs but there are a 
few features that are GigaStudio specific.  The details of this window are covered next.
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Open File Window Details:

1. Recent:

This dropdown will show you the 
most recent folders that .GIG files
have been loaded from.  It’s a good 
place to start if you want to open 
recently used instruments.

2. Look In:

This dropdown is where you select 
the computer or hard drive to look 
in for files.  You can even browse to
files on a network from here.  

The contents of what you select 
here will show up in the main 
File/Folder window below.
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3. Main File/Folder Window:
[Double-click] on folders to reveal 
their contents.

Select a .GIG file and its name will
show up in the File Name area.  

At this point you can select the [Open] button or [double-click] on the file to open it.  

4. Files of type: (GigaStudio Specific Feature)

This selects between the available file types that the Editor can load.

•GIG Files-Regular GigaStudio Instrument Files.  
(even older versions of .GIG files from the GigaSampler and GigaStudio 2.x)
•DLS Files-Downloadable Sample Files.  
•SF2 Files-Sound Font 2 Files

This is where the DLS and Sound Font compatibility is utilized.  GigaStudio does not read 
these files directly but you can open them with the Giga Edit from here and then save
them as standard .GIG files.
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5. Navigation Buttons

Last Folder Visited: Takes you to the Last Folder that you were at.

Up One Level: Takes you up one level in the tree.  It is Similar to a Back But-
ton in a browser.

Create New Folder: Click on this to create a new folder.  You can then name it 
and continue browsing and even move files around.
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View Menu: This dropdown lets you toggle between 5 ways of 
displaying the files.
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6. Descriptive Wave Names: (GigaStudio Specific Feature)

This checkbox Changes the names in the Sample Audition window (Below this check-
box) between “Descriptive Sample Names” and “Sample Numbers”.  These are the sam-
ples from the .GIG file that is selected in the main window.

When checked, the names of the samples from the 
.GIG file will be displayed. This feature can take a
few seconds to display each time you select a new 
file.  If you are in a hurry and you don’t need to see
these names, just uncheck the box to display the 
Sample Numbers instead.

When, un-checked, you get sample numbers in-
stead. 

The Sample Numbers display is very handy for see-
ing how many samples are in a .GIG file.  Just scroll
to the bottom of the list to see how many there 
are.
It is also much faster when you need to quickly 
navigate between various .GIG files.  You will not
have to wait for the browser to profile the sample
names.
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7. Sample Play & Audition Window: (GigaStudio Specific Feature)

You can select any sample in the .GIG file and play it
from here.  Just scroll down the list, select a sample and 
hit the [Play] button below to hear it. 

Pressing the [Audition] button will trigger a specially 
created Audition sample.  The audition sample can be 
anything a .GIG file creator wants it to be.  It could be
a musical example of the instrument playing, a single 
note or even a vocal description.

To create an Audition Sample, you just select any sample 
in the wave pool in the Editor, [Right-Click] on it and 
choose “Mark as Audition Sample” When the instrument 
is saved, this will be the file that plays back when you hit
the [Audition] Button.  

8. Advanced File Saving Features:  (GigaStudio Specific)

You will see these features in this screen but they are grayed out because they are not 
used when Opening .GIG Files.  These tools are only used when saving .GIG files.

These are covered in “08-13 How To-Load Status & Split Files”.  
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How to create a new empty .GIG file:
There are two ways to create a new .GIG file.  

1. The File Menu:

2. The Tool Bar:

An empty .GIG file will then open in the Instrument Editor.  At this point, there are no
instruments, regions, samples or parameters in the .GIG file.

Go to the file menu and choose [New]

[Ctrl] + [N] or [Alt] + [F] + [N]

Select the document icon on the toolbar.
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How to Import Samples:

1. Importing Samples from the Sample Window: 

Creating Folders

Samples are imported into folders in the Sample Window.

1. To create a new folder, [right-click] any-
where in the Sample Window and choose 
“New Sample Folder”. (Left)

2. This will create a new group ready to be 
named.

3. You can then give it any name you want.

4. You can do this with as many folders as 
you need.

When you create a new .GIG file, you will
always find a “default” sample folder in
the Sample Window.

You can start importing samples into this folder or you can create new folders.  
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Importing Samples:

1. To import samples into a folder, 
[right-click] on a folder and 
choose “Import Samples” 

You can [right-click] anywhere in the Sample Window but you need to make 
sure that the folder you want the samples to go in is selected.

2. This will bring up the Sample 
Browsing Window.  

This is very similar to the File 
Open Browsing Window.  

3. When you select a sample, the 
sample window displays the 
sample specs including the Bit 
Rate, Sample Rate, Length and 
Size.

4. Select a sample or a group of 
samples and click on the [Open] 
button to import the samples 
into the folder.
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Importing Directories/Folders:

5. The samples will now show up in 
the Sample Window. (Left or Below)

6. [Right-click] in the Sample Window
to sort them by “Pitch” (Left)

7. Or Sort by “Name” (Below)

1. [Right-click] in the Sample Window 
and choose Import Directory 
2. This will bring up the Directory 
Browsing Window.   
3. Open the drives & folders with the 
checkboxes to browse to a directory.
4. Click on [OK] to import the direc-
tory into the Sample Window. 
5. Imported Directory (Below)
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2. Importing Samples from the Windows Desktop:

The most convenient way to import directories and samples into the Sample Window is 
to drag and drop them directly from the Windows Desktop.  With this method, you can 
import multiple directories at once instead of just one at a time.

To import samples or directories, you need to open up a Windows Browsing screen on 
top of the GigaStudio Editor.  

1. To do this, first minimize the Editor with the Minimize button on
the very top right corner of the Editor screen.  You will see two sets 
of these buttons.  Use the top one.

2. Then [double-click] on My Computer to bring up the Windows 
Browser screen.  

3. From this window, navigate your way 
to a folder of samples.  You will need to 
be familiar with the Windows interface 
for this.

4. Here we have navigated to a folder of 
samples.  
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6. Drag the samples from this 
browsing window to any folder in 
the Sample Window.

7. Here we are dragging to the 
folder named “Import Sample 
Folder”    

5. You will need to make sure this browsing window is sized small enough to fit on top
of the Instrument Editor screen.  (Unless you are using a dual monitor setup)
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8. Now the samples appear in the folder.

9. You can do this with more samples and 
put them in any of the folders.  

In this example, we put some Kick sam-
ples in the “Import Sample” folder where 
the crash samples are.

Then we put some Snare samples in the 
“Default Sample Group” folder.



65

3. Importing Multiple Folders from the Desktop:  

1. To do this, navigate to 
where you can see several 
folders that have samples in 
them.  

2. Drag & drop a folder or several folders from the desktop into the Sample Window.
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3. All the folders and their samples are 
now in the Sample Window inside the 
GigaStudio Editor.  

This is the best way to quickly import a 
bunch of samples at once.  

4. Click on the check boxes to open or 
close the folders to display or hide the 
samples.

Now the samples are imported, orga-
nized and ready to be mapped into in-
struments.
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Creating Regions:
The next step in creating an instrument is to create some regions.  There are many ways 
to create regions.  In this section, we will cover how to create them manually.  This is the 
way certain instruments (Like drum kits for example) will usually be created.  This will 
also help familiarize you with the concepts of mapping samples before getting into the 
more advanced ways of mapping like the Wizard Tool.

Using the Region Window:

Before you start creating regions, we need to point out a few Region Window items that 
you will use or need to be aware of.  The Region Window is covered in detail in its own 
section.  

The Region Window is covered in chapter “09-04 The Region Window”

1. Zoom Buttons:
Use these buttons to shrink or enlarge the Region Keyboard.

Zoom In: (+)

Zoom Out: (-)



68

2. Middle C:

This red line indicates where Middle C is.  (Defaults to MIDI note 60 or C4)  
It is always to the left of Middle C

This can be changed up or down an octave in the Editor Preferences if needed.  (Edit 
Menu/Preferences/”Middle C Is”)

3. Key-Switch Region:
This gray region represents the Key-
Switch range.  It can be sized and moved 
around just like Regions.

This is a new feature of 3.0 to be able to 
easily adjust the Key-Switch range graph-
ically.  For now, you can move this out of 
the way and ignore it.

4. MIDI Select Button:

The MIDI Select Button allows regions & dimensions to be highlighted 
and selected by the incoming MIDI data.  

For now, make sure this is turned off.  
(Red Light “Off”)
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5. Graphical Editing Tools:

The Region is one of the places to adjust instrument parameters and see the results 
graphically across the whole instrument.  It’s a wonderful way to edit some things and 
to keep your bearings on what is happening as you edit.

Parameter Menu Bar:

Parameter Zoom Level:

Parameter Editing Dots:

You will see little blue dots on each 
region you create.  These represent 
an editing parameter and it can be 
adjusted by moving the blue dot up 
or down on the region or on a bunch 
of regions at once.  You can ignore 
these for now but we wanted to 
point them out.
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Creating Regions: In the Region Window

1. Place the mouse under the note where you want to 
create a region and [right-click].  

In this example, we will use “Middle C”.

2. Choose “New Region” from the menu.

3. This will create a brand new region and it will also be 
indicated in the velocity window below.

4. In this case, it is a single solid block of color.
This shows that there are no velocity splits and the re-
gion is mono.  

Also, there is no sample mapped to this region.
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There are a few things to keep in mind when creating regions this way:

•If you accidentally click under the wrong note, you can easily drag the region to   
  the correct note. The region can also be resized. (Stretched)

•The region’s split amounts are setup in the Edit/Preferences menu.  You can  
  have anything from a simple mono region with no velocity splits, up to a stereo   
  region with 32 splits.

•If you create a region with an empty instrument (no samples imported) then  
  the region will be empty.  The velocity window will display Not Mapped.

•If you create a region while there are samples in the Sample Window, then a  
  sample will be automatically assigned to this region.  You can choose which  
  sample this will be by selecting a sample before creating a region.

We will now cover these points in detail:

Moving Regions:
1. To move a region, grab it in the 
middle so that the mouse turns into 
a little hand.

2. Then drag the region to the left or 
the right.
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Resizing Regions:

3. A region can be stretched over the range of an entire keyboard and beyond from MIDI 
Note 0-127 (C-1 to G9)

1. To resize a region, grab one of 
the edges with the mouse so that 
the mouse turns into a left-right 
arrow.  

2. Then drag the mouse to stretch 
the region.  

You can do this with either side 
of the region.
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Selecting and Moving Multiple Regions:
1. To select several regions, drag across 
them with the mouse.  
Start in the gray space of either side 
and then drag across the regions.

You can also select the first region
and hold down the shift key while 
selecting the last region to do the 
same thing.

2. The selected regions will now be 
highlighted in yellow.

3.You can then move all these regions 
at once by dragging on one of the 
regions.

4. You can also select non-contiguous 
regions by holding down the [control 
key] while selecting regions with the 
mouse. 
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5. These non-contiguous regions can then 
be moved around the Region Window.

They will maintain their relationship 
with each other wherever you put them.
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Splits for Manually Created Regions:

You can choose the default region settings in the Editor Preferences Menu.  This will de-
termine whether manually created regions are mono or stereo and how many velocity 
splits there will be.  This is a very handy feature when doing a lot of similar type regions.  
If you know that you are dealing with stereo samples and will need 4 velocity splits, 
then you can set the default to this setting.  Otherwise, you have to select the created 
regions and make these settings manually afterwards.  

1. Go to the Edit Menu and choose “Preferences”.  
This is the bottom item in the Edit Menu.

2. That will bring up the Editor Preferences Window.
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3. In the Preferences Window look for the 
section called “Velocity splits for manu-
ally created regions”.  

4. Click the “stereo” checkbox if you want 
stereo regions.  

5. Uncheck it to create mono regions.

6. Select the amount of velocity splits you 
want.  (1-2-4-8-16 or 32)

7. Then hit OK.

8. Any new regions you create will re-
flect this setting and this setting can be
changed as often as needed while you 
work.
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1. Mono-No Velocity Splits: 2. Mono-4 Velocity Splits:

3. Stereo-4 Velocity Splits: 4. Stereo-8 Velocity Splits:

Split Settings Examples:



78

Automatic Sample Assignment:

1. If there are any samples in the Sample Window, one of them 
will be always assigned to any region that you create 
manually.  In this example, the Crash v1-p sample is highlight-
ed in the Sample Window.

2. When a new region is created, this sample is assigned to 
the region.  The name of the samples now shows up in the 
Velocity Map.

3. You can choose which sample by simply selecting it in the 
Sample Window.  That sample will continuously be mapped 
every time you create a new region until you select a different 
sample.  

Here we have selected the Kick v1-p sample.

4. Now when we create a new region, the Kick is mapped to 
the region.  
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Also, keep in mind that the selected sample will assign itself to all the velocity splits if 
there are more than more than one splits selected in the Editor Preferences.

1. In this example, we have selected 4 veloc-
ity splits as the default for manually created 
regions.

2. This time, the Kick sample is assigned to all 
four velocity splits.
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Creating Regions: Drag & Drop

A very quick and simple way to map a region is to drag & drop samples directly from 
the Sample Window into the Region Window.

1. Grab a sample & drag it out with the mouse:

2. Put the mouse under a note:

3. Let go of the mouse and the region is created:

4. Now the sample name shows up in the Velocity 
Map.
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There are a few things to keep in mind when using this drag & drop method:

•This method will create a region with only one velocity split.  

•If you drag with the [Left] mouse button, pitch tracking is enabled.  The sample  
  will pitch stretch depending on the unity note (or root note) and the location on  
  the keyboard.

•If you drag with the [Right] mouse button, pitch tracking is disabled.  The     
  sample will play back at its natural pitch no matter where it is located on the  
  keyboard.
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Mapping Samples
After you create the regions, you can map samples to them.  In the GigaStudio Editor, 
this mapping is done in a different way than might be expected.  Instead of putting the 
samples directly under the keyboard, you drag them to the Velocity Map.  This allows 
you to easily put the sample directly on the velocity split or dimension that you want.  

Dragging to the Velocity Map:

2. To map a sample drag it 
from the Sample Window 
directly to the Velocity Map.

3. Once you let go of the 
mouse, the sample name 
will now appear in the Veloc-
ity Map.  

4. If you drag different sam-
ple to this same region…

5. It will replace it.  In this 
example, the Kick samples 
replaced the Crash sample.

1. To start off, create a few regions and select one of them.
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Pitch Tracking:

When you map samples, they will either have the Pitch Tracking “Enabled” or “Disabled”, 
depending on which mouse button you use when dragging the samples to the Velocity 
Map.

1. Pitch Tracking Disabled: Drag With [Right] Mouse Button

When Pitch Tracking is disabled, the sample will not transpose at all.  It will always play 
at its natural pitch wherever you put it.  
(Good for drums & percussion or Sound Effects)  

2. Pitch Tracking Enabled: Drag With [Left] Mouse Button

When Pitch Tracking is enabled, the sample will be transposed up or down from its 
unity note (Root Note or Natural Pitch) depending on what unity note is assigned and 
where it is on the keyboard range. 
(Good for melodic multi-sampled instruments)

3. If you make a mistake or change your mind, you can also change the Pitch Tracking in 
the parameters page.  (Mix/Layer-Pitch Tracking OFF or ON)

Map to Null Sample:

A “Null Sample” creates a dimension that is silent and empty.  This allows you to have 
the equivalent of a silent sample without having to actually map a silent sample to the 
region.

1. [Right-Click] on the Velocity Map and choose “Map to null 
samples” from the menu.  
2. This will remove any sample that was mapped out to this 
area. (Not Mapped)
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Mono & Stereo Samples:

The icon next to each sample in the Sample Window indicates whether a sample is 
Mono or Stereo.

This is a good point to mention the color of the icons.

The color indicates whether the samples are compressed or not. 
(Tascam Loss-less Disk Acceleration Compression)

Mono Samples have one wave icon next to their 
names.

Stereo Samples have two wave icons next to their 
names.

Compressed Samples have Green wave icons.

Uncompressed Samples have Red wave icons.

Also, if you see the letter “A” next to a sample, this 
shows that the sample has been selected as the 
Audition Sample.
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Mono & Stereo Samples:

When you map a sample, it will automatically switch the region to a match the chan-
nels of the sample.

1. Stereo to Mono:

In this example, a Stereo sample is dragged to the Velocity Map of a Mono region.  No-
tice how the Velocity Map is one solid color at this point indicating that it is Mono.

When the mouse is released, the Stereo sample replaces the Mono sample and the ve-
locity map is now split into two parts, indicating that it is now stereo.

2. Mono to Stereo:

In this example we do the opposite and drag a Mono sample to the Velocity Map of a 
Stereo region.  The Velocity Map is split into two parts indicating that it is stereo.

The Mono sample replaces the Stereo sample and the Velocity Map is now one part, in-
dicating that it is mono.
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This is most important to keep in mind when you have multiple velocities or multiple 
dimensions.  This very convenient feature will remove any samples from the region that 
don’t match the sample that you are mapping.  

Here is a quick example using 4 velocity splits.

This covers the basics of drag & drop mapping of samples.  So far we have used ex-
amples of a single velocity, mono or stereo.  However, you can have many velocity splits 
and other splits called dimensions.  Dimension Splits are covered in the next section 
followed by more advanced mapping using the multiple dimensions.  

1. In this case we have 4 velocities mapped out with 
4 stereo samples.

2. If we drag a mono sample to the top velocity, the 
whole region is changed to mono and this sample 
is mapped to the top velocity split as intended.  

However, the bottom three samples have been 
removed.  

If you have a mix of Mono and Stereo samples in 
your instrument, be mindful of this as you map 
them out.
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Dimensions are one of the most important and revolutionary concepts of the GigaStu-
dio.  Dimensions allow real-time MIDI control of which samples are triggered.  

Creating Dimensions

The Basic Dimensions Overview:

•Stereo Split-This is the first and most basic of Dimensions.  There is no MIDI
  control of this dimension.  It is either Mono or Stereo.
•Velocity Splits-The speed at which you hit the keyboard determines which 
  sample is triggered.  This is most often used to for samples of instruments 
  actually playing from soft to loud.  Acoustic instruments tend to get brighter   
  and more aggressive as they get louder so having samples recorded ranging  
  from loud to soft makes for a much more convincing instrument.
•Sustain Pedal-The MIDI Sustain Pedal switches back and forth between samples.   
  This is most often used for piano libraries that have actual pedal up & down  
  samples or to open and close hi-hats.
•Mod Wheel & Other MIDI Controllers-This allows the Mod Wheel and most other  
  MIDI continuous controllers to switch between various samples.  A good 
  example would be using the Mod Wheel to switch from closed to open hi-hats.
•Layers-You can have several samples layered on top of each other playing 
  together at once.  You can even have individual MIDI control of the volume of  
  each layer or have a MIDI controller sweep between the layers. 
  (Cross-Fade Layering)
•Key-Switch-This original Giga invention allows you to use notes on the MIDI  
  keyboard to instantly switch between various samples.  This is often used for 
  orchestral instruments that have a bunch of articulations.  You can instantly  
  switch from Long Sustain to Staccato to Legato to Trills to Tremolo etc. all on one  
  MIDI channel.  
•Round Robin & Random-These dimensions switch the samples automatically  
  each time you play a note.  Round Robin plays a pre-determined sample order  
  while Random triggers the samples randomly.
•Smart MIDI- This Dimension is used for the new MIDI tools in Giga 3.0. These  
  tools include the Pattern Alternator, The Repetition Tool and the Legato Mode  
  Tool.  
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Working With Dimensions:

The best way to learn about dimensions is to start working with them.  

•These next few lessons will start with a simple velocity split and work up to an 
  advanced multi-dimension layout of a region.  

•For now, we are going to be working with a single note to get to know the 
  concept of working with dimensions.  (E-2 of an Orchestral Bass Ensemble from   
  the Vienna Symphonic Library)

•Everything will be done with the manual [Drag & Drop] method so you can see  
  and experience directly what these dimensions do.  Once you understand what  
  they do, you will then be better prepared to work with the Wizard Tool.  

•The Wizard Tool does everything described in these lessons but does it 
  automatically across many regions in a split second.  As you will see, it would 
  be a bit tedious to do an entire instrument with this manual [Drag & Drop]  
  method.  However, this is the best way to learn about the structure of a region.  
  In the Wizard Tool lessons, we will recreate some of these examples using the  
  Wizard Tool using several notes.

•This manual method is however, the best method for creating certain 
  instruments that don’t benefit from the Wizard Tool like drum kits.

•You need to have the GigaStudio software installed and have your Audio and  
  MIDI connections working.  Open the Instrument Editor and create a new blank 
instrument.



91

Stereo Dimension Splits:

As you have seen in earlier lessons, a region can be Mono or Stereo.  This counts as a di-
mension. If the region is Mono, you can have twice as many of all the other dimension 
splits.  Once you make a region Stereo, you cut the number of other available splits in 
half.  

Manually Changing the Stereo\Mono Split Settings:

2. [Right]-Click in the region window to create a new region.

1. The first thing to do is go to the Edi-
tor Preferences and set the Velocity 
for manually created regions to 1-Ve-
locity Split and Un-check the Stereo 
Checkbox.  Click the [OK] button.

3. The single solid color in the Velocity Map 
indicates that this region is Mono and has No 
Velocity Splits.
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4. To turn this into a Stereo Dimension, [Right]-
Click on the Velocity Map and choose ‘Force to 
Stereo’.

5. This will bring up the “Force region(s) to ste-
reo” window. (Below) Click on [OK].

6. Now the Velocity Map is split into two parts, 
indicating that the region is now Stereo.  

7. You can change it back to Mono the exact 
same way by [Right]-Clicking again on the Ve-
locity Map and choosing “Force to mono”.

Automatically Creating Stereo Regions:

Also, if you [Drag & Drop] a Stereo sample onto the Velocity Map, this will automatically 
change it to Stereo.  Dragging a Mono sample will change it back to Mono.

Go back to the Editor Preferences and Check 
the Stereo Checkbox. Click [OK].

All the new regions will now be created as Ste-
reo until you Un-check this box.
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Velocity Splits: Creating

Now we will take a region and add some Velocity Splits to it.  

3. This is the Dimension Controller Window for Velocity Splits.  In this window, you can 
create velocity splits, name them and rearrange the order of these splits.

1. Create a Stereo Region and put it on E2.

2. Click on the [Menu Bar] at the top of the 
Velocity Map to bring up the Velocity Dimen-
sion Controller Window.

4. Click on the [Add] button to add a second Velocity Split.

5. A New Split will appear at the top.  
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6. Click the [Rename] button and change the name of each split.  Name the top one 
Soft and the bottom one Loud for now.  Then Click [OK].

7. Now the Velocity Map is divided horizontally to represent these two velocity splits.

•If you click on the bottom split, it highlights and the name “Soft” appears in the  
  Velocity Split Button at the top.  

•If you click on the top split, it highlights and the name “Loud” appears in the 
  Velocity Split Button.

As you can see, naming these dimensions makes it much easier to keep up with what is 
selected.  This is even more important as we add more dimensions.  This is a worthwhile 
habit to get into if you plan to do a lot of instrument design.
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Velocity Splits: Mapping Samples

At this point, we just have an empty region with no samples mapped to it.  Next we will 
import and map out a Soft & Loud sustain note.

1. Import the two Bass-Sustain folders into the 
Sample Window. 

These are in the “Editor Tutorial Files” direc-
tory for this chapter. 
(How To Create Dimensions)

2. [Drag & Drop] the Bass-Sustain f E2 (this is the forte/loud sample) to the top split in 
the Velocity Map.

3. [Drag & Drop] the Bass-Sustain f E2 (this is the piano/soft sample) to the bottom split 
in the Velocity Map.
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The samples are now mapped to the low and high velocity splits.  In order to hear them, 
we need to save and load this instrument.

4. Choose Save or Save As in the 
File Menu & Save this .GIG file to
your drive someplace.

 5. Click on the [Download] Button on the Toolbar to load the instrument.

6. The Load Indicator Light will turn green when the instrument is loaded 
and ready to play.

7. Play E2 on your MIDI Keyboard to hear the 
results.  Play soft & loud and notice how the 
sample changes depending on how hard you 
play.  

When you cross the halfway point, it switches 
from the soft to the loud sample.  This is indi-
cated visually as well in the Velocity Map.  

The blue pointer on the left tracks the incom-
ing MIDI velocity level as you play and rests at 
the last played velocity level.
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8. You can set the Velocity Split Point by [Drag-
ging] up & down with the mouse.  

The MIDI value is displayed next to the curser 
(in this case, Up & Down Arrows) as you ad-
just the Velocity Split point.
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Playback Monitoring:

This is a good place to briefly point out the various Playback Monitoring features of the
GigaStudio Editor.  As you play the keyboard, a variety of real-time things happen on the 
screen at once, especially if you have the “Jump to Regions” and “MIDI Select” enabled.

First we will enable the “Jump to Regions” mode:

1. [Right]-Click in the Sample Window and en-
able Jump to selected region at the bottom 
of the menu.  This feature will highlight any 
samples which have regions selected.

2. To see how this works, select each of the velocity splits in the Velocity Map back and 
forth.  Notice that when you select one, its sample lights up in the Sample Window.  It 
highlights in yellow with an orange border.  

3. When you select the other velocity splits, its sample then gets highlighted in yellow 
with the orange border. 
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4. If you [drag-select] both velocity splits, both samples will be highlighted in yellow and 
the most recently selected of the two will have an orange border. 

Now we will enable the “MIDI Select” Mode:

5. Go to the top right of the Region Window and click on the [MIDI Se-
lect] button to turn this feature on.  The Button will light up.  

MIDI Select enables regions, dimensions and velocity splits to be automatically selected 
by the incoming MIDI data.

6. Play the bass note again at various velocities.  When you play loud, the top velocity 
is selected and highlighted as if you clicked on it with the mouse.  A lower velocity se-
lects the bottom split the same way. Also, the samples light up in the Sample Window.  
This allows you to instantly locate any region, dimension, velocity split and sample by 
playing it via MIDI instead of having to hunt and peck for it.  This ensures that you are 
indeed editing the correct sample.  As we get to more complex dimensions and more 
regions, this will be an invaluable tool.  

For example if you are playing a note in real-time as you adjust a filter on the bottom
velocity, you don’t want this MIDI Select tool constantly throwing you to the top velocity 
split every time you play too loud.  This is a tool that you will toggle on & off depending 
on what you are doing.  

7. You will need to turn the MIDI Select off when you are tweaking vari-
ous parameters.  
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MIDI Controller Splits:

Now we will add another dimension to the sustaining bass note we have been working 
on.  This will be a Mod-Wheel Dimension Split that will allow the Mod-Wheel to switch 
between the sustain samples and some short staccato samples, each with two veloci-
ties. 

1. Import the two Bass-Staccato Folders into 
the Sample Window.  
(Bass-Stac f and Bass-Stac p)

2. Click on the [Menu Bar] at the top of one of the dimen-
sions.  This will bring up the Dimension Controller 
window.  You can use any of the dimensions but to keep 
it simple, use the top one.

3. On the Control Source menu, 
choose “(1) Mod wheel”

4. That will create “two” splits in the Split Names section.
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5. Rename these to Sustain & Staccato from 
top to bottom.  The name limitation here is 12 
characters.  Then click on [OK].

6. Now we have two Mod-Wheel Dimension Splits and two Velocity Splits.

If you click on a dimension, three things will happen:

•It will be highlighted in the Velocity Map and the  
  custom velocity name will be displayed in the red  
  text at the top. (Left)

•It will also highlight the Dimension Map and the  
  custom dimension name will be displayed in the  
  red text at the top. (Below)

•The sample from that dimension will highlight in  
  the Sample Window.
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7. Click on the various dimensions to see how everything interacts:

Dimensions:
Bottom Velocity 
& Mod Wheel Split 1

Dimension Names:
(Soft & Sustain)  
Sample:
Bass-Sustain p E2

Dimensions:
Top Velocity & 
Mod Wheel Split 1 

Dimension Names:
Loud & Sustain
Sample:
Bass-Sustain f E2

Dimensions:
Top Velocity & 
Mod Wheel Split 2 

Dimension Names:
Loud & Staccato
Sample:
Bass-Stac f E2

Dimensions:
Bottom Velocity &
Mod Wheel Split 2 

Dimension Names:
Soft & Staccato
Sample:
Bass-Stac p E2
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8. Last but not least before moving on, try [drag-selecting] all the velocity and dimen-
sion splits at once with the mouse.

•In this case, everything is highlighted in orange or yellow depending which 
  dimension was the most recently “clicked on” when dragging.

•All the samples are highlighted in the Sample Window as well.  The most 
  recently “clicked on” dimension sample has the orange border.

Be sure to experiment with every combination of clicking & dragging and watch what 
it does on the screen.  This is how you will select specific samples or groups of samples
to make edits to them in the future.  

9. To hear the results of this new dimension, click on the [Download] button again.  This 
will save the new changes and load the instrument.   The reload light will go off.
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Switching the Order of Dimension Splits:

A new feature of the Editor in GigaStudio 3.0 is the ability to quickly re-order the Di-
mension Splits.  

Changing the Split Order:

1. Right now, in the Mod Wheel dimension 
split, the Sustain samples are on the left (Mod 
Wheel-Down) and the Staccato samples are on 
the right. (Mod Wheel-Up)

2. Click on the Dimension 
[Menu Bar] to bring up the 
Dimension Controller Window.

3. Click on the “Sustain” Split Name.

4. Click on the [Down] button to move it below the 
Staccato Split name.  

Now the Staccato is on top and Sustain is on the 
Bottom.
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5. You can also do the opposite and select 
Staccato, and click on the [Up] button.

The result is the same.  The Staccato is on top 
and the Sustain is on the bottom now.

6. Click on [OK]

7. Now the Staccato Samples are on the left 
(Mod Wheel-Down) and the Sustain samples 
are on the right. (Mod Wheel-Up)

8. You can also do the exact same thing with the Velocity Splits.  Just click on the Velocity 
Map [Menu Bar] instead and then re-order the Velocity Split Names. (Soft & Loud)

9. Now we have reversed Velocity and Mod Wheel Splits.  
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Changing the Dimension Controllers:

Another very important skill to know is how to change between different dimension 
controllers.  Dimension Controllers can be easily changed without having to re-map 
the samples and this can be done across the whole instrument.  If you don’t like the 
controller that has been assigned in a library you have, you can change it to something 
else.  Also, if you are designing your own instrument, the ability to make these changes 
allows you to change your mind and experiment.   

Using the same tutorial instrument, you can change the Mod-Wheel dimension split 
any other MIDI controller.  We’ll cover a few examples next.

Change to Sustain Pedal:
1. Click on the [Menu Bar] bar of the Mod 
Wheel dimension split.

2. Click on the [Drop Down] arrow in the Control source and choose “Sustain Pedal” and 
then click on [OK] to apply this change.

4. Now, instead of the Mod-Wheel switching between the Sustain and Staccato samples, 
the Sustain Pedal with change them instead.  You will need to re-load the instrument to 
hear this change

3. Now the dimension controller is changed to 
the Sustain Pedal.  
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Change to Key-Switch:

Next we will change this to a Key-Switch dimension.  This will allows us to use any key 
on the MIDI keyboard to change between the Sustain and Staccato samples.

1. Again, click on the [Menu Bar] of 
the Sustain Pedal dimension switch.

2. This time, change the controller to “Keyboard” and click on [OK].

3. Now the dimension has been 
changed to “Keyboard” also known as 
Key-Switch.  
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4. Once you create a Key-Switch dimension, the gray 
colored region will now turn “purple” 

This is where you choose which MIDI keys will tog-
gle between the Sustain and Staccato samples, just 
like the way the Mod-Wheel and Sustain Pedal did. 
In this example, we have the range set to C4-C#4.  
This region works just like normal regions and can 
be dragged and resized the same way.

5. Alternatively, this range can be set numerically in the Instrument Properties window.  
[Double-Click] on the Instrument to get to this window.

6. You will need to re-load the instrument to hear this change.

7. Now, triggering C4 will change to the Sustain samples and triggering C#4 will change 
to the Staccato samples.  Play C4 and then play the instrument note to hear the Sustain 
samples, then Play C#4 and play the instrument note again to hear the staccato.  This is 
a two-hand technique.  One hand is for playing the Key-Switch and the other for playing 
the notes.

Change to Round Robin:

The procedure is the exact same as the previous two examples.  Change to the Round 
Robin this time for the dimension controller.

What this will do is automatically change back and forth between the Sustain and Stac-
cato samples every time you play the instrument.  Reload the instrument and play the 
instrument note repeatedly to hear how this works. 
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Dimensions for Alternate Edit Parameters:

Another use for Dimension Switches is to change between alternate Parameter edits of 
the same samples.  
Examples:

Change between Filtered and Unfiltered variations.
Change between different ADSR settings.
Change between different Velocity Curves or Velocity levels.

Load and play the Tutorial Instrument “Bass Note 4-Way Mod.GIG”

This instrument is a good example of how dimensions can be used to play the same 
exact samples but with different edit variations.  In this instrument, the Mod-Wheel 
will switch 4 ways between the following options.

Normal Sustain
Filtered Sustain
Slow Attack Sustain
Short Release Sustain

Layer Dimension:

So far we have covered basic switching dimensions that use MIDI controllers or Veloc-
ity to change the samples that are played back.  Another type of dimension is the Layer.  
This allows you to layer several samples on top of one another to be played back at the 
same time.  You can also adjust or control the volume of the individual layers and even 
do a MIDI controlled cross-fade between layers.

In this example, we will create a simple two-way layer and put a Mod-Wheel cross-fade 
on it.

1. Start with a new blank instrument and import 
the Sustain Sample Bass note directories into the 
Sample Window.

2. Create a Stereo region at E2 again.
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3. Click on the [Menu Bar] on the top 
empty dimension to bring up the Dimen-
sion Controller window.

4. Set the Control source to “Layer” 
Type in a Description and name the Split names to Soft & Loud.
Click on [OK]  

5. Now we have a Layer dimension split 
with Soft on the left and Loud on the 
right.
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6. Select the Soft dimension split and map “Bass-Sustain p E2” to the velocity map.

7. Select the Loud dimension split and map “Bass-Sustain f E2” to the velocity map.

8. Select both the Layer dimensions.
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9. Click on the [Menu Bar] in the Edit Parameters window and choose “Mix/Layer” That 
will bring up the Mix/Layer menu.

10. Click on the word “None” in the “Attenuation controller” line and then select “Mod 
wheel” This will set the Mod-Wheel to control the volume of both layers in real time.
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11. Select the Loud layer dimension. Then set the Attenuation controller in the Edit Pa-
rameter window to “Yes” This will reverse the Mod-Wheel for the loud layer and create a 
simple cross-fade using the Mod-Wheel between the loud & soft layers.

12. Save the instrument and 
load it to a MIDI channel.

13. Hold down the Note E2 while moving the Mod-Wheel back and forth.  You should 
hear a smooth cross-fade between the soft and loud layer.  

You can also do custom in and out points using the Cross-Fade Layer Tool, which is cov-
ered in detail in its own section.  This tool can handle up to 8 stereo layers.
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How to Map Samples-Advanced
In this lesson, we will create a full drum kit with several advanced features that will 
utilize many of the Editor features.  Since this is a Drum Kit, all of the mapping will be 
[drag & drop] using the [Right] mouse button. (To Disable Pitch Tracking)

•Multiple Velocities
•Stereo and Mono Regions
•MIDI Controller Dimension for Hi-Hat Open & Close
•MIDI Controller Dimension for Snares On & Off
•Self-Masking on the Cymbals to save Polyphony
•Low Pass Velocity controlled Filters on the Toms & Bass Drum

The first thing to do is to create a
new instrument.

Import all the Tutorial Drum Kit 
folders into the Sample window.  

These can found in the “Editor Tuto-
rial Files” directory  for this chapter. 
(HowTo Map Samples-Advanced)

In the Bank-Instrument window you 
can name the instrument to “Tutorial 
Drum Kit”

You can also delete the “Default 
Sample” folder to keep the Sample 
window from getting too cluttered.

The final result should look like this
diagram on the left.

Now we are ready to start creating a 
drum kit.
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Kick Drum:

•The Kick Drum has 4 Velocities of Mono samples.  
•We will create two identical regions of the Kick Drum for Left-Right playing style.  
  (Like a Double Kick Setup)
•To do this, we will complete the first region and then copy and paste it to create  
  the second one.
•There will also be a low pass filter controlled by velocity so that the tone is dark  
  when played soft and gets brighter the louder it is played.  This combined with  
  the 4-way velocity split makes for a smooth and realistic transition from soft 
  to loud.
•We will also adjust the Release Time of the Kick Drum.

1. Go to the Edit/Preferences Menu and setup the 
Velocity splits dialog for 4-Velocity splits.  Leave the 
Stereo box unchecked since these samples will be 
mono.

2. [Right-click] under C-2 in the Region and choose 
“New region” from the context menu.  

This will create a new region at C2.

3.This new regions will have 4 mono velocity splits ready 
to be mapped out with Kick Drum samples.
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4. [Drag & drop] the Kick Drum samples to the 4 velocity splits as shown below.  Be sure 
to use the [right] mouse button to disable the pitch tracking.  We want all the samples 
to play at their original pitch.

5. At this point, it would be nice to hear the results as we edit the Kick drum parameters 
& velocity split points.  Click on the [Download] button.

6. Choose the Save As option.

7. Find a place on your Giga Sounds hard drive to save this instrument.  Enter a File 
name and click on [Save].
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8. Once the instrument is loaded, the Load indicator light will turn green and you 
should be able to hear the Kick Drum if you play C-2 on the keyboard.

 9. The note will also light up in blue when you play

10. The blue arrow will move to the velocity levels you play in real time.  This will help in 
adjusting the Velocity Split points to be able to see them as you play.

11. Drag the Velocity Split point divider lines to adjust the 
splits until they sound and feel right.  Play the Kick drum 
and use the blue arrow as a guide as you adjust the 
splits points.

This example shows a popular velocity split setting that 
works great on percussive instruments.  Many keyboards 
don’t reach the very low velocity range so it helps to 
make the lowest velocity a little larger than the rest so 
you can hear it.  The top velocity is way up high so that it 
only triggers when you really hit the key fairly hard.
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The next step is to put a longer release time on this Kick Drum.   The default release 
time is a bit too short.  

12. Select all the velocity splits of the Kick drum so that they 
are all highlighted.  

This way, any edits we perform will apply to all of them at 
once.    

13. In the Edit Parameters window, click on the [tool bar] and choose “EG1 (amplitude)” 
from the context menu.  This will bring up the Amplitude ADSR section.

14. Change the Release time with the mouse or with text entry.  You can experiment 
with different settings in real time as you play the Kick Drum to find a good setting.  
Around 3 seconds will cover the whole decay of the Kick Drum.

Default of 0.300 Sec:

Set to 3 Sec:
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15. You will notice that in the Drag Tools 
menu that Envelope 1 Release time has 
been selected.  

Anything you select in the Edit Param-
eters window will be automatically se-
lected here as well.  

By dragging the blue dot on the Kick 
Drum region, you can adjust the release 
time here.  

This is another option for editing various parameters in addition to the Edit Parameters 
window and the Waveform View window.  It will come in very handy for editing mul-
tiple regions at once.  

You can also select various parameters by clicking on the [tool bar] of the Drag Tools and 
choosing the parameter you want to edit from the context menu.

Click on [Tool Bar]:

Select Parameter: Edit Parameter:
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The last thing to apply to this Kick Drum is a simple Low Pass Filter.  This will make the 
tone of the Kick Drum Samples get brighter as you play louder and darker as you play 
softer.  

16. Make sure all 4 Velocity Splits are still highlighted.  
This filter will span all 4 splits.  

You can however have individual filter settings for each
velocity split if you want.

Also notice how the Release time (3.000 sec) is indi-
cated here as well.  

17. Go back to the Edit Parameters window and change to the Filter section.

18. Set the Filter type to the Low pass Filter.
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19. Now, play the Kick Drum and notice how the tone gets darker or brighter depending 
on how hard you play.  There are two types of tone change happening here at once.  One 
is the sound of the velocity switching between loud to soft recordings of the Kick Drum.  
The other is this Filter.  Between these two things, you can get a fairly smooth transition 
from soft to loud.  Feel free to experiment with other filter settings.  

The final step for the Kick Drum is to create a second region so that we have two keys to
trigger.  (Like a double Kick setup)

20. [Right-Click] on the Kick Drum Region and 
Choose “Copy region” from the context menu.

21. Now, [right-click] in the empty space under 
the note D-2.  

This will bring up the context menu again.  

Choose “Paste region(s) here”

22. Now we have two identical regions of the 
Kick Drum on C2 and D2.  

All the editing done to the original is carried 
over to the new region as well as the sample 
mapping.  

It is literally a clone but on a different key.
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Snare Drum:

The next part of the drum kit to map out is the Snare Drum.

•This drum will have separate Left and Right samples.
•These samples are stereo with 4 velocities.
•There are also samples with the snares off. (One set with 4 velocities)

1. Go back to the Edit/Preferences 
screen.  Since we are now dealing 
with stereo samples, check the “Ste-
reo” check box in the manually cre-
ated regions section. 

2. Create two new regions at E-2 and F-2.  These will be 
the Left and Right snare samples.  

Notice how these new regions are solid while the Kick 
Drum regions have diagonal hash marks on them.  
This differentiation indicates that these regions are 
different from each other in some way.  In this case the 
difference is that the Kick regions are mono while the 
Snare regions are stereo.   If you select the Kick drum 
regions, those will turn solid and these Snare regions 
will get the hash marks.

3. The Velocity Map for these new regions shows a Ste-
reo Split and 4 Velocity Splits, just like the setting in the 
Edit Preferences window.
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4. Select the Left Snare region (E-2).  

[Drag & Drop] the Left-Hand Snare samples 
from the Sample window to the 4 velocity 
splits using the [right] mouse button.

Snare Left v4-ff
Snare Left v3-f
Snare Left v2-mf
Snare Left v1-p

5. Select the Right Snare region (F-2).  

[Drag & Drop] the Right-Hand Snare samples 
from the Sample window to the 4 velocity 
splits using the [right] mouse button.

Snare Right v4-ff
Snare Right v3-f
Snare Right v2-mf
Snare Right v1-p
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6.Adjust the Velocity Split Points and the Re-
lease Time of both Snare Drum regions just 
like with the Kick Drum.  

You can also apply the Low Pass Filter at this 
point.

Now we want to add the Snare Off samples in a useful way.  

•In this case, we will create a Mod-Wheel controlled dimension that will switch  
  the snares on & off so to speak, like a snare drum switch.  

•Moving the Mod-Wheel forward beyond the halfway point will switch to the  
  “snares off” samples while moving it back will switch back to the “snares on”  
  samples.  

•Also, there is only one set of “snares off” samples in these tutorial samples.   
  There are no Left and Right hand samples so we will map the samples to both  
  regions.  
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7. Click on a Dimension [Tool Bar].

8. In the Dimension Controller window:

•Set the Control source to Mod-Wheel.  
•Enter “Snare Switch” in the Description.  
•Rename the Splits to “Snares On” and “Snares Off” 
•When you’re done, click on [OK]. 

9. The result is a labeled dimension switch.

10. Select the Left Snare region and then select 
the “Snares Off” dimension.
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11.  Map out the 4 “Snares Off” samples to the velocity map.  Repeat this with the Right 
snare region so that both regions have “Snares Off” samples.

12. Click on the [Download] Button to hear the latest results.

13. Play the Snare samples while moving the Mod-Wheel back and forth.  

The Tom samples also have Snare on and Snare off variations so we will do the same 
thing with them in this next section.

Mod-Wheel Back-Snares ON

Mod-Wheel Forward-Snares OFF
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Toms:

•There are three sets of Tom samples: High, Mid and Floor.
•They are stereo with 4 velocities.
•There are Snare On and Snare Off samples.  With the Snare On samples, the snare  
  drum buzz is heard when the toms are hit.

1. Create 3 new regions, one for each Tom.  Put 
them on G2-A2-B2.  

The regions should automatically be stereo 
with 4 velocity splits as before with the snares 
based on the Edit/Preferences settings.

Select all three of them so that the following 
edits will apply to all of them.

2. Using the same techniques as with the Kick 
and the Snare, adjust the Velocity Split Points, 
the Release Time and add a Low Pass filter.

The changes should apply to all three regions 
at once if they are all selected in the previous 
step.

3. Click on a Dimension [Tool Bar].
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4. Do the same thing we did with the snares:

•Set the Control source to Mod-Wheel
•Enter “Snare Switch-Toms” in the Description field.
•Rename the Splits to “Snares On” and “Snares Off”
•Click on [OK] when you are done.

5. Now the Toms have a labeled dimension 
switch.

6. Select the G-2 region.  

This will be the Floor Tom.
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7. Select the “Snares On” dimension.

8. Map out the “Tom-Floor Snares On” samples using the [right] mouse button.

9. Select the “Snares Off” dimension.

10. Now map out the “Tom-Floor” Samples using the [right] mouse button.  These sam-
ples do not have any snare buzz in them.
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11. Repeat these steps for the Middle and High Toms.  

Mid Tom:

•Select the A-2 Region.
•Select the Snares On dimension
•Map out the “Tom-Mid Snares On” samples.
•Select the Snares Off dimension.
•Map out the “Tom-Mid” samples.

High Tom:

•Select the B-2 Region.
•Select the Snares On dimension
•Map out the “Tom-High Snares On” samples.
•Select the Snares Off dimension.
•Map out the “Tom-High” samples.

12. Click the [Download] Button to save and reload the 
instrument.

13. Now play the Toms while moving the Mod-Wheel back and forth.  You should hear 
the snares turning off and on.



132

Cymbals:

The Cymbals are fairly straightforward:

•There are 4 sets of samples: Ride-Ride Bell-Crash-Splash.
•They are all stereo.
•They all have 4-Velocity Split Points.
•We will enable “Self Masking” to save polyphony for the long sustain times.

1. Create 4 new regions:

C3-D3-E3-F3

This should create 4 Stereo re-
gions with 4 Velocity Splits.

Select all 4 of the regions.

2. Give the Velocity Split points a rough adjust-
ment as in the past examples.  

Set a Release Time of 5 Seconds. 
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3. Select the C-3 Region in the Region window.

Map out the “Ride Tip” samples using the 
[right] mouse button.

4. Select the D-3 Region in the Region window.

Map out the “Ride Bell” samples using the 
[right] mouse button.
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5. Select the E-3 Region in the Region window.

Map out the “Crash” samples using the [right] 
mouse button.

6. Select the F-3 Region in the Region window.

Map out the “Splash” samples using the 
[right] mouse button.

7. Click on the [Download] button to save the changes 
and hear the results.

Play the cymbals and tweak the velocity split points and release times if needed.
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The final thing we will do to the cymbals is enable “Self Masking” to save polyphony.

With Self-Masking enabled, playing louder velocities will shut off any sustaining softer 
velocities on the same region that are still decaying.

For example, these cymbals have several seconds of decay.  If you play a soft note, the 
sample will play to the end of the decay no matter what.  You could trigger a louder 
note while the soft sample is still decaying and drown out the soft sample.  However, 
even though you can’t hear the soft sample any longer, it would still be using up po-
lyphony until it is finished decaying.  With Self Masking enabled, the louder note will
cut off the softer note.

8. Before enabling the Self-Masking, trigger one of the cymbals several times from soft 
to loud and notice how much polyphony it uses.

9. Select all 4 of the Cymbal Regions.  

10. Select all the Velocity Splits.
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11. In the Edit Parameters window, bring up the Mix/Layer section.

12. Set the Self-Masking to Yes.

13. Now trigger one of the cymbals as before and notice the difference in the polyphony.  
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Hi-Hats:

Last but not least, we have the Hi-Hats.

•4 Stereo Velocities of Tip Closed
•4 Stereo Velocities of Tip Open
•4 Stereo Velocities of Edge Closed
•4 Stereo Velocities of Edge Open
•4 Stereo Velocities of Foot Closed

We are going to get fancy with the Hi-Hat.  The Sustain Pedal will do several things at 
once

•Switch between Open and Closed Tip and Edge Samples
•Trigger one of the Foot Closed Samples
•Cut off the Open Samples using a Key-Group assignment.

1. Create three more regions at G3-A3-B3

Select the Left two regions G3 & A3.  

These regions will be the Tip and Edge hits and they will 
have a Sustain Pedal dimension split that will switch 
between open and closed samples.

2. Click on a Dimension [Tool Bar].
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3. Do the same thing we did with the snares:

•Set the Control source to Sustain Pedal
•Enter “Hi-Hat Open Close” in the Description field.
•Rename the Splits to “Hi-Hat Open” and “Hi-Hat Close”
•Click on [OK] when you are done.

4. Select the G-3 region.  

This region will have the Hi-Hat Tip samples.

5. Select the “Hi-Hat Open” Dimension Split.
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6. Map out the “Hi-Hat Tip Open” samples to the Velocity Map using the [right] mouse 
button.  

7. Select the “Hi-Hat Close” Dimension Split.

8. Map out the “Hi-Hat Tip Closed” samples to the Velocity Map using the [right] mouse 
button.  
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9. Select the A-3 region.  

This region will have the Hi-Hat Edge samples.

10. Select the “Hi-Hat Open” Dimension Split.

11. Map out the “Hi-Hat Edge Open” samples to the Velocity Map using the [right] mouse 
button.  
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12. Select the “Hi-Hat Close” Dimension Split.

13. Map out the “Hi-Hat Edge Closed” samples to the Velocity Map using the [right] 
mouse button.  

The last thing to map out is the Foot Closed Hi-Hat region.

14. Select the B-3 Region. 

This will be the Foot Closed Hi-Hat.
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15. Map out the “Hi-Hat Foot” samples to the Velocity Map using the [right] mouse but-
ton.  

16. Click on the [Reload] Button to save the changes and 
hear the results.

17.  Play the Tip and Edge Hi-Hat regions while triggering the Sustain Pedal.    

Pressing down on the pedal will change to the Closed Hi-Hat samples, just like the pedal 
of a real Hi-Hat.  

Releasing the pedal will change to the Open Hi-Hat samples, just like the pedal of a real 
Hi-Hat would do.

However, there is one more thing to add to be even more realistic.  When you stomp on 
a real Hi-Hat pedal, it closes the Hi-Hat cymbals.  (Foot Closed Samples)

Right now, we can play the Foot Closed Hi-Hat on the keyboard but we also want the 
Sustain Pedal to trigger one of those samples as well.  We also want it to shut off the 
open Hi-Hat samples when closing, just like the real thing.
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18. [Right-click] in the Bank-Instru-
ment window and choose “iMIDI Rule 
manager…” from the context menu.  

If this option is grayed out, you need to load the instrument by clicking on the [down-
load] button.  

19.  This will bring up Rules Manager.  Select  “Controller Triggered” from the list and 
then click on the [Add] button.
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20. That will bring up this Control Panel.

•Set the Controller to “64 Sustain Pedal” This tells the GigaStudio to use the 
  Sustain pedal to trigger a MIDI event.
•Set Note to Trigger to “B3” This tells the GigaStudio to trigger the Foot Closed Hi- 
  Hat region, which is mapped to B-3.
•Click the “Switch controller logic enabled” check box and enter 64 for velocity.   
  This tells the GigaStudio to trigger the sample that is mapped out to the Velocity  
  split that is in the range of 64.  (This will be the V2 mf sample)
•Leave everything else the same and click on the [Add] button and then OK.

21. Click on [OK] in the Rules Manager window to close it.  

Now, when you step on the Sustain Pedal, it will trigger the mf Foot Closed sample on 
B-3.  

It also continues to switch the Tip and Edge regions between Open and Closed samples 
at the same time.

The last step is to assign all the Hi-Hat regions to the same Key-Group so that they will 
cut each other off.  This will cause the Sustain Pedal to choke the open samples, just like 
the real Hi-Hat.
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25. Now, the Hi-Hat regions will cut each other off. The Sustain Pedal will cut off any 
open sustaining samples while it triggers the Foot Closed sample.  This is very similar to 
the way the real Hi-Hat operates.

This lesson has touched on nearly every section of the Instrument Editor.  Be sure and 
check out the in depth reference and tutorials on these various features for more infor-
mation.

22. Select all three Hi-Hat Regions and then [Right-Click] 
with the mouse.

23. Choose “Properties” from the context menu.

24. Set the Key group to “1” and click 
on [OK].

Make sure the instrument is saved 
and loaded so you can play it.
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The Wizard Tool:

Up to this point, everything has been done manually with the [drag & drop] method.  

To better understand this wizard tool, you need to be familiar with the manual method 
of mapping samples & creating dimensions.  

Also, certain instruments like Drum Kits will still need to be created with the [drag & 
drop] method since each region will usually be different from the other and the Wizard 
Tool won’t work very well for these.  

The Wizard Tool works best on melodic instruments like pianos, guitars & orchestral 
instruments.  

You can imagine that if you had to create a full 88 note piano with 8 velocities with 
sustain pedal switches, that it would take an enormous amount of time to do it manu-
ally one note at a time.  This is where the Wizard Tool comes in.  It allows you to map 
an entire instrument with multiple dimensions “instantly” Once you have the samples 
properly named and organized, you are only seconds away from having an instrument 
mapped out. 
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Preparing the Samples:

As you edit and organize your samples, you need to also be aware of getting them ready 
for the Wizard Tool if you plan to use it.  This is very simple and will save a lot of time.

Sample Names & Unity Notes:

For the Wizard Tool to work, it needs to know the Unity Note (Also known as Root Note) 
of each sample.  This is the note that the pitch is recorded at and assigned to on the key-
board.  Even if the samples are not chromatic, the Wizard Tool can assign them to their 
root note and then stretch the regions until they meet each other.

The Editor will recognize the unity note of a sample if the sample name indicates the 
unity note by MIDI note number or by note name.  For example, middle C would be note 
name C-4 or MIDI note number 60.  

MIDI Note Name Range: C-1 through G9
MIDI Note Number Range: 0 through 127

Just put the Note Name or Note Number in the Sample Name before importing the 
samples into the Editor.  To keep from confusing the Editor, we recommend putting this 
name or number at the end of the file name with a space separating it from the rest of
the characters.

Example:
Piano Velocity-4 C4.wave
Piano Velocity-4 60.wave

The Editor will have no trouble recognizing files that are named like this.

On the other hand, naming the samples like this might be confusing for the Editor to 
figure out the unity note.

Piano Velocity-4C4.wave
Piano Velocity-460.wave

Note: The Wizard Tool can also simply map the samples out in alphabetical order as 
well.  This works for sound effects, percussion and other non-melodic instruments.
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Organizing by Folders:

The Wizard Tool can also map out complex dimension and velocity splits but to do this, 
the various splits need to be organized into separate folders.

For example, if we have a piano that is 4 velocities with sustain pedal up & down sam-
ples, the folder structure would look like this.

Piano Velocity 1 Pedal Up
Piano Velocity 2 Pedal Up
Piano Velocity 3 Pedal Up
Piano Velocity 4 Pedal Up

Piano Velocity 1 Pedal Down
Piano Velocity 2 Pedal Down
Piano Velocity 3 Pedal Down
Piano Velocity 4 Pedal Down

In the Wizard Tool, we would be able to assigned each of the folders full of properly 
named samples to the proper dimensions.

Keep in mind that each of these folders could contain up to 88 samples each. That 
would be 704 samples that would have to be mapped by hand without the Wizard Tool.  
The Wizard Tool can map these out for you in about a second.

So, as a general rule, there needs to be one folder of properly named samples for every 
single velocity or dimension split.  
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Using the Wizard Tool-Simple Mapping:

1. Start with a new instrument and import the 4 Tutorial 
Electric Piano folders into the Sample Window.

These can be found in the “Editor Tutorial Files” directory 
for this chapter. 
(How To Use the Wizard Tool folder-EP)

2. Start the Wizard Tool by clicking on the [Wizard Hat] icon on the tool bar.

3. This brings up Page 1 of the Wizard Tool.  

•Most of the items in here are identical with the Instrument Properties window.  
•This gives you the opportunity to fill in all these details if you wish but you can  
  go back and fill them in later in the Instrument Properties window.  
•At the very least, you might want to enter an instrument name.

Click the [Next] button to proceed to the next step.
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4. Select the checkbox “Create Regions 
every” and set it to 1 half step.  This will 
create chromatic regions, one for every 
note on the keyboard.  

The other option would stretch non-chromatic regions.

•“Ignore unity notes” is for non-melodic samples like percussion and sound effects.   
    Checking this box will let the Wizard Tool map the samples alphabetically across the   
    keyboard.

•“Finish with this step” would simply create a bunch of blank regions across the key 
    board.

5. Set the Start-note to A0.  

Set the End-note to C8.  

This sets the range to cover an 88-note keyboard.

6. Leave these check boxes blank and click the [Next] 
button to move to the next step.



152

7. Go to the top Controller Source and choose “Veloc-
ity”. This will be our velocity split dimension.

8. Set the Splits number to 4.  This will create 4 velocity splits, one for 
each folder of samples.

9 Fill in the Description and the State Names.  

These work the same way as the description and spit names when manually creating 
dimension splits.  This is a good habit to get into because these names can really help 
keep you bearings when dealing with complex instruments.  Also, naming is absolutely 
essential in the last step of the Wizard Tool as things get more complex.\

10. Click on the “Reserve space for stereo” checkbox.  

Anytime you are dealing with stereo samples, this box needs to be checked.  Leave it 
blank when using mono samples.

Click on the [Next] Button to move to the last step.
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This is the final step of the Wizard Tool.  As you can see, the Velocity split state names
are in the section on the right.  Without the names, they would just be MIDI number 
ranges, which are much harder to read, especially when we start dealing with more di-
mensions.

Also notice that the folders of samples are represented in the left section.  Mapping the 
samples out is simply a matter of assigning these folders to the splits in the right sec-
tion.

11. Assign the folders on the left (one at a 
time) to their corresponding velocity split 
on the right.  

To do this, click on a folder and then click 
on a velocity split name.

Click on the [Next] button to finish the Wizard Tool.
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12. The Wizard Tool instantly maps out the whole instrument across the keyboard.

13. Each Region has the 4 Velocity Split 
points that were represented by the 4 
folders of samples.

The samples have the unity note in their 
name so they are mapped to their unity.

If the samples are not chromatic, they will 
be pitch stretched up & down until they 
meet up with the neighboring samples.  

If the samples meet on the same note, 
the higher sample will stretch down.  

Doing this by hand would have taken at least an hour or more.

The instrument is now mapped out.  Save it and load it to a MIDI channel to hear what 
it sounds like and start tweaking it.
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Chromatic vs. Non-Chromatic mapping:

In this example, we chose to map the notes chromatically even though the samples are 
not chromatic. (Create Regions every 1 half step option)

Alternatively we could have created one region per sample to be able to better see 
where the samples are.

The disadvantage of doing it this way is that it limits the note-by-note fine-tuning that
can be done if the samples are mapped chromatically.  The results sound the same ini-
tially with either method but the ability to make chromatic edits is limited.  

Here is an example using the Drag Tools.  Lets say we want to have the Release time 
short at the top and have it gradually get longer going down the keyboard.

With the Non-Chromatic mapping we are limited to one envelope per thick region:

With the Chromatic mapping we get one envelope per note.  

This is something to keep in mind as you create instrument.  If you don’t need the edit-
ing resolution, the non-chromatic mapping makes it easier to see where the samples 
are mapped.
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Using the Wizard Tool-Complex Mapping:

In this example well use the Bass Ensemble samples to create a complex key-switch 
instrument with two velocity splits.  This will demonstrate the need for good labeling of 
the descriptions a split names.  

1. Start off again with a new .GIG file and im-
port the Tutorial Bass Folders into the Sample 
Window.

These can be found in the “Editor Tutorial 
Files” directory for this chapter. 
(How To Use the Wizard Tool folder-Bass)

2. Start the Wizard Tool and go to step 2.

3. This time select the “Make a region per sample” checkbox.  This will allow us to see 
how the samples are mapped & stretched out.  

4. Set the Start & End Note to C1 & B2.  There are only a few samples included with the 
bass ensemble tutorial samples so this is a good range that will also stretch the top and 
bottom notes a bit.

Move on to step 3 in the Wizard Tool.
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5. Set the first controller to Velocity and give it 2 splits.  Name it “Velocity Splits” in the
Description field.

6. Set the second controller to “Keyboard” and give it 8 splits.  Name it “Key-Switch” in 
the Description field.

7. Click on the [Velocity State names] button and 
name the splits as shown.  

Click the [OK] button when finished.

8. Click on the [Keyboard State names] button and name the splits as shown.  These are 
named for each type of articulation.  Click the [OK] button when finished.

Move on to last step 4 in the Wizard Tool.
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Here is where the naming comes in real handy.  This would just be a matrix of numbers 
otherwise.

9. Map the folders on the left to the splits 
on the right.  Match the folder names to 
the split names.

10. The Wizard Tool maps the regions 
across the keyboard.
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11. The Dimension Control window shows the Key-Switch splits and the descriptive 
names that were entered in the Wizard Tool.

12. The Dimension display also shows the descriptive names of the dimension and the 
individual splits.

The instrument is now mapped out.  Save it and load it to a MIDI channel to hear what 
it sounds like and start tweaking it.
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Complex Mapping Example:

Here is a brief example of some fairly complex mapping in the Wizard Tool.

In step 3 of the Wizard Tool, we have 4 dimensions. (5 including Stereo)

•2 Velocity Splits
•4-Way Keyboard Split that changes between 4 articulations.
•2-Way Layer that adds the Tremolo samples.
•2-Way Sustain Pedal switch that changes to the Staccato samples.
•Stereo

The Descriptions and State Names are meticulously labeled.

Here is the final Step showing all the articulations and names.
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Here is what you would see if you 
don’t enter descriptions and state 
names.
It would be virtually impossible to 
figure out what goes where in this
matrix of numbers.

Here are the dimensions of the finished instrument.

This will allow a 4-way key-switch between Sustain/8th Note/Quarter Note/Pizz
The Layer could have the Mod-Wheel fade the Tremolo layer in.
The Sustain Pedal would switch to staccato samples.

This is just quick hint of the complexity and creativity available when using the Wizard 
Tool.
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Load Status Lights:

The load status of an instrument is very important when you are editing instruments.  
You can play the instrument while you edit and hear most of the changes in real-time 
as long as the instrument is loaded to a MIDI port and channel and the load status light 
is green. 

Loading Instruments to MIDI channels:

1. Choose port & MIDI channel.  

2. Click on the [Download] button. 

3. Make sure keyboard is sending to that channel and connected to the port.

4. The entire gig file will load to the MIDI channel.  You know it’s loaded properly be-
cause the “Loaded” light is green and the “Reload” light is off.  

5. If there are more multiple instruments in the .GIG file, select the one you want to hear
and play it.  This is like making a patch change and happens instantly.
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Load Indicator Lights:

Grey: The .GIG file is not loaded.  You need to click the [Down-
load] button to load it to the selected MIDI channel.

Green: The .GIG file is loaded. Continue editing until this light
turns yellow or red.

Yellow: The changes that have been made to the instrument 
require quick save. 

You will still hear the instrument but the recent changes will not be heard until you 
save the instrument.  These are minor changes to the instrument such as moving or 
stretching note regions.

Do do a quick save, click on the [Download] button. 

This will bring up the “File modified”
window.  For the quick save, click on the 
[Save] button. 

This will save the changes that were made without having to save the entire .GIG file to
disk.

However, if you choose [Save As] this will save the whole .GIG file to disk using a differ-
ent file name.  
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Red: The changes made require a complete resaving of the 
entire .GIG file.  

These are major changes that alter the structure of the .GIG file.

•Adding, removing, reordering or changing dimension and velocity splits.
•Adding, deleting or replacing samples.
•Adding, deleting or importing new instruments.
•Moving instruments between banks or adding & deleting banks.

To do a full save, click on the [Download] button.

This time, if you choose the [Save] 
button, the entire .GIG file will be
resaved.  

This will write the whole file to the temp directory and then overwrite the original file.

A faster way to work is to choose [Save As] instead and save as a new file.  You can then
delete the original .GIG file if you like.  This avoids the extra step of copying the whole file
to the temp directory.  It also keeps a backup of the original .GIG file.  
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Separating Parameters from .GIG file:

As you can see, doing a complete full save can be time consuming if you are dealing 
with large .GIG files.  This problem has been solved with the ability to separate the in-
strument parameters from the samples.  

1. Go to the File menu and choose [Save As…]

2. In the new GigaStudio Browser screen, look in the lower left for this check box.
“Keep all waves in extension files for fast editing of instrument definitions”

3. Check that box and then [Save] the file.
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4. This will create two files, a .GIG file (which contains the parameters) and an Extension
file (which contains the samples)

5. From here on out, you can make major changes to the file in the Instrument Editor
and you will no longer have to wait for the complete .GIG file to save every time.  

Things to keep in mind:

•This file will load just fine in the main GigaStudio Interface but you need to
  make sure that both files are together on the hard drive, or this will not work.

•If you want to simplify things, you can re-save this split file again when you’re  
  done editing. Save it again but with the checkbox “un-checked” and it will  
  merge them back together into a single .GIG file that contains the parameters    
  and the samples as before.  This is something that library developers might  
  want to do to keep everything together and make for a cleaner release.  

•This is most useful for large .GIG files.  It’s probably not worth the effort for  
  smaller files, which would reload fairly quickly.  
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Instrument Editor Menus:

Editor Menu Details:

There are some things to keep in mind with the Editor menus.

Edit Menu Changes:

Some parts of the Edit Menu will change depending on what has been selected in the 
Editor. (Mainly the Cut-Copy-Paste-Delete-Rename commands)

These commands will change what they refer 
to when ever you change the type of item 
that is selected.  

If you have highlighted an instrument, then 
these 5 commands will refer to “Instruments”

If you have highlighted a Region, then these 
will refer to “Regions” instead and so on for 
Banks-Instruments-Regions-Folders-Samples.  



169

Menu Key Commands:

Every Menu item has a Keyboard Shortcut.  These are shown as each item is described 
but you can figure them out by simply looking at the Underlined letters in the Menu
Titles.  

Most of the Keyboard Shortcuts start with the [Alt] Key followed by a letter.  

For example [Alt] + [F] will open up the File Menu.  

[Alt] Key followed by [F] Notice that the word “File” on the menu has the F under-
lined.

[Alt] + [F] + [S] will Save the file.  

[Alt] followed by the letter [F] again which brings up the File Menu, then followed 
by the letter [S] which brings up the Save feature.  Notice again how the word 
Save has the S underlined indicating that S is the keyboard shortcut.

The underlined letters inside the dropdown menus will only be underlined when 
you use a key command.  If you use the mouse, then the letters inside the dropdowns 
menus will not be underlined.

By observing the underlined letters, you can navigate the entire menu with keyboard 
shortcuts without having to refer to the manual.  

Some standard keyboard shortcuts use the Ctrl key as well.  These are also displayed in 
the menus.  

Menu Opened with the [Mouse] Menu Opened with the [Keyboard]
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File Menu: [Alt] + [F]

New: [Alt] + [F] + [N] or [Ctrl] + [N]

This creates a new and empty .GIG file.

Open…[Alt] + [F] + [O] or [Ctrl] + [O]

Use this to find and open a .GIG file. This will bring up the file browser screen below.
This is a slightly customized version of the typical Windows file browser window.
See chapter “08-02 How To Open a GIG File” for more details.
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Save: [Alt] + [F] + [S] or [Ctrl] + [S]

Save the currently loaded .GIG file.  

•If the file is new and has never been saved before, you will get the “Save As”  
  screen where you can name the file and select where you want it to go on your  
  computer.

•If the file has been saved before, it will automatically save over the existing file.

•If the existing .GIG file is tagged as a “Read Only” file, you will get a message
  asking if you would like this removed before saving over it.  

Save As… [Alt] + [F] + [A]

Save the currently selected .GIG file to a new file.

This is the option to use on a file that already exists on the hard drive that you don’t
want to save over.
  
The “Save As” screen will come up so that you can choose the location and name of the 
file you are saving.  
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Save Limited: [Alt] + [F] + [L]

This is a specialized save option that gives you three choices.

Instruments requiring more than 64 MB:
This will only save instruments from the .GIG file that do not need more than 64 MB of
RAM buffering and will omit any instruments that need more.

Instruments requiring more than 32 MB:
This will only save instruments from the .GIG file that do not need more than 32 MB of
RAM buffering and will omit any instruments that need more.

Un-referenced Samples:
This option will keep the Editor from saving any samples that are not being used in any 
of the instruments in the .GIG file.  This is much faster than having to manually hunt
through a potentially long list of samples & folders of samples, trying to figure out
which ones are not being used and deleting them.
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Merge File…[Alt] + [F] + [M]

This option allows you to merge other .GIG files with the one you are working on.  

Note on Merged Waves:

If the Editor determines that there are identical samples after merging or copying & 
pasting instruments, it will not re-import those particular samples.  This avoids redun-
dant samples and the hard disk and RAM buffering resources that would get used up 
otherwise.

It will bring up a browsing win-
dow that works just like the 
“Open New Instrument” window 
described earlier.  

You can then hunt for the .GIG 
file/s you want to merge.  

Select the files and hit the open
button 

The instruments in the selected 
.GIG files will be imported into
the current .GIG file.  

The instruments will be added to 
the “Instrument & Bank” window 
and the samples will be added to 
the “Sample Pool” 
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Load Articulation…[Alt] + [F] + [R]

This is where you apply and Articulation (.ART) file to the current .GIG file.

This screen is also very similar to the other browse windows but it is filtered to only
search for .ART file.  Just search for the .ART file you want to use and hit the “Open” but-
ton and it will apply all the mappings and parameters of the Articulation file to the cur-
rent .GIG file.

An Articulation File is a tiny file that contains all the mappings & parameters of an in-
strument, separate from the large samples.  This allows people to update instruments 
without having to send entire .GIG files with all the samples.  This file is small enough
to upload or email so that you can share your changes with other people that have the 
same original .GIG file.  This is great for sharing various edits and tweaks, official library
updates and is especially helpful for long distance collaboration on a library.
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Save Articulation…[Alt] + [F] + [T] 

Recent Files: [Alt] + [F] + [Up & Down Arrows]

Exit: [Alt] + [F] + [X] 

•This is how you create your own Articulation file.  

•Once you have a .GIG file edited and tweaked, you can save all the parameters  
  and sample mappings to an .ART file here.  

•Choose where you want to save the file and give it a name and hit the “Save”
  button.  

•The last 4 .GIG files that have been loaded into the Editor are listed here.  

•You can quickly load them by selecting them here instead of having to hunt for  
  them in the “Open” browse window.

•This will shut down the Editor.  

•You can also close the editor by clicking the X in the top right corner as with any  
  Windows program.
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Edit Menu [Alt] + [E] 
The Edit Menu is where you will find the vari-
ous editing commands.  

Many of these commands can be accessed 
with the computer keyboard.  

These keyboard commands match the stan-
dard Windows keyboard shortcuts for the 
most part.

The display of the edit menu will change 
depending on which area of the Instrument 
Editor is highlighted to reflect what kind of
objects are to be edited.  The section with the 
cut, copy, paste, delete & rename will change.  
The rest of the menu stays the same.

Edit Menu for “Banks”

This is what the Edit Menu looks like when an 
instrument bank is highlighted in the Editor.

This means you can cut, copy, paste, delete 
and rename entire Instrument Banks.

The rest of the Edit Menu stays the same.
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Edit Menu for “Instruments”

This is what the Edit Menu looks like when an 
instrument is highlighted in the Editor.

This means you can cut, copy, paste, delete and 
rename entire Instruments.

The rest of the Edit Menu stays the same.

This is what the Edit Menu looks like when a 
Region is highlighted in the Editor.

This means you can cut, copy, paste, delete and 
rename entire Regions.

The rest of the Edit Menu stays the same.
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This is what the Edit Menu looks like when a 
Folder is highlighted in the Editor.

This means you can cut, copy, paste, delete 
and rename entire Folders.

The rest of the Edit Menu stays the same.

This is what the Edit Menu looks like when a 
Sample or group of Samples is highlighted in 
the Editor.

This means you can cut, copy, paste, delete 
and rename entire Samples.

The rest of the Edit Menu stays the same.
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To make an edit, select an item with the mouse and go to the menu with the mouse or 
with a keyboard shortcut and choose the edit command you want to use.

There are also various short cut keyboard combinations you can use.

•[Ctrl] + [X] to Cut
•[Ctrl] + [C] to Copy
•[Ctrl] + [V] to Paste
•[Delete Key] to Delete

Many of these options are also available by “Right Clicking” on the item instead of going 
up to the menu.  

Undo: [Ctrl] + [Z] or [Alt] + [E] + [U]

•This will undo your most recent edit.  
•Selecting this again will “Redo” the edit that was “Undone”.  
•You can toggle back and forth between “Undo” and “Redo” using the mouse or  
  Ctrl+Z.  
•[Alt]+E+U will only work for the “Undo” but will not toggle the “Redo”  

Cut: [Ctrl] + [X] or [Alt] + [E] + [C]

•This Cut command will “Delete” the selected item and put it into the clipboard so  
  that it can be pasted later to another location.  
•You can paste to a variety of locations including different areas within the 
  current .GIG file or to other .GIG files that are opened in the Editor.
•You can also Right-Click with the mouse over an item to bring up the Cut 
  command without having to go to the Edit menu.

Copy: [Ctrl] + [V] or [Alt] + [E] + [C] + [C] 

•The Copy command will “Copy” the selected item without deleting it and put it  
  into the clipboard so that it can be pasted later to another location.  
•You can paste to a variety of locations including different areas within the 
  current .GIG file or to other .GIG files that are opened in the Editor.
•As with the other basic edit commands, you can also Right-Click with the mouse  
  over an item to bring up the Copy command without having to go to the 
  Edit Menu.
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Paste: [Ctrl] + [V] or [Alt] + [E] + [P]

Delete: [Delete] Key or [Alt] + [E] + [D]

Rename: [Alt] + [E] + [N]

•Once you Cut or Copy and item, this command will Paste it where you instruct it  
  to.

•There are a variety of ways to paste depending on the item you are working  
  with.  For example, regions can be pasted to the same key range or you can  
  specify where to paste them .  This will all be covered in detail in each area of 
  the Editor.

•As with the other edit commands, you can right click with the mouse over an  
  item to bring up the Paste command without having to go to the Edit Menu.

The Delete command will delete the item you have selected.  You will get a prompt ask-
ing if you really want to delete the item.  Choose [Yes] to delete it or [No] if you change 
your mind.  

•This is one of a couple of ways that you can rename a Bank, Instrument, Folder  
  or Sample.  

•Select the item you want to rename and choose “Rename” from the edit menu.   
  This will highlight the name of the item and you can then change the name.

•Another method is to click on the item once with the mouse to highlight it. Then  
  click it a second time to put the name in edit mode.  (Two slow clicks, not a fast  
  double-click)
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Import samples: [Alt] + [E] + [S]

Import sample directory: [Alt] + [E] + [Y]

Export all sample folders: [Alt] + [E] + [A] 

This is one of several ways to import samples into a .GIG file.  

•Select a folder in the Wave Pool where you want the imported samples to go and  
  then choose “Import samples”.  
•Use the browsing window that comes up to navigate to the wave files you want  
  to import. 
•Select the waves and click on the open button.  They will show up in the folder  
  you selected in the wave pool.

You can also right-click on a folder in the Wave Pool and choose to import samples or 
directories from there as well.

Alternatively you can simply drag & drop wave files or folders full of wave files directly
from the Windows desktop into the Wave Pool area of the Editor.

This works very similar to the “Import samples” command but you choose a folder full 
of wave files instead.  The navigation-browsing window is slightly different looking as
well.  

Remember, just like with the waves, you can drag & drop folders full of wave files direct-
ly from the Windows desktop into the Wave Pool area of the Editor.  Using this method, 
you can import more than one directory at once.

You can also right-click anywhere in the Wave Pool and choose “Import directory” from 
there as well.

This will export all the samples in a .GIG file to standard wave files on your hard drive.
These wave files will also include any existing loop points in them.  This is handy if you
need to do audio editing to a bunch of the samples in an instrument.  You can later use 
the “Replace All” option to batch replace the samples back into a .GIG file.  

You should first create an empty folder on the hard drive where you want these samples
to go.  Then choose this command and browse to the folder you created and click on the 
OK button to export them.  The folders and samples will be named and organized the 
same way they are in the Wave Pool. 
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Convert wave pool format: [Alt] + [E] + [F]

This is a handy new feature that allows you to batch convert ALL the samples in a .GIG 
file to various bit rates, compression settings and channel conversion settings.
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Convert wave pool format to:

This drop box displays the various bit rate and compression (disk acceleration) options 
you can choose.

24-bit, integer:
Uncompressed full size 24 bit waves.  This will of course get less polyphony than 16 bit 
samples.

24-bit, min. accelerated (preserve 24 bits):
Disk acceleration compression with no loss of quality.  This improves the polyphony 
and reduces the file size significantly. The polyphony is similar to uncompressed 16 bit
samples with no loss of quality.  

24-bit, nom. accelerated (preserve 20+ bits):
More disk acceleration compression with 20-bit quality. This offers even more polypho-
ny with a very slight quality loss.

24-bit, max. accelerated (preserve 18+ bits):
More disk acceleration compression with 18-bit quality. This offers even more polyphony 
with a very slight quality loss.

16-bit, integer:
Standard uncompressed 16 bit samples.

16-bit, accelerated (preserve 16 bits):
Disk acceleration compression with no loss of quality.  This improves the polyphony and 
reduces the file size significantly.
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HD1 dither (adds 1.5 bits eff. resolution)  

In most cases, this box should be checked whenever you are converting from 24-bit to 16 
bit samples.  In the rare case that dither noise has been added to 24-bit samples before 
importing them into the GigaStudio, you can uncheck this box.

Convert stereo to mono

At last there is a way to convert all the samples of a .GIG file from Stereo to Mono.  The
.GIG file will adjust the stereo dimension to Mono to accommodate this.
You get the choice of combining the left and right channels or picking one or the other.

Conversion Display Window.

The Conversion Display window shows the progress of the conversion.  It shows which 
samples have been converted and it shows weather the conversion was feasible or not.  
Samples that are too short to start with will not benefit from the Disk Acceleration
Compression for example.



185

Edit macros: [Alt] + [E] + [M] 

You can open the Macro Editor from the Edit menu.

You can also open it with the Macro Edit button at 
the bottom of the Editor.

This brings up the Macro Edit 
Screen.

This is where you can edit the 
Name and the Hotkey of any 
created Macros.  You can also 
Delete them here as well.

A Macro allows you to save commonly used parameter edits to be reused later.  For 
instance, if you spend some time tweaking the perfect filter setting, you can save it as
a macro and instantly apply it to any region of any instrument in the future without 
having to completely redo it from scratch.  Macros are covered in the reference Chapter 
“09-09 Macros”
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Editing Macros:

To edit a macro, double click 
on the macro name or select 
the macro and click on the 
“Properties” button.  

This will bring up a window 
where the name and hotkey 
can be edited.

To delete a macro, click on 
the macro name and then 
click on the “Delete” button.

In this example, the Flute Fil-
ter Macro has been deleted.
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Instrument wizard: [Alt] + [E] + [W]

Combine instruments [Alt] + [E] + [B]

Crossfade editor: [Alt] + [E] + [O]

This command brings up the famous and all-powerful Wizard Tool.

It can also be launched with the Wizard Icon on the Tool Bar.

The wizard tool helps you to automatically map samples across the keyboard, across 
multiple velocities and dimensions in a matter of seconds.  It is covered in detail in the 
Wizard Tool tutorial “08-09 How To Use the Wizard Tool”

•With this feature, you can combine several instruments into a single instrument  
  in a variety of ways.  You can use this feature to create velocity split, layered or  
  dimension split instruments out of several existing instruments. 

•You can also access this command by Right-Clicking in the Instrument area.

•You must have at least two instruments selected in the Bank/Instrument 
  window to access this command.  Otherwise, this command will be grayed-out. 

This command brings up the Crossfade editor screen where you can graphically edit the 
cross-fades of a layered instrument.  
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File info: [Alt] + [E] + [I]

This command brings up the File Information Window.

Most of this is window is self explanatory and obvious.  You just fill in any of the fields
you see with text.  There is even a Comments section to add even more detailed infor-
mation about the instrument.  

An important section to point out is the Keywords section.

This is where you can enter keywords that the Quick Sound Database will recognize 
when doing complex searches for GigaStudio instruments.  The search criteria can also 
be edited from the Main Giga Interface and you can to batch keyword entry as well.  

The QuickSound Database is covered in detail in its own chapter. “05-05 Tutorial 5 
– QuickEdit”
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Preferences: [Alt] + [E] + [R]

This is where you setup the various preferences for the Editor. It’s a very important sec-
tion to get to know.
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Middle C is: C3-C4-C5 (Default is C4)

This setting will set the location for middle-C.  Some keyboards standard for middle-C 
is offset from what the GigaStudio and many other MIDI devices use.  (MIDI note 60)  
This setting allows you to match your keyboard setting.  The red Middle C indicator will 
move when you change this setting to confirm the change.  

Set to C3

Indicator at C3

Set to C4

Indicator at C4

Set to C5

Indicator at C5
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Unity note for imported .wav files

•When you import samples into the Editor, this setting will choose what unity  
  note to assign to each sample.  This is essential when working with the Wizard  
  Tool, especially if you don’t have chromatic samples.  
•The Wizard Tool can use these unity note settings and automatically assign 
  regions by unity note and stretch them properly.  
•When mapping by hand, this unity note setting will also be taken into account  
  for pitch setting and stretching.

This will set all the waves that you import to a unity note of middle-C.  This is good for 
non-melodic instruments like percussion or sound effects that you want to play at the 
natural pitch.

Default to middle C:

Guess from filename (e.g. *61.wav):

If you put the MIDI note number (0-127, Middle-C being 60) in the wave file names, the
Editor will automatically assign these as the unity notes.  Use this setting if that is the 
way you name your samples.  

Guess from filename (e.g. *C#4.wav):

If you put the Note Name (C4-C#4-D4 etc..) in the wave file names, the Editor will auto-
matically assign these as the unity notes.  Use this setting if that is the way you name 
your samples.

Be sure to include the note and the octave when naming the samples.  
Be sure to use the number sign (#) for flat & sharp notes.
(A# instead of Bb for example)  
We advise that you put a space between the name and the unity note in the file
name to avoid confusion.  
(Violin Staccato C#4.wav but not ViolinStaccatoC#4.wav) 
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Filename overrides internal setting:

If there are already unity note settings embedded in the wave files, this check box will
override these internal unity notes in favor of the wave file name.  Some audio editors
allow you to embed the unity note information into the wave file.  Some even do it au-
tomatically, which could be troublesome if you want to use the file name to determine
the unity note.  That is what this checkbox is there for.

Adjust unity note by # half steps:

This allows you to transpose the unity notes by half steps after the unity notes are as-
signed.  For example, if you are importing samples with unity notes of F3-F4 (embedded 
or in the name of the files) and you decide that you want them to be assigned to C4-C5;
you would enter a value of 7 here to transpose everything up after it is imported.  Then 
the unity notes will be assigned based on all the settings above plus this offset.  You can 
also offset in negative numbers.  This saves having to go back and rename all of your 
wave files again or having to embed different unity notes into them.

With this section, each manually created region can be created with a default amount 
of velocity splits and stereo settings.  You can always come back to this screen and ad-
just these as you work depending on what you need.  It is a huge time saver.

Velocity splits for manually created regions:
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Examples:

Here we have 1-Velocity Split and nothing in the Stereo 
checkbox. This will create a mono region with no Velocity 
Splits.

Here is the resulting Region’s Velocity window:
Zero Velocity Splits and Mono

Here we still have 1-Velocity Split but now the Stereo 
checkbox is selected.

Here is the resulting Region’s Velocity window:
Still no Velocity Splits but it is now Stereo.

Now we have 4-Velocity Splits and Stereo Selected.

Here is the resulting Region’s Velocity window:
Now we have 4-Velocity Splits and Stereo.



194



195

Temp directory:
All the editing done in the Editor is nondestructive, even edits done to the waveforms 
in an external audio editor.  This is because when you load a .GIG file into the Editor or
import wave files to the wave pool, they are all stored in a temp directory on your hard
drive, separate from the original .GIG files or wave files. You can choose which hard
drive and directory to use as the temp folder here.

Audio Editor:
To make changes to the audio of the samples, you need to use an external audio editor.  
This setting will choose which audio editor to use when you choose to “Edit Audio” on a 
sample in the Editor.

Reload Warnings:
These next two options are related to the Load & Reload status of a .GIG file.  Some edit
changes will require a partial save while more drastic ones will require a complete re-
saving of the whole .GIG file.  You will probably want to be warned about this before the
Editor starts a long saving process or overwrites your file with the new settings.  That is
what these settings are foe.  
See the tutorial on the Load and Reload status light for more details. “08-13 Load Status 
Lights”

Warn if reload requires save:
This refers to the quick (or partial) save option.  If you do not have this checked, the Edi-
tor will automatically do a quick save on top of your existing .GIG file.  If it is checked,
you get a warning screen that gives you the opportunity to “Save As” to another file
instead.  

Warn if reload requires FULL save:
This refers to the full save option.  If you do not have this checked, the Editor will auto-
matically do a full save on top of your existing .GIG file.  If it is checked, you get a warn-
ing screen that gives you the opportunity to “Save As” to another file instead.  

Warn about unmapped regions on save:
This will warn you if you have any blank regions with no samples assigned to them.  
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Use internal names on WAV import:
Wave files can have two different names, Internal and External names.  
The External name is the name of the file as you see it on the windows desktop, just like
any other file name.

The Internal name is usually the same name as the external name but can be different 
if you like.  Most audio editors can set a differing internal name or it can be set in the 
summary information in the file properties of a wave file. If the Internal Names option
is checked, the sample will be named the internal name when it is imported into the 
Giga Editor.

Retune regions when dragging:
This will choose whether your samples will transpose or not when you drag regions up 
& down the keyboard.  If you don’t want them to transpose (Pitch Stretch) then check 
this box.  If you do want the pitch to transpose as you move the regions around, then 
leave it unchecked.  

Update region properties after wave edit:

•Checked-any audio edits you make to a sample/s will updated every case of the  
  sample/s throughout the .GIG file

•Un-checked-the wave file/s will be edited but the changes will not be reflected in
  the .GIG file until you re-map the sample/s to a region.

Update region properties after sample replace:
Similar to the last checkbox except it applies to replacing samples instead of editing 
them.  

•Checked-If you replace samples or directories of samples, the samples will be re 
  placed throughout the entire .GIG file.

•Un-checked-If you replace samples or directories of samples, the samples in the  
  wave pool will be different but the changes will not be reflected in the
  instruments of the .GIG file.
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MIDI Menu: 
Channel Status: [Alt] + [M] + [C] 

Channel Status Tool Bar Button.

You can also open the MIDI Channel Status window with this Icon on the Tool Bar.

This screen displays the port and channel information for the instruments that are 
loaded in the Instrument Editor.

Instruments need to be loaded to MIDI channels to be seen here.
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View Menu: [Alt] + [V]

Tool Bar: [Alt] + [V] + [T] 

You can free up screen space by disabling any of these 
items. Toggle them on and off by clicking on the item 
in the menu.  A checkmark will appear beside enabled 
items.

This command displays or hides the Toolbar

The toolbar gives you quick access to some of the commonly used commands.  These 
are the same commands that are found in the menus.

New (New command from the File Menu)

Open (Open command from the File Menu)

Save (Save command from the File Menu)

MIDI Channel Status (MIDI Channel Status from the MIDI Menu)

About (Version Info from the Help Menu)

What’s This? (Click this button, then click on any area of the Editor and the 
relevant section of the help file will automatically open up)
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Status Bar: [Alt] + [V] + [S]

This command displays or hides the Status Bar

Show Audio: [Alt] + [V] + [A]

This command displays or hides the graphical audio waveform view.
The Waveform View displays the sample wave and the Graphical Parameter such as 
ADSR envelopes, LFOs and Loop points.  
This allows you to precisely edit these parameters and see how they will lay on top of 
the sample.

Waveform View

Audio-Audio card information

Voices-Real-Time polyphony usage meter
Peak-Highest polyphony count measured

External MIDI-MIDI Port status lights.  

Memory-Percentage of RAM used for sample loads

Temp Free-Amount of space free on the temp directory

Committed-Amount of temporary drive space being used by 
all the loaded instruments.
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Tall Velocity Window: [Alt] + [V] + [V]

This command hides or displays the Tall 
Velocity Window.  If you have a lot of velocity 
splits, this comes in real handy for seeing more 
of them at once.
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Window Menu: 
This is similar to the menu that is in most Win-
dows programs.  

It allows you to arrange multiple open .GIG files on
the screen weather minimized or open windows  

You can also toggle between multiple .GIG files in
this menu.

Cascade: [Alt] + [W] + [C]

When you have several .GIG files opened in the Editor, this command will shrink the
windows down a bit and stack them diagonally across the screen.

To restore the full screen view, select the Maximize button in the 
upper right corner of one of the .GIG file windows.
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Arrange Icons: [Alt] + [W] + [A] 

The .GIG file windows need to be minimized down to Icons to use this command.  

Once you have several minimized icons on the screen, the Arrange Icons command will 
arrange the icons neatly across the screen.  

Select .GIG File: [Alt] + [W] + [Number]
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Help Menu: [Alt] + [H] 

Help Topics: [Alt] + [H] + [E] 

About: [Alt] + [H] + [A] 

The Help menu is where you can launch the Editor Help file and
display the software version information.

This command launches the Editor Help File

This command opens the Version Information screen
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Bank & Instrument Window

This is where you manage your Instruments and 
Instrument Banks.

Bank & Instrument Facts:

•GIG files can have multiple Banks and multiple Instruments.
•These correspond and respond to standard MIDI Bank and Patch/Program  
  Changes.
•This is where you cut, copy, paste & rename instruments and change their bank  
  & Patch numbers.
•You can also cut, copy & paste banks as well.
•Banks & Instruments can be moved or copied between .GIG files.
•This is where you toggle between multiple instruments to move or copy regions     
  between instruments.
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Banks:
Here is an example of two Instrument Banks.  This is 
two out of a potential of 127 Banks.
Banks will respond to MIDI Bank Changes.
Banks are also handy for organizing Instruments.

Opening & Closing Banks:

To Open an Instrument Bank, click on the 
[plus + sign] with the mouse.  You can close it 
again by clicking on the [minus – sign].

Now the Bank is open and you 
can see the two instruments in-
side it.

You can also open several Banks 
at once.

The second bank is now opened.
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Creating a New Bank:

1. [Double-click] on an instrument to bring up the Instrument Properties. 

You can change the Bank and Patch number here among other things.  

In this example, we will change this instrument to Bank 3.  This will create a new Bank 
and move the instrument into it.  This is how you create new Banks.

2. Now the instrument is in Bank 3.
This is the best way to create a new 
Bank.
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Deleting Banks:

1. To Delete a Bank, select the Bank you 
wish to delete with the mouse.  

Keep in mind that when you delete a 
Bank, you also delete any Instruments 
within it. 
(The samples are not deleted however)

2. Go to the Edit Menu and choose “Delete 
bank” with the mouse.  

The Edit Menu lists these edit commands 
as Banks since we have selected a Bank.  

These will change depending on what is 
selected.

3. Or [Right-Click] on the Instrument 
Bank to bring up the Bank Edit menu and 
choose “Delete bank” with the mouse.

You can also click on the [Delete-Key] on 
your computer keyboard.

4. You will then get a window asking if 
you are sure you want to delete the Bank. 

Choose Yes to delete it.

5. Now the Bank is gone.  

The wave files of the deleted instrument
will remain in the .GIG file in the sample
pool.
You can only delete one bank at a time.  
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Cut or Copy Bank:

2. Once you have selected a Bank to Copy or Cut, you can go to the “Edit Menu” and 
choose the “Copy” or “Cut Bank” command using the mouse.  

1. Select the Bank you want to Copy or 
Cut & Paste a Bank, with the mouse.

3. Go to the Edit Menu and choose “Copy 
bank” or “Cut bank: with the mouse.

“Copy bank” will copy the Bank and all of its 
Instruments to the clipboard.

You can also use [Ctrl] + [C] on the computer 
keyboard.

4. “Cut bank” will delete the Bank and then 
copy all of its Instruments to the clipboard.

You can also use [Ctrl] + [X] on the computer 
keyboard.

5. Or [Right-Click] on the Bank to 
bring up the Bank Edit Menu and 
choose “Copy bank” with the mouse.

6. A progress window will come up.

Now we are ready to Paste the Bank 
to a new location.
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Paste Bank:

1. Go to the Edit Menu and choose “Paste 
bank” with the mouse.

You can also use [Ctrl] + [V] on the com-
puter keyboard.

2. Or [Right-Click] on the Bank 
to bring up the Bank Edit menu 
and choose “Paste bank” with the 
mouse.

3. You will then get a prompt ask-
ing you to pick an unused Bank 
Number.

For this example, we will choose 2.

4. The Bank is now copied to its 
new location with all of its instru-
ments.



211

[Drag and Drop] Copy & Paste Banks:

A simpler and faster method is to [drag & drop] the Bank with the mouse.

1. Grab the bank with the mouse 
and hold the left mouse button 
down and drag into any of the 
surrounding space.

This one simple operation will do 
all the steps mentioned before in 
one quick stroke.

2. You will get the prompt to put 
in an unused bank number and 
then the  Bank will be copied as 
before.
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Copy & Paste Banks between different .GIG Files:

The Cut/Copy & Paste functions can also be applied between .GIG files.

[Drag & Drop] Between files:

You need to have at least two files opened in the GigaStudio Editor.  They don’t have to
be loaded to MIDI channels for this purpose.  

2. Bring the file with the Bank you want to copy “from” to the front so that it is on top of
the file you want to copy the bank “to”.

1. Go to the Window menu and choose “Cascade” 
with the mouse.  This will stack the .GIG files on top
of each other and minimize their screen to a more 
managble size.
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3. Drag the Bank from one 
file to the other with the
mouse.

4. Enter an unused Bank 
number if necessary.

5. The bank is now copied to 
the other .GIG file.

6. The Samples are also copied to the sample 
window in the .GIG file.
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Cut/Copy & Paste Banks between .GIG files

(with Menus or Key Commands:)

1. Go to the Window Menu and choose the .GIG 
file you want to copy “from”.

2. Select the bank you want to copy with the 
mouse.

3. Go to the Edit Menu and choose “Copy bank” 
with the mouse.

You can also use [Ctrl] + [C] on the keyboard.

4. Or [Right-Click] on the Bank to bring up the 
Bank Edit menu and choose “Copy bank” with 
the mouse.

5. Go to the Window Menu and choose the .GIG 
file you want to copy “to”.

6. Go back to the Edit Menu and choose “Paste 
Bank” with the mouse.

You can also use [Ctrl] + [V] on the keyboard.
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Changing the Bank Number:

7. Or [Right-Click] on the Bank to 
bring up the Bank Edit menu and 
choose “Paste bank” with the mouse.

8. The Bank is now copied.

1. [Right-Click] on a Bank

Choose the “Change bank number” 
with the mouse

2. A window will come up asking you 
for a Bank Number.

You can enter it with the keyboard 
or use the mouse.  Click the [Up & 
Down] arrows with the mouse or 
drag the spinner between the arrows.

3. The Bank is now changed to Bank 4.
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Instruments:
Here is an example of a bank 
with three Instruments.

•An Instrument is what loads to a MIDI channel in the GigaStudio.
•GigaStudio files can have many Instruments within them.  
•The Instruments can all be inside a single Bank or organized across several Banks.  
•Instruments respond to standard MIDI Patch (or Program) Changes in real time.
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Renaming Instruments:

Renaming with the Edit Menu or Keyboard Shortcuts:

1. Select the Instrument you want to 
rename with the mouse.

2. Go to the Edit Menu to choose the 
“Rename” with the mouse.

You can also use [Alt] + [E] + [N] on 
the Keyboard.

3. Or [Right-Click] on the Instrument 
to bring up the Instrument Edit 
menu and choose “Rename” with the 
mouse.

4. The Instrument Name will now be 
highlighted, ready to be renamed.

5. Enter the text that you want for the 
new Name.

6. When you’re done renaming the 
Instrument, click on the [Enter Key] 
or click anywhere on the screen with 
the mouse.  The Instrument is now 
renamed.
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Renaming by clicking on the Instrument Name:

Here is an even simpler and faster way to rename and Instrument.

1. Click once on the Instrument 
name to highlight it.

2. Now click on it a second time 
and you can rename it.

This is like a real slow 
[double-click]

3. Enter the text that you want 
for the new name.

4. Click on the [Enter Key] or click 
anywhere on the screen with the 
mouse.  The Instrument is now 
renamed.
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Renaming with the Instrument Properties Window:

1. [Double-Click] on the Instrument and the Instrument Properties Window will come 
up.  You can then change the name of the instrument.

This is where you can also edit the Patch and Bank number among other things.

2. Or [Right-Click] on the Instrument and chose “Properties” with the mouse.
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Deleting Instruments:

1. Select the Instrument you want 
to delete with the mouse.

2. Go to Edit Menu and choose 
the “Delete instrument” with the 
mouse.  

The Edit Menu lists these edit 
commands as Instruments since 
we have selected an Instrument.  

3. Or [Right-Click] on the Instru-
ment to bring up the Instrument 
Edit Menu and choose “Delete 
instrument” with the mouse.

You can also click on the [Delete-
Key] on the computer keyboard.

4. You will then get a window 
asking if you are sure you want 
to delete the Instrument. 

Choose [Yes] to delete it.

5. Now the Instrument is gone.  

The wave files of the deleted in-
strument will remain in the .GIG 
file in the sample pool.
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Deleting Multiple Instruments:

1. Hold down the [Shift-Key] and 
select several Instruments with 
the mouse.

2. Go to the Edit Menu and choose 
“Delete instruments” with the 
mouse

Notice that the editor displays 
“instruments” (plural) instead of 
“instrument” (singular)  It knows 
that you have selected more than 
one instrument.  

3. Or [Right-Click] on an Instru-
ment to bring up the Instrument 
Edit menu and choose “Delete In-
struments” with the mouse.

You can also click on the [Delete-
Key] on the computer keyboard.

4. Choose Yes to Delete the Instru-
ments.

5. Now the Instruments are gone.  

The Samples are still in the .GIG 
file though.
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Cut/Copy & Paste Instruments:

1. Select the Instrument you want 
to cut or copy with the mouse.

2. Select the Cut or Copy com-
mand from the Edit Menu.

You can also use [Ctrl] + [C] for 
Copy or [Ctrl] + [X] for Paste on 
the computer keyboard.

3. Or [Right-Click] on the Instru-
ment to bring up the Instrument 
Edit Menu and choose “Cut in-
strument” or “Copy instrument” 
with the mouse.

4. A progress window will come 
up showing that the samples are 
being copied.
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Paste Instruments:

1. Select the Bank you wish to copy 
“to” with the mouse.

2. Select “Paste Instrument” in the 
Edit Menu or use [Ctrl] + [V] on 
the computer keyboard.

3. Or [Right-Click] on the Bank and 
select “Past Instrument”.

4. Now the instrument is copied 
to the Bank.
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[Drag & Drop] Instruments between Banks:

[Drag & Drop] Instruments within a Bank:

1. The fastest way to copy and 
Paste an Instrument is to drag it 
from one Bank to another with 
the mouse.

2. In one single step, the Instru-
ment has been copied from one 
Bank to the next.

1. You can also [drag & drop] an 
Instrument within its own Bank 
and create copy of it within the 
Bank.  

Drag the instrument to the Bank.

2. Since there is a patch number 
conflict, you will get this prompt
asking for different Patch loca-
tion.

Give it a new Patch Number.

3. Here is the Instrument copied 
within it’s own bank with the 
new patch number.
Now you can edit this version 
instrument without harming the 
original.
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Copy & Paste Instruments between different .GIG Files:

[Drag & Drop] Between files:

You need to have at least two files opened in the GigaStudio Editor.  They don’t have to
be loaded to MIDI channels for this purpose.  

2. Bring the file with the Instrument you want to copy “from” to the front so that it is on
top of the file you want to copy the Instrument “to”.

1. Go to the Window menu and choose “Cascade” 
with the mouse.  This will stack the .GIG files on
top of each other and minimize their screen to a 
more managble size. 
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3. Drag the Instrument from one 
file to the other with the mouse.  

4. Enter an unused Patch number 
if necessary.

5. The Instrument is now copied 
to the other .GIG file.

6. The Samples are also copied to 
the sample window in the .GIG 
file.
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Cut/Copy & Paste Instruments between .GIG files with Menus or
Key Commands:

1. Go to the Window Menu and 
choose the file you want to copy an
instrument “from”. 

2. Select the Instrument you want to 
copy with the mouse.

3. Go to the Edit menu and choose 
“Copy instrument” or “Cut instru-
ment” with the mouse.
You can also use [Ctrl] + [C] to copy 
or [Ctrl] + [X] to cut on the computer 
keyboard.

4. Or [Right-Click] on the Instrument 
to bring up the Instrument Edit 
menu and choose “Copy Instrument” 
or “ Cut Instrument” with the mouse.

5. Go back to the Window menu and 
choose the file you want to copy “to”
with the mouse.

6. Go to the Edit menu and choose 
“Paste instrument” with the mouse.

You can also use [Ctrl] + [V] on the 
computer keyboard.
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7. Or [Right-Click] on an Instrument to 
bring up the Instrument Edit menu 
and choose “Paste instrument” with the 
mouse. 

8. The Bank is now copied.

Notes on Pasting Instruments:

When you paste Banks & Instruments, one of two things will happen.

•They will simply paste to the next available patch number 

•You will be prompted to assign an unused bank & patch number. 

This depends on what patch numbers are available in the Bank you are copying to and 
what the copied instrument patch number is.  Whenever there is a conflict, then you
will be prompted to assign new bank or patch number.  If there is no conflict, it will
automatically put the copied instrument into the bank at the next available patch 
number.



229

Changing the Bank & Patch number of an Instrument:

1. [Double-Click] on an Instrument to 
bring up the Instrument Properties 
Window.

This is where you change the Bank & 
Patch numbers.

2. Or [Right-Click] on the Instrument 
to bring up the Instrument Edit 
menu and choose “Properties” with 
the mouse.

3. Use the Mouse or Keyboard to 
change the Bank & Patch number.
Click [OK]

4. The Instrument has been moved 
from patch 0 to patch 5.  This moves 
it down in the list and it will now 
respond to MIDI Patch Change 5 in-
stead of 0. 

5. Or we can change the Bank num-
ber.

6. A new Bank is created and the In-
strument is moved to it.



230

Instrument Properties:

Open Instrument Properties:

There are two ways to open the Instrument Properties Screen

•[Double-Click] with the mouse on an instrument

•[Right-Click] on an instrument and choose “Properties” from the Instrument Edit  
  menu with the mouse.

Instrument Properties Window:

Name:
You can change the Instrument Name in this box.

Bank  & Patch Number:
This is where you assign the Bank & Patch (or Program Change) numbers.  These set-
tings are what the instruments will respond to when standard MIDI Bank & Patch 
Change commands are sent from a keyboard or sequencers.

Enter a number from 0-127 for Bank & Patch Numbers.

Effects Send:
This feature is disabled for the time being.  
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Attenuation & 6 dB Boost:
This allows a global Attenuation setting for the whole instrument.  If the instrument is 
prone to distorting or too loud, you can bring the volume down with this setting.

Enter a value from 0-96 (dB) 

You can boost the overall volume of the Instrument by checking the 6 dB boost check-
box.  

This will cancel out the Attenuation Setting.

This also cancels out any 6 dB boost settings on individual Dimensions.

Tuning Adjust (Cents):
You can adjust the global tuning of the entire instrument in cents over a range of 7 oc-
taves up or down.   Ranges between 1-50 are more likely to be used though.
This is very handy for tuning instruments from different libraries to match each other.

Enter a value from -8400-+8400

Pitch Bend (Semitones):
Set the Pitch Bend Range between 0-12 Semitones (or Half Steps)

Piano Release Mode:
This checkbox is for Piano samples.  On a real piano, you can step on the sustain pedal 
very quickly after releasing the notes and you will still get some strings resonance.  This 
checkbox allows the GigaStudio to emulate that when using Pedal Down samples.  This 
is not needed however if your pedal down ambience is from the GigaPulse.  It’s only 
needed for piano libraries that use actual pedal down samples for that ambience.  

•A Quarter Tone is 50 cents. 
•A Half step is 100 cents.  
•A Whole step is 200 cents.
•An Octave is 1200 cents.
•8400 cents is 7 octaves
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Dimension Key Start & End Range:

This is one place to set the range of the Key-Switch keys.

Enter the key directly with the keyboard

Click on the [Up & Down] arrows with the mouse.

Drag the spinner with the mouse.

There are three ways to make these changes here.

You can also set this range very quickly in the Region Window by dragging the range of 
the Key-Switch region.  
(The Key-Switch range is Purple when there is a Key-Switch dimension.  Otherwise, it 
will be colored gray.)
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Bank & Instrument Edit Menus:

Bank Edit Menu:

[Right-Click] on a Bank to bring up the Bank Edit Menu.

These are the basic Cut-Copy-Paste & Delete Edit 
commands that are also found in the Edit Menu. 

This provides a quick way to access these basic 
commands instead of having to go up to the Edit 
Menu.

Instrument Edit Menu:

[Right-Click] on an Instrument to bring up the Instrument Edit Menu.

This brings up the basic Cut-Copy-
Paste-Delete & Rename commands 
that are also found in the Edit Menu.
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Sample Window
The Sample Window is the area of the Instrument Editor interface where the  
instrument samples are imported and organized.  
In a .GIG file with more than one instrument, these instruments can share
samples from the Sample Window.
The wave samples are organized into folders. 
There will be at least one folder in the Sample Window at all times. 
By default, a single folder named “Default Sample Group” is created within a  
new .Gig file. This folder can be re-named to whatever is appropriate, and as  
many folders as are necessary may be added as well. 

Folder View:

Sample View:

Here is a view of the wave pool containing several 
folders. 

It is extremely helpful organize the samples into folders 
for designing and building complex instruments. 

Folders should be divided in categories by instruments, 
velocity splits and dimension splits.  
This is especially important when working with the 
Wizard Tool.

Clicking on the [Plus] sign (+) to the left of a folder 
opens it up to display the samples inside. 

Clicking the [Plus] sign again will close the folder.

Samples are mapped out by dragging them from here 
to the Velocity Zones in the Velocity Map.
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Sample Icons:

You can tell exactly what kind of samples are in a folder by the wave icons to the left of 
the sample name.

Accessing the Folder Context Menu:

{Right-clicking] on a Folder 
brings up the Folder Context 
Menu.

A single wave line indicates a Mono sample.

A double wave line indicates a Stereo sample.

A tiny letter “A” indicates that this is the Audition sample.

Blue-Green wave lines indicate that the samples have been com-
pressed with the GigaStudio Disk Acceleration.
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Accessing the Sample Context Menu:

[Right-clicking] on a Sample brings up the Sample Context Menu.
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Folder Context Menu:

Import Samples:

Selecting this option will bring up the browsing window below:

•Use this window to find and select which samples to import.  
•The samples will be imported into the folder you [right-clicked] on to bring up  
  this context menu. 
•Use [shift] + [select] or [ctrl] + [select] to select multiple samples.  
•When you click on a sample, you can see the file details in the window on the  
  right.  You can also play any selected sample by clicking on the [Play] button.  
•Click on [Open] to import the samples into the Editor.
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Import Directory:

•This command lets you import an entire folder of samples.
•Use this window to find sample folders.
•Only one folder at a time can be imported this way.

Alternatively, you can simply [drag & drop] a folder from the desktop into the Sample 
Window.  This method allows you to import multiple folders at once. 
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Replace all in Folder:

This command allows you to replace all the current samples in a folder with new ver-
sions. 

•This is a good option if you have made audio changes to your samples outside  
  the GigaStudio after having mapped out the instrument.  
•Instead of having to rebuild the whole instrument, you can batch replace the  
  samples from here.  
•A common use for this feature is to replace the original samples with noise 
  reduced versions or to replace 16 bit samples with 24 bit versions.  
•For this to work properly, it is important that the file names of the new samples  
  match the file names of the original samples as they appear in the Editor.  
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Export Samples:

This command will export all the samples in the selected folder to the hard drive as 
wave files.  You will need to choose a folder to put these samples in.

Export as Folder:

In this case, the whole folder will be exported to the hard drive as a folder of wave files.  
The folder will have the same name as it does here in the Editor.

Export all Sample Folders:

This command will export all the folders of the .GIG file to the hard drive as wave files.
They will be named and organized exactly as they are here in the Editor.

New Sample Group:

Creates a new empty folder.  
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Cut Folder: [Ctrl] + [X] Keyboard Shortcut

•This will Delete the selected Folder and put it into the clipboard so that it can be  
  pasted to another location.  

•The folder can then be pasted in the Sample window of another opened .GIG file. 

Copy Folder: [Ctrl] + [C] Keyboard Shortcut

•This will Copy the selected Folder without deleting it and put it into the 
  clipboard so that it can be pasted to another location.  

•The folder can then be pasted in the Sample window of another opened .GIG file. 

Paste: [Ctrl] + [V] Keyboard Shortcut

Once you Cut or Copy a Folder, this command will Paste it in the Sample window of an-
other opened .GIG file.
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Delete folder: [Delete] Key

This will delete the Folder from the Sample Window.  You will get a prompt asking if you 
really want to delete it.  Choose [Yes] to delete it or [No] if you change your mind.  

Deleting Mapped Samples:

A warning will appear when you begin to delete a sample that is referenced by one or 
more keyboard regions. Those regions will be “unmapped” without a reference to any 
sample after the deletion. 

The warning dialog tells you the location of the first region it finds linked to the sample
you’re deleting, and asks you whether you want to precede. There are four options: 

•Yes: Proceed but issue more warnings if there are other regions mapped to this  
  sample. 

•Yes to all: Delete the sample and ignore any other regions mapped to it. 

•No: Cancel the operation 

•Go to region: Cancel the operation and highlight the region mentioned in the  
  warning.

Rename Folder:

Use this command to rename the selected folder. This will highlight the folder name so 
that a new name can be typed in.
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Wave Pool Statistics: 

Clicking on this will bring up the Wave Pool Statistics window.  This window allows you 
to get an overview of all the samples in the .GIG file.  

Group:

The Group dropdown list allows you to display the 
samples of any folder or all the samples at once in the 
sample list.

Total Samples:

This is the total number of samples in the .GIG file
or the selected group depending on what is select-
ed from the Group dropdown menu.
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Sample Statistics:

These statistics are for the selected folder or for the 
whole .GIG file depending on what is selected from
the Group dropdown menu.

Select a sample from the list and then click on the [Audition] 
button to hear it.

Click on the [Stop] button to cut the sample off.  This is handy if 
you audition a real long sample.

In the Sample list, you can sort the visible samples by Name, Format, Unity Note, 
Fine Tune, Sample Rate or Length.  Click on one of the tabs to sort the samples.  
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Convert Wave Pool Format: 

•This tool is where you convert the bit rate and apply Disk Acceleration 
  compression to all the samples in the .GIG file.  You can also convert the whole  
  file to Mono.

•This allows a developer to easily generate 24 and 16 bit versions of the library in  
  both mono and stereo. 

•This interface is covered in detail in the Edit Menu section.

Sort by Pitch: 

This will sort the samples by their pitch based on the assigned unity note.

Sort by Name:

This will sort the samples by their name.
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Jump to Selected Regions:
This has to be hands down one of the nicest features in the editor.  The editor will now 
highlight the samples in the Sample Window whenever you make a selection while ed-
iting.  

To show how helpful this feature is, imagine you want to edit the sample assigned to 
the middle velocity of middle C, Pedal Down on a Piano.  In the past you would have to 
hunt and peck through the Sample Window folders to find it.  If the sample folders &
names are not organized or obvious, this could make it very difficult to find a specific
sample.  

However, with “Jump to Selected Regions” enabled, all 
you have to do is select the C-4 Region.

Select the Pedal Down 
Dimension.

Select the Middle Velocity. The sample then lights up.
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If you select several regions or several dimen-
sions, all the samples used will highlight in 
the Sample Window.  

All the regions are highlighted yellow while 
the most recently selected region (C-4) is or-
ange.  

Notice that all the samples are highlighted in yellow 
but one of them also has an orange border around it.  

This orange border represents the most recently select-
ed dimension.  In this case that is C-4. 

Enable this feature by [right-clicking] in the 
Sample Window and choosing “Jump to Se-
lected Region” 

Also, when you have the MIDI Select feature enabled, the samples will also 
highlight as you play them in real time.  

You can then find samples really fast by just playing the MIDI keyboard and manipulat-
ing MIDI controllers.  
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Sample Context Menu:
[Right-click] on a sample to bring up the Sample “Context Menu”
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Sample Properties Window:

Name:

The Sample Name appears in this field.  It can also be renamed here.

Current location:

This shows the actual location of the sample file on the hard drive or to which .GIG file it
is a part of.

Size (bytes):

Displays the size of the sample in bytes.

Sample rate (Hz):

Displays the Sample Rate of the sample in Hz. 

Audio format:

The recorded bit depth of the selected sample as well as mono/stereo designation. 
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Unity note:

•The assigned unity note of the selected sample. This value can also be changed  
  here by entering a new note or scrolling the spinner to the right.

•Any change made to the Unity note here will affect any regions and splits that  
  reference this sample. 

Fine tuning (cents):

•The assigned Fine-tuning value of the selected sample. This value can be 
  adjusted here. 

•Any change made to the Fine-tuning here will affect any regions and splits that  
  reference this sample.

Loop Information:

Enable checkbox: This toggles the loop function of the selected sample(s) on/off. 
Start: The number of samples at which the loop begins. 
End: The number of samples at which the loop ends. 
Length: Total number of samples making up the entire loop region. 

Although you can adjust the loop information here, this box is better used for display 
purposes.  We recommend adjusting loop points in an audio editor for more precise 
control with real-time playback. 

Update all derived cases:

Unity note: Updates the Unity note of all the regions that reference the current sample. 
Fine-tuning: Updates the Fine-tuning of all the regions that reference the current 
sample. 
Loop points: Updates the Loop settings of all the regions that reference the current 
sample. 

These checkboxes allow you to override the settings in the .GIG file with the ones here
in the properties page.  For example, if you repair a bad loop in an audio editor, you can 
update all the regions with the fixed loop.
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Edit Audio:

This command will launch the audio editor so that you can edit the sample.  The audio 
editor needs to be selected in the Edit/Preferences page.

Audition Sample:

Plays the selected sample.

Find Instance: [Ctrl] + [F]

Locates where the selected sample is mapped out.  If the sample is mapped to more 
than one location, this will change to “Find next instance”  

Choose a sample in the Sample window and 
[right-click] on it. 

Select “Find Instance” from the menu that 
comes up.

The exact region, velocity and dimension split that this sample is assigned to will be 
selected in the Editor.  

Repeat this to find the next instance if the
sample is used more than once.  
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Import Samples:

Selecting this option will bring up the browsing window below:

•Use this window to find and select which samples to import.  
•The samples will be imported into the folder you [right-clicked] on to bring up  
  this context menu. 
•Use [shift]-select or [ctrl]-select to select multiple samples.  
•When you click on a sample, you can see the file details in the window on the  
  right.  You can also play any selected sample by clicking on the [Play] button.  
•Click on [Open] to import the samples into the Editor.
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Import Directory:

•This command lets you import an entire folder of samples.
•Use this window to find sample folders.
•Only one folder at a time can be imported this way.

Alternatively, you can simply [drag & drop] a folder from the desktop into the Sample 
Window.  This method allows you to import multiple folders at once. 

Replace Sample:

To replace an existing sample, use this dialog to select the new sample. 

Export Sample:

This command will export the selected sample to the hard drive as a wave file.  You will
need to choose a folder to put the sample into.
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Mark as Audition Sample:

This is a new feature that allows you to select a specific sample to be the audition sam-
ple.  This can be a quick demo or even an audio tutorial specific to the .GIG file. From
the GigaStudio interface, Audition Samples can then be played from the Loader before 
loading the instrument to hear what the instrument will sound like.  

The Audition sample will have a tiny letter “A” next to the sample in the folder.

Cut Sample:

Copy Sample:

•This will Copy the selected Sample without deleting it and put it into the 
  clipboard so that it can be pasted to another location.  

•The Sample can then be pasted to another folder in the current .GIG file or in  
  another opened .GIG file.

•This will Delete the selected sample and put it into the clipboard so that it can  
  be pasted to another location.  

•The sample can then be pasted to another folder in the current .GIG file or in  
  another opened .GIG file.  

Paste:

Once you Cut or Copy a Sample, this command will Paste it in to another location.

Delete Sample:

This will delete the Sample from the Folder.  You will get a prompt asking if you really 
want to delete it.  Choose [Yes] to delete it or [No] if you change your mind.  
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Deleting Mapped Samples:

A warning will appear when you begin to delete a sample that is referenced by one or 
more keyboard regions. Those regions will be “unmapped” without a reference to any 
sample after the deletion. 

The warning dialog tells you the location of the first region it finds linked to the sample
you’re deleting, and asks you whether you want to proceed. There are four options: 

Yes: Proceed but issue more warnings if there are other regions mapped to this sample. 

Yes to all: Delete the sample and ignore any other regions mapped to it. 

No: Cancel the operation 

Go to region: Cancel the operation and highlight the region mentioned in the warning. 

Rename:
Use this command to rename the selected sample. This will highlight the sample name 
so that a new name can be typed in.
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Move Sample to Folder:

Here we can move the selected sample to another folder.

In the Move samples to folder window, choose a different folder and click [OK] to move 
the sample.  

Alternatively, you can [drag & drop] samples from one folder to another.

Common Menu Items:

These are the same commands as found in the Folder Context Menu.   They are de-
scribed earlier in that section.
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Region Window

Region Menu:

[Right-click] on a Region and you will be presented with the following context menu: 
From here you can get to several region parameters & settings.

Properties:

Click on “Properties” in the Region menu to bring up the Region Properties window.

Shortcut: You can also [double-click] on a region to bring this screen up.
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Note Range:

Displays the note range of the selected region. This setting is not adjustable here. 
To modify the note range you stretch the region graphically in the Region window. 

Key group:

This is an advanced Hi-Hat mode feature. The key group feature will allow regions as-
signed to the same Key group to turn each other off. You can have several key groups in 
an instrument. (Up to 127) 

This can also be used to create a monophonic mode instrument by setting all the re-
gions to the same group other than zero. 

Key group zero is the default setting and has no effect.  Regions set to zero will not be 
cut off by each other or by regions on other key groups. 

New region:

This option will be grayed out when [right-
clicking] an existing note region. However, by 
[right-clicking] on any gray area of the region 
map, the “New region” option will be available. 

Selecting this will create a single note region 
under the note where you [right-click]. To 
move the region to a different location simply 
click on the region and drag it to the new loca-
tion.
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Cut-Copy & Paste Regions:

Select a region or group of regions and [right-click] on them and choose “Cut or Copy or 
Delete” from the context menu.

Cut region(s):

This will remove the region(s) from the 
current instrument and place it in the 
clipboard for pasting to an empty location on 
the region window or to another instrument 
region window.

Copy region(s):

This will copy the region in the current 
instrument without deleting it and place 
it in the clipboard for pasting to an empty 
location on the region window or to another 
instrument region window.
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Paste region(s):

•This option will paste the cut or copied region or group of regions from the 
  clipboard.
•If you are pasting to another instrument, it will try to put the regions on the  
  same note range as they came from.  
•If these note ranges are occupied, then the regions will be placed on the closest  
  empty note ranges.
•When pasting to the same instrument that the regions were copied from, the  
  regions will also be placed on the closest empty note ranges.

Paste region(s) here:

•This option allows you to determine where the copied regions will be placed on  
  Region Window.
•[Right-click] under the note where you want the regions to go and choose “Paste  
  regions(s) here”  
•The region or group of regions will be placed starting on that note.

Delete region:

This will remove a selected note region or regions from the current instrument without 
placing them in the clipboard. 

You will be presented with a dialog asking if you are sure.  Choose [Yes] to delete the 
region.
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Apply macro:

Use this function to perform complex and repetitive editing commands to one or 
more selected regions. This command will apply the selected Macro to the region or 
group of regions that are selected and to any of the dimensions and velocity splits that 
are selected. See the Macros section for more information about creating Macros of 
your own.  “09-09 Macros”  

Transpose:

This will transpose the selected region(s) by half steps and cents. 

Make a selection and click on [OK] to apply the changes.  

This accomplishes the exact same thing as changing the unity note and the fine tune
setting but can be a lot easier than calculating the unity notes and fine tune number
offsets.  Also, these settings reset to zero each time they are applied so that you are al-
ways transposing and fine tuning from where you left off.  

Range is 127+/- Half Steps and 50+/- Cents:
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Selecting Regions:

You can select regions several ways: 

One note region selected:

All regions drag-selected:

Control select of individual regions:

Shift-select several regions in the middle:
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Note: Drag-selecting only works when you start from a blank space with no region on 
it. To select several consecutive regions that are surrounded by other regions, select one 
region and shift-select another region and all the regions in between will be selected. 
Otherwise you will end up moving one region instead of selecting several. 

Stretching & Moving Regions:

Regions are stretched by grabbing the left or right 
edge and dragging with the mouse.

By stretching a single chromatic note region both right (upward) and left (downward) 
in range it is possible to cover several octaves with a single region. 

A region can be moved to a different area of the keyboard by clicking in the middle area 
of the region and dragging left or right. 
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Region Cut/Copy/Paste

[Right-click] on a region to bring up the Cut, Copy, and Paste settings. 

You can Cut, Copy, or Paste regions within the same instrument or between instru-
ments. When you Paste, the regions will attempt to place themselves on the same key 
range they were copied or cut from. If there are regions occupying this range already, 
they will map to the next available key ranges to the right (upward). 

Paste Region(s) Here:

You can also manually choose where to paste the region. Place the cursor in the area 
under the note range where you wish to paste the region(s). 
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Deleting Regions:

Deleting one or more regions. To delete a region (or several that are selected) select 
Delete region from the context menu or use the “delete” key and the region(s) will be 
removed from the instrument without being placed into the clipboard. 

One Region Deleted: 

Several Regions Selected:  hold down [Shift] +[select]

Several Regions now Deleted: 
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Moving Regions

If you ever wanted to do something as simple as bring several notes down an octave 
without changing the pitch, you would normally have to change the note range and 
pitch of each note one at a time. There is a quick and easy way to do this in the region 
map. You simply drag the regions where you want them to go. 

Note: First you must setup the retuning mode in the Edit/Preferences dialog from the 
Edit menu. Check the box “Retune regions when dragging” before you move any regions 
if you wish to preserve the pitch of each note. Otherwise each note will be stretched in 
pitch according to their ‘Unity note’ and ‘Pitch tracking’ settings.

Check ‘Retune regions when dragging’ to preserve pitch:

You can drag one region at a time or several regions at once. Just grab the region you 
want to move by its middle and drag it anywhere on the region map. If you grab one 
side or the other, you will stretch the region instead of dragging it so be careful.

Move a single region: 

Move several regions at once: 
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Region Keyboard Display:

On the keyboard display, Middle C has a red line along its left border. The octave num-
bers are centered above the virtual keyboard display. 

This keyboard can be dragged left and right across the screen with the mouse to bring 
note regions into view from either side of the region map. 

When notes are triggered from a MIDI controller or sequencer the notes played they are 
displayed on this keyboard by changing to blue. 
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Region Scale Resolution

You can adjust the scale of the Drag Tool Menu editing dots.  Many of the parameters 
edited with the drag tools have fine tuning amounts that can be unwieldy to access
graphically.  This is where the Scale Resolution comes in handy because you can zoom 
the resolution in and out as needed.  If the selected parameter does not have fine tun-
ing settings, this feature is disabled.  

Moving the slider Up increases the resolution:

In this example, the value range is 0.00-1.00 for very fine-tuning.

Moving the slider Down decreases the resolution:

Now the value range is 0.00-100.00 for coarser editing.
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Region Zoom Buttons:

Use these buttons to zoom the region window view in and out:

Region Map Zoomed Out: 

Region Map Zoomed In: 
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The Dimension Window

The Dimension Window is where you setup all the various types of dimension splits.

There are three main areas in the Dimension Window.

The Velocity Map: The Dimensions Switches:

The Display and Selection Buttons:
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The Velocity Map:
The Velocity Map accomplishes several things at once:

Mono-Stereo Settings:

•A single vertical divider line down the middle of the Velocity Map displays the  
  Stereo & Mono status.
•The divider line indicates a stereo region. 
•The lack of a divider line indicates a mono region.

•Samples are mapped here and sample names are  
  displayed here.
•The Stereo-Mono status is set and displayed here.
•The amount of Velocity Splits is set and displayed  
  here.
•Various Parameters settings and visuals are 
  displayed here.
•[Right-clicking] here brings up a context menu      
  with several editing tasks.

Mono with no velocity splits: Stereo with no velocity splits:
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Mono with 4 velocity splits: Stereo with 4 velocity splits:

Assigning a Mono sample to the Velocity Map will automatically put it in Mono mode.
Assigning a Stereo sample to the Velocity Map will automatically put it in Stereo mode.

You can also manually change the Stereo or Mono status by [right-clicking] on the Ve-
locity Map and choosing “Force to Mono” or “Force to Stereo” in the context menu.

•When going from Stereo to Mono, the dialog window will give you the option of  
  which side to keep.  
•When going from Mono to Stereo, these choices are not available.  
•Click on [OK] to apply the change.
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Velocity Split Points:

Velocity Split points are displayed by horizon-
tal divider lines.  

These are adjustable by dragging them with 
the mouse.

Velocity Splits are created and named in the Dimension Controller Window.  
The Velocity Split order can also be changed here as well.
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Assigning Samples:

Samples are assigned by dragging them from the Sample Window to a Velocity Split in 
the Velocity Map.  

Dragging with the Left Mouse button enables pitch tracking.

Dragging with the Right Mouse button disables pitch tracking.  

If you make a mistake and use the wrong button you can either drag the sample again 
or go to the Mix/Layer section of the Edit Parameters window and correct it there.
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Dimension Controller Window:

Click on the Velocity Map [Toolbar] to open the 
Dimension Controller Window.

This is where you create, delete, rename and reorder velocity splits.

Control Source:

The Control Source is Velocity so this option is disabled.  In the Dimension Split resource 
window, you will be able t set it to a variety of MIDI controllers or rules.

Description:

This is also disabled for Velocity Splits.  You can enter a description but it will not show 
up in the Velocity Map.  This is another feature specific to the Dimension Splits.

Sample Space in Use:

This indicator helps you keep up with the amount of dimension resources available.  
The meter fills up as you use up more dimensions.
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Split Names:

This window is where you select the various splits for deleting, reordering and renam-
ing.

Add Splits:

Click the [Add] button to add more Velocity Splits.  It will add the amount of splits that 
are entered in the numerical entry field to the right.

Delete:

Select a split or group of splits and click on [Delete] to remove them.

Rename:

Select a Split and click the [Rename] button to enter a new custom name.  It is very im-
portant to label the various splits and descriptions to keep everything organized and 
intelligible. These names show up in the Velocity Split Toolbar when different splits are 
selected.

Move Splits Up & Down:

Select a split and click the [Up or Down] buttons to change its order.  



280

The Context Menu:

[Right-click] on the Velocity Map to bring up the context menu.

Copy Articulation:

This command copies all the parameter settings of the current dimension split so that 
they can be pasted to another region or dimension split.  

Paste Articulation:

This command pastes the copied articulation to the selected region or dimension split.

Save Articulation as Macro:

This will save all the parameter settings to a macro so that it can be reused at a later 
time on other regions, dimensions or even other instruments.  See the chapter on Mac-
ros for details on working with Macros.

Apply Macro:

This will apply any available macro to the selected split.  See the chapter on Macros for 
details on working with Macros.

Map to Null Samples:

This will clear any samples that are mapped to the selected split and set it to “Un-
mapped”
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No Selection Lock:

Lock to Stereo Pairs:

Allows you to select individual left or right 
dimension splits.

This is also available by clicking on the [Lock 
Selection] Button.

Locks the mouse selection to stereo pairs.  

This is also available by clicking on the [Lock 
Selection] Button.

The Context Menu Continued:
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Lock to Entire Regions:

Locks the mouse selection to the entire region 
including all the velocity and dimension splits.

This is also available by clicking on the [Lock 
Selection] Button.

Lock to Entire Instrument:

Locks the region selection to the whole instrument at once.  All the regions will be high-
lighted and any editing will affect the whole instrument at once.

The Context Menu Continued:
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Show Envelopes (& Parameters):

Displays various edit parameters and ADSR 
envelopes graphically on the Velocity Split 
dimensions.

This can also be toggled on & off with the 
[Show Envelopes] button.

The graphic depends on what parameter is 
being edited.  

In this case, the ADSR envelope is being dis-
played.  The graphic will update in real time 
as you make changes.

Force to Stereo/Mono:

You can also manually change the Stereo or Mono status by [right-clicking] on the Ve-
locity Map and choosing “Force to Mono” or “Force to Stereo” in the context menu.

This deletes the currently selected velocity split dimension.  This is the same as deleting 
a split in the Dimension Controller window.

Delete Case:

The Context Menu Continued:
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Playback Velocity Level Pointer:

You can see the incoming MIDI Velocity level 
with this pointer.  

This will help to see what velocity split is play-
ing as you edit.  

This pointer also selects the velocity split it is 
pointing to in real time.  

Tall Velocity Window:

Select this option from the View Menu to raise the height of the Velocity Map to the top 
of the screen.  This will make it more convenient to deal with a large number of velocity 
splits.

Parameter Meters:

The bottom part of the Velocity Map always 
displays the setting of whatever parameter is 
being edited at any time.  It gives a numerical 
and graphical bar display.
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Dimension Switches: 
This is where the various Dimension Switches are created.  Dimensions allow various 
MIDI controllers or rules to instantly change between different samples.  Here are the 
basic types of dimensions.

Stereo Split-This is the first and most basic of Dimensions.  There is no MIDI control of
this dimension.  It is either Mono or Stereo.  This part of the Velocity Map.

Velocity Splits-The speed at which you hit the keyboard determines which sample is 
triggered.  This is most often used to for samples of instruments actually playing from 
soft to loud.  Acoustic instruments tend to get brighter and more aggressive as they get 
louder so having samples recorded ranging from loud to soft makes for a much more 
convincing instrument. This is part of the Velocity Map.

Sustain Pedal-The MIDI Sustain Pedal switches back and forth between samples.  This 
is most often used for piano libraries that have actual pedal up & down samples or to 
open and close hi-hats.

Mod Wheel & Other MIDI Controllers-This allows the Mod Wheel and most other MIDI 
continuous controllers to switch between various samples.  A good example would be 
using the Mod Wheel to switch from closed to open hi-hats.

Layers-You can have several samples layered on top of each other playing together at 
once.  You can even have individual MIDI control of the volume of each layer or have a 
MIDI controller sweep between the layers. (Cross-Fade Layering)

Key-Switch-This original Giga invention allows you to use notes on the MIDI keyboard to 
instantly switch between various samples.  This is often used for orchestral instruments 
that have a bunch of articulations.  You can instantly switch from Long Sustain to Stac-
cato to Legato to Trills to Tremolo etc. all on one MIDI channel.  

Round Robin & Random-These dimensions switch the samples automatically each time 
you play a note.  Round Robin plays a pre-determined sample order while Random trig-
gers the samples randomly.

Smart MIDI- This Dimension is used for the new MIDI tools in Giga 3.0. These tools in-
clude the Pattern Alternator, The Repetition Tool and the Legato Mode Tool.  
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Dimension Split Examples:
Two-Way Mod-Wheel Split:

Two-Way Sustain Pedal Split:

4-Way Keyboard Switch Split:

2 Layer Split:

16-Way Keyboard Switch Split:

Various 2-Way Splits using all the Dimen-
sion Windows:

This view is toggled with the [Dimension 
View] button.
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Dimension Context Menu:

[Right-click] on a dimension split to bring up the context menu.

Copy Articulation:

This command copies all the parameter settings of the current dimension split so that 
they can be pasted to another region or dimension split.  

Paste Articulation:

This command pastes the copied articulation to the selected region or dimension split.

Save Articulation as Macro:

This will save all the parameter settings to a macro so that it can be reused at a later 
time on other regions, dimensions or even other instruments.  See the chapter on Mac-
ros for details on working with Macros.

Apply Macro:

This will apply any available macro to the selected split.  See the chapter on Macros for 
details on working with Macros.
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Dimension Controller Window:

Click on the Velocity Map [Toolbar] to 
open the Dimension Controller Window.

This is where you create, delete, rename and reorder dimension splits.

Control Source:

This is where you choose the MIDI controller or Rule that will change the playback of dif-
ferent samples.

Description:

Enter a useful description here.  This will show up in the Dimension Tool bar. It is very 
important to label the descriptions and split points. It will make mapping & editing 
much quicker and easier, especially if you wind up with complex dimensions. 
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Sample Space in Use:

This indicator helps you keep up with the amount of dimension resources available.  
The meter fills up as you use up more dimensions.

Split Names:

This window is where you select the various splits for deleting, reordering and renam-
ing.

Add Splits:

Click the [Add] button to add more splits.  It will add the amount of splits that are en-
tered in the numerical entry field to the right.

Delete:

Select a split or group of splits and click on [Delete] to remove them.

Rename:

Select a Split and click the [Rename] button to enter a new custom name.  It is very im-
portant to label the various splits and descriptions to keep everything organized and 
intelligible. These names show up in the Dimension Split Toolbar when different splits 
are selected.

Move Splits Up & Down:

Select a split and click the [Up or Down] buttons to change its order.  

Dimension Playback Pointer:

You can see the incoming MIDI controller location with this pointer.  This will help to 
see which split is playing as you edit.  This pointer also selects the dimension split it is 
pointing to in real time.  
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Dimension View Toggle Button:

This button switches between 4 and 8 part dimension windows.

If there are only 4 or less dimensions being used, then the 4 part view will offer the 
most easy to read view with more horizontal space for the names & descriptions.  

Use the 8 part view when there are more than 4 dimensions being used. 

4-Part View: 8-Part View:
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Envelope 1 & 2 (Amplitude & Filter)

Envelope 1 (amplitude) affects the Volume playback over time.

Envelope 2 (filter) affects the Filter Resonance over time.

The GigaStudio offers the following Envelope Parameters for the Amplitude and Filter 
Envelopes.

•Pre-attack level (%):
•Attack Time (sec):
•Decay 1 Time (sec):
•Hold: (Yes/No) “Amplitude Envelope Only”
•Sustain level (%):
•Decay 2 Time (sec)/Infinite
•Release Time (sec):

All of these parameters can be adjusted from the Edit Parameters Window and the Drag 
Tools Menu.  Most but not all of them are also viewable and adjustable in the Waveform 
View Window.  

Edit Parameters
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An envelope, in its simplest terms, is a representation of a sound’s dynamic properties 
in the way they change over time. The most common example is the manner in which 
a sound begins, what occurs during the sustain characteristics, and then fades into si-
lence. All acoustic sounds have their associated envelopes. The three primary aspects of 
any given sound that can be quantified in terms that can be manipulated by way of an
envelope are amplitude (volume), frequency (pitch), and harmonic content (timbre or 
Filter). 
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Envelop 1 & 2 Parameters:

The following explanations of the Envelope Parameters apply to both the Amplitude 
and the Filter Envelope settings with on exception.  The Filter Envelope does not have a 
Hold setting.

Pre-attack level (%):

The Pre-attack level is adjusted with percentage numbers. (0.00-100.00)
It is the very first point on the ADSR envelope and sets the initial volume level of the
attack.

For example, a Pre-attack level of 50.00 sets the beginning of the attack envelope to 
half the potential volume of the sample. This allows for a sample to begin at any level 
from silent to full volume.

Attack Time (sec):

The attack time is measured in seconds (0.000-10.000) 

This parameter sets the amount of time that it takes for the attack to reach its full vol-
ume.  For most instruments, this time will range from zero to a half second max for a 
natural sounding instrument.  However extreme settings can be used for special effects 
to put a slow volume ramp up for each triggered note.   

Decay 1 Time (sec):

The Decay 1 Time is measured in seconds (0.000-60.000)

This parameter sets the amount of time for the first Decay of the envelope.  It decays
from the peak level of the attack down to the sustain level.  
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Hold:

If a sample has a loop point, the Hold function will prevent the first Decay (Decay 1)
from happening until the sample has played through its entire loop one time.

This is real handy for natural decaying instruments like Piano or Guitar that have small 
looped samples.  When Hold is set to “1-Yes” the sample will hold its volume until it 
plays through the loop.  Once it has played through the loop, it will then start the first
decay down to the sustain level.  This can make for a more realistic envelope for short 
looped samples.  It gives them a little more of a natural personality despite the artificial
looping.

Note: Hold is only available on the Amplitude Envelope but not a part of the Filter Enve-
lope.

Sustain level (%):

The Sustain level is adjusted with percentage numbers. (0.00-100.00)

After the first decay dies down, the sample audio will sustain for a period of time de-
pending on the Decay 2 settings. (Infinite or Decay time) This setting determines the
volume level of this sustaining portion.
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Decay 2 Time (sec):

The Decay 2 Time is measured in seconds (0.000-60.000) or it is set to “Infinite” which
overrides the time setting.

This parameter determines how long the Sustain section of the envelope will last.

A Decay 2 Time will cause the sample level to sustain for that amount of time and then 
go into the release, even without letting go of the note.

Checking the “Infinite” check box will cause the sample level to sustain indefinitely until
you release the note.

Release Time (sec):

The Release Time is measured in seconds (0.000-60.000)

This parameter determines how long it will take for the sample volume to ramp down 
depending on how Decay 2 is set.

If the Decay 2 is set to “Infinite”, the release will kick in when the note is released.

If the Decay 2 is set to an amount of time, then the release will kick in after that amount 
of time passes “or” if you release the note before that time passes, then the release will 
kick in at that point.
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Amplitude & Filter Modulation Settings:
The Modulation controls allow real-time MIDI control of the Attack, Decay and Release 
of the Amplitude and Filter.

Modulation source:

Choose the MIDI controller to use from the list of standard MIDI controllers.

Modulation invert:

This setting allows you to reverse the MIDI controller by setting it to “Yes”

Attack-Decay-Release Mod Depth:

The response of these individual parameters is set here.  

•Off-No response to the MIDI control source.
•Low-Very light response to the MIDI control source.
•Medium-Medium response to the MIDI control source.
•High-More drastic response to the MIDI control source.

This allows the MIDI controller to affect only one, two or all three parameters at once 
and with varying intensities for each.  

The effect will depend on the actual envelope settings.  For example, if the Attack time 
in the envelope is set to zero, you will not hear any effect of the Mod controller.  Once 
you enter a parameter higher than zero, this controller will then start working.  Smaller 
Attack time settings will result in very light changes with the Mod controller.  Larger 
settings will result in more drastic changes with the Mod controller.  This also applies 
to the Decay and Release settings.  A little experimentation will be needed to learn how 
this works and figure out the settings you need.
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Amp-Filter-Pitch LFO:
Amplitude LFO

Filter LFO

Pitch LFO

LFO stands for Low Frequency Oscillator: 

LFOs are used to control various parameters cyclically, so that continuously repeating 
changes over time can be automated. For example, applying an LFO to pitch creates 
the effect known as vibrato. Applying an LFO to amplitude creates a cyclical change in 
volume known as tremolo. More exotic effects can be created by applying LFOs to filter
parameters, for creating repeating changes in harmonic content such as “wah-wah” 
effects. 

GigaStudio includes three discrete LFOs for Amplitude, Filter, and Pitch.  The following 
explanations apply to all three of these with one exception.  The Pitch LFO does not have 
a “Flip Phase” switch.  
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LFO frequency (Hz):

The Frequency may have any value between 0.1 and 10 Hz and sets the rate at which the 
LFO oscillates. 

Internal depth:

Use the internal depth to apply a fixed LFO depth.  

•Amp LFO 1200+/- Volume Oscillation
•Filter LFO 1200+/- Filter Resonance
•Pitch LFO 1200+/- Pitch in Cents

Control depth:

An external continuous controller, such as the Mod-Wheel can also be used to apply the 
LFO settings.  This setting works the same way as the Internal depth settings but you 
won’t hear its effect until the assigned MIDI controller is moved forward.

•Amp LFO 1200+/- Volume Oscillation
•Filter LFO 1200+/- Filter Resonance
•Pitch LFO 1200+/- Pitch in Cents
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Control Source:

The Control Source selects between Internal LFO, Mod Wheel, an Alternative MIDI con-
troller or a combination of Mod Wheel and the Alternative MIDI controller.  

This alternative MIDI controller is different for the Amp, Filter and Pitch LFO.

The Alternate controller for the Amp LFO is “Breath Control”

The Alternate controller for the Filter LFO is “Foot Control”

The Alternate controller for the Pitch LFO is “Aftertouch”
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Control Source for Amplitude LFO

0-Internal: Only the pre-set LFO depth will be heard.

1-Mod Wheel: The Mod Wheel modifies the LFO depth.

2-Breath Control: Breath Controller modifies the LFO depth.

3-Int/Ex Mod Wheel: In addition to the internal preset, the Mod Wheel further modifies
the LFO depth.

4-Int/Ext Breath Control: In addition to the internal preset, the Breath Control further 
modifies the LFO depth.

Control Source for Filter LFO

0-Internal: Only the pre-set LFO depth will be heard.

1-Mod Wheel: The Mod Wheel modifies the LFO depth.

2-Foot Control: Foot Controller modifies the LFO depth.

3-Int/Ex Mod Wheel: In addition to the internal preset, the Mod Wheel further modifies
the LFO depth.

4-Int/Ext Foot Control: In addition to the internal preset, the Foot Control further modi-
fies the LFO depth.

Control Source for Pitch LFO

0-Internal: Only the pre-set LFO depth will be heard.

1-Mod Wheel: The Mod Wheel modifies the LFO depth.

2-Aftertouch: Aftertouch modifies the LFO depth.

3-Int/Ex Mod Wheel: In addition to the internal preset, the Mod Wheel further modifies
the LFO depth.

4-Int/Aftertouch: In addition to the internal preset, the Aftertouch further modifies the
LFO depth.
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Flip phase:

This switches the phase, or direction, of the Amp and Filter LFOs.  This is not available for 
the Pitch LFO.

Synch:

This enables a single synchronized LFO. The LFO will be constant no matter what note is 
played or when it is struck. 

When this is not enabled, an LFO begins at the point in time when each note is played 
and each note will have its own out of synch and independent cycle.

When Synch is enabled, the LFO cycle will stay in synch for all the notes no matter when 
they are triggered.  
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Filter Settings

Filters shape the timbre of a sound by reducing (or “filtering”) the amplitude of
specific frequency ranges. This can be used to make an instrument’s character warm,
dull, bright, or thin depending on the type of filter and its settings.

Filters can be used creatively by assigning real-time continuous controllers to various 
aspects of its envelope, cutoff frequency, and resonance thereby allowing for creation of 
more synthetic textures with electronic characteristics. 
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Filter Type:

Use the drop-down arrow to select the type of filter.

None:

The filter mode is completely bypassed

Lowpass:

This filters out high frequencies

Highpass:

This filters out low frequencies

Bandpass:

Filters out a mid frequencies

Bandreject:

Inverse filtering of mid frequencies
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Turbo LPF:

Adds additional poles of attenuation to the Lowpass filter algorithm. This creates a
more intense analog filter effect. This option is only available when the selected Filter
Type is set to “Lowpass”

When used with certain resonance settings, Turbo LPF can generate high amplitude 
resonant frequency oscillations. Proceed with caution when editing at loud volumes. 
This could be damaging to your speakers. 

Cutoff freq:

This sets the maximum filter cutoff frequency.
Range is from 0-127:
This parameter is only available if the Cutoff Controller is set to “None”.
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Cutoff controller:

Instead of setting the cutoff frequency, this parameter allows you to assign a MIDI con-
troller to the Cutoff Frequency for real-time continuous control.  This overrides the Cut-
off Frequency setting, which will be disabled once you assign a MIDI controller here.

Control invert:

This setting allows you to reverse the MIDI controller by setting it to “Yes”

Min cutoff:

This value places a limit on the lowest filter cutoff frequency when using MIDI Cutoff
Controller.  The low range of the MIDI controller will start with this value.

Range is from 0-127
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Resonance:

Resonance creates a peak in amplitude at the specific cutoff frequency, and is used
to generate classic analog synth textures. The maximum resonance is set close to the 
point of self-oscillation, and will resonate according to the frequency content of the 
waveform that is being filtered.

Range is from 0-127:

Dynamic:

A setting of “Yes” Increases the overall resonance by dynamically scaling the Q in addi-
tion to the cutoff frequency of the filter over changes of envelope and/or external con-
trol. 
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Resonance controller:

Assign a real-time MIDI controller to the Resonance. 

Key tracking:

A setting of “Yes” Scales the cutoff frequency based on key position relative to the as-
signed Breakpoint value. (Next Item)  

With this feature, you can have the filter go from dark to bright as you play from one
end of the keyboard to the other. 

Key Tracking Breakpoint:

Adjust this value to set the breakpoint for the filter keyboard tracking.

Range is from 0-127 with a default value of 60 (Middle C):

Velocity scale:

This value is used to scale the currently selected velocity curve in order to specify a 
much larger number of filter velocity responses. For example, if you desire the filter to
scale from a low cutoff to fully open within the lowest velocity range, the filter response
can be scaled to open more quickly by entering values above 20 (up to 127). Values below 
20 will cause the filter to open more slowly over velocity yielding a darker response.

The range is 0-127 with a default value of 20.

This parameter is only available if the Cutoff Controller is set to “None”.
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Velocity curve:

Select how the filter responds to the incoming velocity.

•0-Non linear 
•1-Linear 
•2-Special 

Velocity dynamic range:

With this setting, you can lower or raise the dynamic range of the velocity response of 
the filter. There are five response positions:

•1-High 
•2-Medium high 
•3-Medium 
•4-Medium low 
•5-Low 

This setting varies dramatically depending on which velocity curve has been assigned.   

The next three diagrams will show how these two settings (Velocity Curve and Velocity 
Dynamic Range) interact with each other. 
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Linear Curve:

Each line represents one of the 5 dynamic range curves from top to bottom.

•Low 
•Medium low
•Medium
•Medium high
•High
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Each line represents one of the 5 dynamic range curves from top to bottom.

•Low 
•Medium low
•Medium
•Medium high
•High

Non-Linear Curve:
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Each line represents one of the 5 dynamic range curves from top to bottom.

•Low 
•Medium low
•Medium
•Medium high
•High

Special Curve:
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Response Settings:

The previous 3 diagrams of Response curves and Dynamic range settings also apply to 
the Response Settings. 

These settings determine the Velocity and Release Velocity responses and curves.  If an 
instrument doesn’t have the right feel for your playing style or keyboard, these are the 
settings that will smooth things out.

Velocity Split Point:

Although the Velocity Split points can be ed-
ited in the Velocity Map, you can also enter 
it numerically in the Instrument Parameters 
window.
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Note-On Velocity response curve:

Choose the velocity response curve:
(Refer to the previous curve  & response diagrams)

•Linear 
•Non-linear 
•Special 

Note-On Velocity Dynamic range:

Select one of the five response curves:
(Refer to the previous curve  & response diagrams)

•1-High 
•2-Medium high 
•3-Medium 
•4-Medium low 
•5-Low 

Note-On Velocity Curve Scaling:

This works in conjunction with the 5 Dynamic Range settings to give even finer control
of the velocity response.  Find a Dynamic Range setting that works best and then use 
this to fine tune the feel.

Range is from 0-127:
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Note-Release Velocity response curve:

The Release Velocity settings affect the release note decay time based on the Note On 
Velocity.   This is more noticeable with longer Amp Envelope release times.  This feature 
allows you set longer or shorter release times depending on how hard you hit the note.

Choose the release velocity response curve: 
(Refer to the previous curve  & response diagrams)

•Linear 
•Non-linear 
•Special

Note-Release Velocity Dynamic range:

Select one of the five response curves:
(Refer to the previous curve  & response diagrams)

•1-High 
•2-Medium high 
•3-Medium 
•4-Medium low 
•5-Low 
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Release trigger decay

This parameter determines the rate of attenuation for the amplitude of an existing re-
lease-triggered sample.

When you are using a Release Trigger dimension, you can control the volume of its play-
back depending on how long you hold down the Note-On.  

With Slower settings, you can hold the note down longer and still get the release trigger 
sample to play fairly loud.

With Faster settings, the release trigger will be quiet or even silent unless you let up on 
the note quick enough.  

There are 9 levels to choose from:

0-Fastest
1
2
3
4
5
6
7
8-Slowest
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Mix/Layer Settings

This section Volume attenuations & Cross-fade Layering settings and several important 
miscellaneous settings.

Attenuation:

Attenuation is measured in decibels (dB). This parameter is always a positive number; 
with higher values indicating decreasing output levels. 

This field is unavailable when the Attenuation controller is selected. You can use an ex-
ternal controller alongside and attenuation setting but the attenuation needs to be set 
first before selecting an attenuation controller. If the attenuation controller is already
selected, it needs to be reset temporarily to none to access the attenuation setting for 
adjustment. 

Range is from 0-98 dB:  A value of 96 = silence while a value of 0 = full volume.
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6 dB boost:

A 6 dB increase is available if needed to boost individual samples.  

Attenuation controller:

Assign a MIDI continuous controller for real-time attenuation control. 

By assigning the same attenuation controller to groups of related notes or samples, a 
MIDI controlled sub mix capability can be designed into the instrument so that indi-
vidual sounds can have discrete MIDI volume control.

Attenuation Controller Invert:

This reverses the MIDI controller.  This is crucial to creating a simple MIDI controller 
cross-fade layer.  Both layers would be set to the same MIDI controller for attenuation 
but one would be inverted with this parameter.  The result would be a cross-fade.

Attn CC thresh:

This parameter allows you to assign a minimum threshold to the external volume at-
tenuation controller.  This is useful for volume crescendo/decrescendo and expressive 
dynamics. Its very similar the threshold knob found on controller/volume pedals.  For 
example, this allows a MIDI controller to set the volume from “full volume to soft” in-
stead of “full volume to silent”   
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Pan:

This setting sets the pan position by a value from -64 (hard left) to +63 (hard right). 
It is very useful for instruments where it is desirable for individual samples to have 
their own unique pan settings.  

Pitch track:

This setting enables or disables the Pitch Tracking of samples across the keyboard.  
This is typically disabled for non-pitched samples such as drums, percussion, loop, and 
sound effects and enabled for melodic instruments.  Pitch tracking will transpose the 
sample based on its unity note setting.

M/S decode:

GigaStudio can decode Mid Side encoded recordings using this checkbox. 

M/S or Mid-Side mic’ing is a creative method of recording direct from the source with 
a cardioid-type microphone on one channel alongside a large diaphragm microphone 
with a ‘figure of 8’ pattern to capture ambience. Since it is not a true right/left repre-
sentation of the sound field it must first be decoded to a useable stereo signal.
The direct or ‘Mid’ channel recording is panned to the center of the stereo field while
the ambient or ‘Side’ channel recording is split to both left and right channels with the 
phase reversed on one of the channels. The ‘Side’ level can then be adjusted by attenua-
tion to dial in the preferred amount of ambience in the source wave file.

Self mask:

When checked, this causes high velocity notes to shut off lower velocity voices.  This 
feature conserves polyphony and should be tried on all samples with percussive attacks 
and releases (pianos, guitars, cymbals, etc.) 
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Sustain defeat:

This setting enables or disables the sustaining action of the sustain pedal. This allows 
the sustain pedal to simply be used as a dimension switch without sustaining the 
samples.

Dimension bypass:

You can bypass the current dimension by assigning one of these two controllers: 

•Effect 4 depth (cc 94) 
•Effect 5 depth (cc 95) 

This allows you to turn a dimension on and off in real time using one of these MIDI con-
trollers.

This can be useful to override certain characteristics built into an instrument without 
having to actually edit the instrument.
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Cross-fade In and Out Settings:

This corresponds to the Cross-fade Editor window and allows numerical entry of cus-
tom in and out points for the MIDI control of volume cross-fades.  

The In & Out points range from 0-127:

Multiple-Cross-fade Editor window:

Channel offset:

This setting creates an offset for individual samples within a single instrument.  

When the instrument is loaded in the main GigaStudio interface and assigned to chan-
nels in the DSP Mixer, samples that have offsets will show up in the mixer channels to 
the right.  

Lets take an example of an instrument assigned to channels 1-2 on the DSP Mixer.

Samples with an offset of 2 will show up on channels 3-4
Samples with an offset of 3 will show up on channels 4-5
Samples with an offset of 4 will show up on channels 5-6
And so on.
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Sample start offset:

Set the sample offset to start after the beginning of the wave sample. 

The value is measured in samples and has maximum limit of 2000 samples.

This is useful to soften the attack of a sample or if there is a pop at the beginning of a 
sample. 

The Sample Start Offset is also viewable and adjustable in the Waveform View window.  
(The Blue marker)
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Sample Settings

This section allows you to override the unity note and fine-tuning of individual
samples. 

Unity note:

Adjust the unity note of the individual sample here. The unity note is the root note of 
the sample and affects how the Pitch Tracking will work:

Fine Tuning (cents):

Adjust the micro tuning of the individual samples here in cents. 

The range is +/- 50 cents. 

Loop Start, End, Length:

Here you view or make changes to the loop points or the loop length.

The loop points are also visible and adjustable in the Waveform View window. 
The Green marker is the loop start and the Red marker is the loop end.
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Waveform Window:

This window displays the audio waveform and several of the editing parameters.   

The parameters are accurately aligned on top of the waveform and they can be edited 
here using the mouse.  

If changes are made to these parameters elsewhere, the changes will instantly update 
here and vice versa.  This helps you keep a visual overview of the editing process.  It al-
lows you to edit three different ways and see the results from three angles in real-time.  
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Envelopes View:

You can make edits by dragging the envelope points with the mouse.

Envelope-1 Amplitude: Yellow in color.

Envelope-2 Filter: Purple in color.

Envelope-2 Pitch: Blue in color.
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LFO (Low Frequency Oscillator View):

You can make edits by dragging the point with the mouse.

LFO-1 Amplitude: Yellow in color.

LFO-2 Filter: Purple in color.

LFO-3 Pitch: Blue in color.
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Sample & Loop Markers:

These markers can be moved with the mouse by grabbing them by the triangle.

Sample Start Offset: Blue Marker.

Loop Start: Green Marker.

Loop End: Red Marker.
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Zoom Buttons:

Zoom in and out with the buttons in the lower right hand corner.

Parameter Name:

Next to the zoom buttons is the name of the currently selected 
parameter.  

Zoomed Out:

Zoomed In:

Medium Zoom:
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Drag Tools:
The Drag Tool is one of the most innovative features that GigaStudio is famous for.

This tool allows you to choose nearly any parameter and then edit it by sliding the blue 
markers on the regions.  

This tool has several advantages:

•It allows you to select any number of regions in any order and edit the 
parameters all at once but only on the selected regions.

•It gives a graphic overview of the selected parameter giving you a helpful visual 
picture of the parameters across the key range.

•It offers a sensitive slider to make edits with.

•With the Linear and Proportional scaling, you can do some fancy angles and  
  curves from one end of the key range to the other.  The parameter amounts can  
  ascend and descend across the key range.
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Using the Drag Tools:

1. Select a parameter from Edit Parameters Window or from the Drag Tool Menu.

Select parameter here.

Or:

Click on the [tool bar] to bring up the Drag Tool Menu:

Drag Tool Bar: 

Drag Tool Menu:

Edit Parameter window:
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2. Select a region or group of regions to make adjustments to.  

3. Drag the blue markers up & down to adjust the parameter and let go.
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4. The parameter change is visible in the Parameter Edit window and the Waveform 
window.

Parameter Edit window:

Waveform window:
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Drag Mode Menu:

Click on the [tool bar] to bring up the Drag Mode Menu:

Drag Mode Toolbar:

Drag Mode Menu:

Drag all selected regions:

This mode simply moves all the selected blue markers and keeps them at the same level 
with each other.  This is used for straight forward editing.
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Drag with linear scaling:

This mode allows linear scaling so that you can have ascending and descending param-
eter values up & down the key range. 

A common use for this mode is to have release times that are short on the top and get 
longer as you go down the keyboard on a piano.

Drag with proportional scaling:

Use this mode to make subtle modifications to a keyboard scaling without disturbing
the basic shape.

Before: Carefully edited parameters.

After: Parameters keep their relationship to each other while editing.
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Scale Resolution:

You can change the sensitivity of the blue markers by changing the Scale Resolution.

Lower Scale Resolution:

Higher Scale Resolution:
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Real-Time Updating:

The Drag Tool [menu bar] will update automatically whenever you switch parameters 
in the Edit Parameters window.

Select a parameter in the Edit Parameters window:

The Drag Tool Menu changes to match:

The blue markers will change position to match the edit changes made in the Edit Pa-
rameters window or in the Waveform window.

Change the parameter value:

The blue markers change to match:
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Changes made with the Drag Tools will also be updated in the other windows as well.

Change to another parameter in the Drag Tool Menu:

The parameter will be selected in the Edit Parameter window:

Change a value with the blue markers:

The parameter value will change in the Edit Parameter window:
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Macros
A Macro is a huge time saving feature that allows you to save any particular parameter 
edit or group of edits to be reused later.  

For example, if you have spent a lot of time coming up with the perfect ADSR and Filter 
settings, you don’t want to have to write them all down and recreate them by hand just 
to use them in another instrument.  Instead, you can save the edits as a macro and in-
stantly apply those hard won settings to another instrument.  

For settings that you use a lot, you can even assign a “hot-key” to any macro.

You can also copy your collection of macros to another GigaStudio system. 

Saving Macros:

To save a new Macro, select the dimension that has the settings you want to save. This 
could be a specific velocity split of a specific dimension split of a particular region.

Once you have selected the region, there are two ways to save the settings as a Macro.

1. [Right-click] on the selected Velocity Split 
and choose “Save articulation as macro” from 
the context menu.

2. Or, simply click on the [Save] Macro button 
at the bottom of the screen.
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3. This will bring up the “Save articulation macro window”

Save as:
Enter the name for the macro here

Hot key:
Type in a key on the keyboard here to create a hot key.  You can also do a combination 
using the [Shift] key combined with any other key.   This key or key combination will in-
stantly apply this macro to any and all regions and dimensions that are selected in the 
editor.  

Set All:
Selects all the parameters.  If you plan to use most of the parameters, click this box.  You 
can then uncheck individual parameters as needed.

Clear All:
Clears the selection of all the parameters.  If you plan to only use a small number of pa-
rameters, click this box.  You can then check individual parameters as needed.

Save:
Once you are finished, this will save the new macro and add it to your list of macros.
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Selecting Parameters:

Click on the check boxes at the left to open and close the parameter lists for each cat-
egory.  These are the same categories that are found in the Instrument Parameters 
window.  

The settings of a macro can range from a single parameter all the way up to every pa-
rameter and any combination in between. 

Click on the check boxes in a parameter category to select individual parameters.



344

Example 1:
Lets say we have created our ideal amplitude envelope, response curve and filter set-
tings.  

1. Select a dimension that has these settings and choose to save the macro.

2. In the Save Macro window, click on the [Clear All] button.  This will uncheck every 
single parameter.  

3. Next, click on the checkboxes for EG1, Filter and Response Curves.

4. This will select all the parameters inside each of these categories.
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5. Assign the macro a name and hot key if you wish and click on the [Save] button.

Anytime this macro is applied to other regions in the future, the EG1, Filter and Re-
sponse settings in this macro will replace those settings on those regions but only these 
settings.  The other categories will be left alone.

Example 2:

In this example, we will only save two specific parameters to a macro. (6dB boost and
Sustain Pedal Defeat)

1. Again, select a dimension that has these settings and choose to save the macro.

2. In the Save Macro window, click on the [Clear All] button again to clear all the param-
eters.

3. Now, open up the Mix/Layer category.

4. Click on the 6dB Boost and Sustain Defeat checkboxes.

5. Give this macro a name and hot key and save it.

6. Anytime this macro is applied to other regions in the future, only these two settings 
will change.  Everything else will stay the same.  
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Applying Macros:

Once you have saved a macro or a collection of macros, you can apply any of them to 
any individual dimension, group of dimensions, region or group of regions.

1. Select all the velocities; dimensions and regions that you wish to apply a macro to.

2. Just like with saving macros, there are two ways to apply macros.

3. Right click on a velocity or dimension split and choose “Apply Macro” from the context 
menu.  Then choose the macro from the list to apply.

4. The macro will then be applied to every selected region and dimension.

5. You can also right click on a region or 
group of regions and apply the macro 
from there.  
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Copying Macros to other machines:

It is very easy to transfer your collection of macros to another machine.
This transfers the whole list and overwrites the existing macros of the machine you are 
copying them to.

The macro file can be found in the Tascam program files folder.
It is called GsEditMacros

C:\Program Files\Tascam\Gstudio

To copy your collection of macros to another machine, just copy this file from here and
put it in the same folder on the other machine and replace the one that is there.  The 
next time you open the GigaStudio Editor on the new machine, these macros will be 
waiting for you there.
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Macro Edit Screen:

1. Click on the Macro [Edit] button at the bottom of the screen.

2. This will bring up the Articulation Macros Edit window.

3. In this window you can change the names and hot keys of the macros and delete 
them.

4. Double click on a macro or choose a macro and click on the [Properties] button to edit 
the Name and Hot key.  Rename it and change or add a Hot key and click on the [OK] 
button to apply the changes.

5. To delete a macro, select it from the list and click on the [Delete] button.

6. When you are finished making changes and deleting macros, click on the [OK] button
to apply these changes.   If you make a mistake, just click [cancel] instead of [OK].  This 
will discard any changes made and any mistakes.
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Copy & Past Articulation:

This command will copy all the parameters of a dimension and paste them elsewhere.  
It will overwrite all the parameters at once with the copied settings.

1. To copy & past an articulation, select a dimension that has the parameter settings you 
want to copy.  

2. Right click on the dimension and choose “Copy articulation” from the context menu.

3. Choose the regions and dimension splits to paste the settings to.

4. Right click on one of the dimensions of the selected regions and choose 
“Past articulation” from the context menu.

5. This will instantly change all the parameters to match the copied parameters.



350



351

Setting up the iMIDI Rules
The iMIDI Tools are enabled in one of two ways:

•In the GigaStudio Interface and saved as part of a performance file.

•In the Instrument Editor and built into the .GIG file.

GigaStudio Interface Setup:

1. The instrument that you want to setup needs to be loaded into the GigaStudio first.

2. In the Loaded Instrument Panel, [right-click] on the loaded instrument and choose 
“iMIDI Rule Manager…” from the Context Menu that comes up.

3. Add, Initialize & edit your iMIDI Rules of choice.  Click on [OK] to apply the rule to the 
instrument. 
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4. Save the instrument as a performance instrument.  Use the instrument performance 
option or custom performance settings to save just the Instrument settings with the 
performance.

5. In the future, when this performance is loaded, the iMIDI Rules will be loaded along 
with the instrument.  The iMIDI Rules are not part of the .GIG file though.  These can be
embedded as part of the .GIG file in the Instrument Editor.

Instrument Editor Setup:

1. The instrument that you want to setup needs to be loaded in the Editor and Loaded to 
a MIDI channel and playable. Otherwise, the iMIDI Rule Manager will be disabled.

2. [Right-click] on the Instrument & Bank window and choose “iMIDI Rule Manager…” 
from the context menu that comes up.



353

3. Add, Initialize & edit your iMIDI Rules of choice.  Click on [OK] to apply the rule to the 
instrument. 

4. Save the .GIG file to embed these rules.  

5. From now on, anytime this .GIG file is loaded, the iMIDI Rules will be loaded as well.
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Adding, Initializing and Editing iMIDI Rules:

1. Select a rule from the “Available Rules” window and click on the [Add] button.

2. Depending on the rule, you may get an initialization screen.  Fill in the necessary de-
tails in the initialization window and click [OK].  See the individual rule lessons for each 
rule for details on the initialize settings.

Pattern Alternator Initialize window:
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3. Click on the [Edit] button to edit the settings of the rule. See the lessons on each rule 
for details on editing.

4. Click on the [X] icon to delete rules from the Active Rules list.

5. Use the [Up & Down] arrows to change the order of the rules in the Active Rules list.

6. When you are finished adding & editing rules, click on [OK] to close the Rule Manager
window.
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Transpose Keyboard
This rule is real simple.  It transposes the keyboard range in half steps up to two octaves 
up or down.  

There are three ways to adjust this setting:

•Move the slider left to right with the mouse.

•Click on the slider and then use the left and right arrow keys on the computer  
  keyboard.

•Enter the number in the number box.



358



359

Filter MIDI
This tool allows you to filter any type MIDI event or group of events so that the GigaStu-
dio will ignore them.  It can be real handy to be able to selectively ignore various MIDI 
events.  

Click on all of the check boxes of any event that you want to be ignored by the instru-
ment.  

Use the scrollbar to access all the MIDI Controllers.  

The [Reset All] button will uncheck all the check boxes.

The [Filter All] button will fill in all the check boxes.
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Legato Mode Rule
“A special thanks to the Vienna Symphonic Library team and specifically Christian
Teuscher, for certain rules of iMidi which have been modeled to emulate the original VSL 
Performance Tool v1 – in particular the Legato, Alternation and Repetition modes”

The Legato Mode tool allows you to play authentic legato lines in real-time on your 
keyboard.  This tool creates the most stunning and realistic note-to-note transitions 
ever. These can be used for a long portamento slides to notes or for natural legato note 
transitions.  The tool automatically takes care of the complex dimension switching in 
real-time as you play the keyboard.

This requires some very meticulous sampling sessions to capture all the intervals, 
speeds and loudness levels but the results are as realistic as can be.  

The nice thing about this tool is that you only to play the keyboard a certain way.  There 
is no need for Key-Switching or MIDI sequence editing.  The tool does all the connecting 
work in real time as you play.  All that is required is that you hold down one note while 
playing the next note in a phrase to connect those two notes.  To avoid connecting the 
notes, you lift off a note before triggering the next note.  

Examples:

There are some audio examples of what this tool sounds like to listen to.  
These can be found in the “Editor Tutorial Files” directory for this chapter.  
(Legato Mode Rule)

Trumpet Without Legato.wav

Trumpet With Legato.wav

Cellos Portamento Legato.wav

This is how most sampled instruments sound.  There is no connectivity between 
the notes.

Now we here the same instrument with this Legato Mode.  Notice how the note 
connect together seamlessly and realistically.  

Here we use the longer portamento slides.  You don’t want to over use this 
though because it can be unrealistic.  Its best used as needed for dramatic or ro-
mantic slides to particular notes depending on the music context. 
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Instrument Components:

A Legato Mode instrument requires several types of samples.  

•Default Sustain Samples:
•Up & Down Interval Samples to and from every note from half step to an octave  
  leap:
•Release trigger samples:
•Alternate Sustain Samples:

These complex instruments can range from 500-2000 samples or more.

The Vienna performance libraries have been recorded to this extent and this tool will 
work with any 3.0 GigaStudio versions of the Vienna Legato instruments.  
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Using a Legato Mode Instrument:

If you have a 3.0 Legato Mode instrument, using it is very simple.  A couple of legato in-
struments are included with the GigaStudio 3.0 package.    

These are in the Vienna Symphonic  Library demo instruments folder.    

VSL-Viola Ensemble Legato.gig
VSL-Clarinet Legato.gig

Load any of these instruments to a MIDI channel and start playing.  Hold down a note 
while playing another note within an octave to hear the legato effect.  Other than that, 
there are a couple of settings that you can work with to customize the feel and trigger 
alternative sounds.

Settings:
There are some settings to customize how the Legato Mode works and to access some 
of the extra samples.  To get to these, you need to open the iMIDI Rule manager.  

[Right-click] on the loaded instrument in the loaded instruments window and choose 
“iMIDI Rule Manager” from the context menu.  
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Click on the [Edit] button for the active Legato Rule to bring up the Legato Mode control 
panel.

Legato Mode Control Panel:

Play Zone:
The Legato Rule will automatically discern the key range of the instrument if the in-
strument is fairly simple and has one obvious key range of regions.  If needed, you can 
change the note range here.  

Number of Legato Samples:
Displays the number of Legato Articulations. For the time being this will always be 12.  

Ghost Key (Bypass):
This controller will mute the Default Sustain samples until you release it.  This function 
makes it possible to start a legato passage with any other articulation from another 
MIDI track.  For instance from a crescendo diminuendo or sustain with a harder attack.  
The key is released when you want to slide to a note.  

Keyboard: Set the MIDI key that will bypass the default starting note.  

MIDI Controller: Use a MIDI controller instead of a MIDI note.  
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Release Trigger Key:
Triggering this Key will allow you to have the last note of a phrase end with a special 
release sample.  Press the trigger note once the last note is played.  The release trigger 
sample will play when you letup.

Alternate Non-Legato Key 1 & 2:
These keys provide alternate sustaining samples when pressed.  You can toggle be-
tween the default sustain these alternate sustain articulations by pressing these keys 
between notes. This is good for repeating the same note within a phrase.  Instead of 
triggering a fresh starting note, you can trigger one of these alternate samples.  

Legato Threshold Time:
This setting can help the Legato Mode tool adapt to your performance technique on the 
keyboard.  The threshold sets the time in which the tool will recognize two consecutive 
notes as a legato transition.  Experiment with this setting until it works best for you.  
Ideally, the Release Time and Threshold Time should be set to the same value.

Release Time:
This sets the delay time of the note-off.  This value should match the Legato Threshold 
setting.
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Saving the Settings:

To save these settings so that they reload with the instrument, you need to save a cus-
tom instrument performance.  

That performance will then load this instrument with these settings.  If you were to just 
load the .GIG file again without using the performance, then the default settings will be
loaded again instead. 

If you would prefer to hardwire these settings into the .GIG file you can do that too.  

•Open the .GIG file in the Editor.  
•Then [right-click] on the Bank/Instrument Window on an instrument and choose      
  the iMIDI Rule Manager from the context menu.  
•Make the settings as before and then save the .GIG file.  

Then whenever the instruments of this .GIG file are loaded, these user settings will also
be remembered.
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Mapping & Creating a Legato Mode Instrument

Required Samples Articulations:

Default Sustain Samples:
You need some basic long sustaining samples to serve as your default sample.  This is 
the articulation that plays first before sliding to another note.

Release Trigger Samples:
If you want to have the natural sound of the instrument release or some natural room 
or hall ambience, you will need to create some standard release trigger samples.  This 
is usually done by creating a copy of the sustain samples and then deleting everything 
except the tail.  Release samples are optional.

Alternate Samples:
There is room in a Legato Mode instrument for two alternate variations for the sustain-
ing samples.   Alternate Samples are optional.

Legato Samples:
To do a complete Legato Mode instrument, you will need recordings of the instrument 
sliding to and from every interval for every note.  The recording starts on the original 
note, then slides to the interval and holds the note.  The length of this hold should 
match the Default Sustain Samples.  The samples are then trimmed right at slide leav-
ing a little bit of the original note in the samples.   Like the release trigger samples, a 
little experimenting will be necessary to get the right sound.
To save sample space & recording time, you can skip every other note or every third 
note as is done with other samples.  You don’t want to go further than every third note 
though or the timing of the slides will be too noticeable.  

The end result needs to be 24 folders of legato samples.  
12 Up and 12 Down.  
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Sample Articulation Order:

To create a Legato Mode instrument, you need to have these articulations mapped in a 
certain order, using a 32 split Smart MIDI dimension split.

The best way to create this is to start by creating individual instruments for each articu-
lation.  (Sustain, Release, Alternate 1 & 2, Legato up x 12, Legato down x 12) 

Then use the Combine Tool to assemble them in the proper order.  

32 Splits-Smart MIDI dimension:

01 Legato Up 1 (half step)
02 Legato Up 2 (whole step)
03 Legato Up 3 (minor 3rd)
04 Legato Up 4 (Major 3rd)
05 Legato Up 5 (Perfect 4th)
06 Legato Up 6 (dim 5th)
07 Legato Up 7 (Perfect 5th)
08 Legato Up 8 (minor 6th)
09 Legato Up 9 (Major 6th)
10 Legato Up 10 (minor 7th)
11 Legato Up 11 (Major 7th)
12 Legato Up 12 (Octave)
13 Blank
14 Blank
15 Blank
16 Blank

17 Legato Down 1 (half step)
18 Legato Down 2 (whole step)
19 Legato Down 3 (minor 3rd)
20 Legato Down 4 (Major 3rd)
21 Legato Down 5 (Perfect 4th)
22 Legato Down 6 (dim 5th)
23 Legato Down 7 (Perfect 5th)
24 Legato Down 8 (minor 6th)
25 Legato Down 9 (Major 6th)
26 Legato Down 10 (minor 7th)
27 Legato Down 11 (Major 7th)
28 Legato Down 12 (Octave)
29 Default Sustain
30 Alternate Sustain-1
31 Alternate Sustain-2
32 Release Trigger

The instrument then needs to be saved to disk and loaded to a MIDI channel in the Edi-
tor to add the iMIDI Rule to it.
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Rule setup:

[Right-click] on the Bank Instrument window on an instrument and choose iMIDI rule 
manager from the context menu.

In the iMIDI rule manager, select and add the Legato rule.  

This will bring up the Legato Mode initialization window.  The settings in the initialize 
window are basically custom user settings. Enter some default settings and then click 
the [OK] button.  

Do this for each legato instrument in the .GIG file if there is more than one.

Click the [OK] button to exit the iMIDI rule manager and apply the changes and save 
the .GIG file.  

Now the Legato Mode tool is built into the .GIG file and it will always be enabled any-
time the instrument or instruments from this file are loaded into the GigaStudio.  The
user just needs to load & play the instrument & adjust the various settings in the iMIDI 
rule manager as needed.  
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Pattern Alternator

The Pattern Alternator acts like an automatic key-switcher.  It changes articulations 
on the fly as you play the notes on the keyboard.  Every note you hit advances to another
articulation instantly. 

The order of the articulations is totally customizable by the composer.  Key-Switches 
are very handy but it can be difficult to change them fast enough in real time for cer-
tain types of music.  Round-Robin does this real time changing but only in a certain 
repetitive order.  With the Pattern Alternator, you can have the advantages of both of 
these tools in real time.

Playing & Editing the Patterns:

 Load the Vienna Symphonic Library “Bass Ensemble-Pattern Alternator.GIG” file from
the Vienna Symphonic Library demo instrument folder and play some notes.

 You will notice it automatically changes between all the articulations in order.  This 
is the default setup when opening the instrument.

NOTE: Don’t play chords at this point.  It is not in polyphony mode at this point.  
Chords will jump several articulations until you put it in polyphony mode.

Staccato-Quarter Note-8th Note-Sustain-Sfz-pfp-Tremolo-Pizzicato. 
Then it goes back to Staccato and starts again.  

However, we can change and customize the order that these are triggered.

Opening the Pattern Alternator window:

If you are in the GigaStudio interface, [right+click] on the Bass Ensemble-Pattern 
Alternator instrument in the Loaded Instruments window and choose “iMIDI Rule Man-
ager” from the context menu.  
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If you are in the Instrument Editor, Make sure the instrument is loaded and playable.  
(Green Light is On)  

Then [right+click] in the Bank-Instrument area and choose “iMIDI Rule Manager” 
from the context Menu.

In the iMIDI Rule window you will see that the Pattern Alternator is already in the 
“Active Rules” area.  
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Click on the [Edit] button to bring up the pattern screen.

Watch the Patterns in Action:

Play the keyboard again and watch how the articulations advance from left to right 
each time you play a note in the top pattern.  Also notice how the names of the articula-
tions change in real time as well.  This helps you identify which articulation is assigned 
to which number in the pattern.

The first note is staccato:  When released it will advance to the next articulation in
the list.  
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The next note played advances to the next articulation:  (Quarter Note) 

Then the 8th Note articulation:

Then Sustain:

This will continue through the rest of the 8 articulations and back to the beginning 
again.  This pattern will repeat until you change to another pattern with a MIDI control-
ler or a Key-Switch.
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Changing the Articulation Order of a Pattern:

However, this is the default setting and it just rotates like a round-robin through the 
8 articulations of this instrument in their order.  You can change the order of these ar-
ticulations by changing the numbers in the pattern.  

Click on one of the numbers and use the [Up & Down] keys to change the number.  

Use the [Left & Right] keys to select other numbers in the pattern.  

Change some of the numbers around and play the keyboard again and notice the 
difference in the order of articulations.

Changing the Amount of Articulations in a Pattern:

At this point, we have 8 articulations to a pattern.  However, we can change that 
number by dragging on the articulation amount with the mouse.

Or you can click on the articulation amount and enter a number with the keyboard.
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This enables us to have a simpler or more complex pattern.  For example, you might 
just want a simple 3-part pattern that gives you two short notes followed by a longer 
note.  In this case we would set the articulation amount to “3” and change the pattern 
to something like 1-1-2.  (Staccato-Staccato-Quarter Note repeating)  

This enables the Pattern Alternator to act like a customizable Round-Robin device.  

Note: There is a Round-Robin dimension in the GigaStudio but it changes on a note-
by-note basis.  With the Pattern Alternator, the articulation changes every time you 
hit any note at all.  With the Round-Robin dimension, the articulations only change for 
individual notes.  (One note might be on the next articulation while the others that 
have not been played are still on their first.) The Round-Robin dimension is very handy
for having a variety of staccato or drum samples but it is not useful for changing more 
drastically differing articulations like this current example instrument.  To achieve the 
type of Round-Robin that most composers are familiar with, the Pattern Alternator is 
the way to go.  

On the other hand, you might want a very complex pattern that covers a whole 
phrase or line of music.  In that case you increase the articulation amount to as many 
notes as you need up to a maximum of 32.  Then you change the articulations to cover 
your musical phrase note by note.  

Multiple Patterns

So far we have covered a single pattern.  However, we can have up to 32 of these pat-
terns to work with.  Click on the [New] button to add more patterns.

Each pattern can be given a custom name as well.  Just 
[double-click] on the name and change it.
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MIDI Controller Pattern Selection

You can use a MIDI controller or the keyboard (like a Key-Switch) to change between 
these patterns.  In the pattern selector, select a controller or a Key-Switch range to 
change between the patterns.

No Selection:

MIDI Controller Selected:

Key-Switch Selected (Most Common method):

Once you have the patterns you want for a song, you can save an instrument perfor-
mance (.GSI GigaStudio Instrument File) that only saves these changes without affect-
ing the default instrument or overall performance setup of the GigaStudio.  This allows 
you to save custom Pattern Articulation setups for each song you are working on for a 
particular instrument.  When you compose, you can keep all your GigaStudio Instru-
ment performances and your main overall GigaStudio Performance files in a special
folder for each song you work on.

Details on creating your own Pattern Alternator instruments can be found in the Edi-
tor Documentation in the iMIDI Rules section.  
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Controller Trigger
The Controller Trigger allows any MIDI controller to trigger any MIDI note and for con-
tinuous controllers it is velocity sensitive.  The faster you move the controller, the louder 
the sample plays back. 

Controller:

Use the controller dropdown to select 
any of the available MIDI controllers.
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Trigger Point Details:

Trigger point:

This sets the exact spot in the continuous controller range (from 0-127) that the trigger 
will occur.   For example, you can have the Mod-Wheel trigger a note at its halfway point 
with a value of 64.

Ascending & Descending:

This determines weather the controller triggers the MIDI Note when it is moving for-
ward or backward.  You can use more than one rule to have the controller trigger the 
note from both directions.

Note to Trigger:

This sets the MIDI Note that will be triggered by the MIDI controller.

Note On & Note Off:

This sets weather the MIDI controller triggers a Note on or Note off.

Override Pedal:

This checkbox only shows up when you have selected “Note Off:  
Checking this enables the MIDI controller to perform a Note Off even if the sustain 
pedal is down.
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Velocity Section:

Tracking Sensitivity:

When using a continuous MIDI controller, you can have velocity sensitivity.  The faster 
you move the controller, the louder the MIDI note will play.  Slower movements will play 
the note back softer.  This setting allows you to tweak the velocity sensitivity of how the 
GigaStudio responds to the MIDI controller.

Switch Controller Logic Enabled:

This check box and Velocity setting are for pedal switch type controllers that are not 
continuous.  Pedal switches are not velocity sensitive but we can set the trigger velocity 
here.  If you setting up a switch pedal to trigger a note, check this check box and set the 
velocity level to trigger.
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Add & Remove Buttons:

Once you have created a controller trigger, click on the [Add] button to add it to the list.

You can add several custom trigger controllers for some complex effects.  

For example, here we have the Mod-Wheel triggering a small scale when pushed for-
ward.  (C-D-E-F-G)

Use the [Remove] button to delete any item in the list.  
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Release Trigger with Tracking
This is a simple looking tool that does some very fancy work.  

•When using Release Trigger dimensions, this tool tracks the volume of the 
  samples as they play.  
•When the note is released, the release trigger plays back at an appropriate 
  volume based on how loud the sample was when it was released.
•It can track the voice parameters such as the ADSR envelopes and base the 
  release trigger playback volume based on the position of the envelope. 
•It can also track both the parameters and the signal level.  

This tool was created to deal with some of the sample libraries that rely on the real hall 
ambience of the room they were recorded in for a lush and authentic reverb tail.  

By putting the release of the recordings on the release trigger, the results are stunning.  
However, there is a problem with this method. Sometimes the samples are expressive 
and use diminuendos & crescendos or simply fade out.  The problem comes in when 
you try to release the hall ambience when the sample has died out or is at a low point 
in its volume.  This tool solves that problem by constantly tracking the signal level of 
each samples and setting the volume of the release trigger samples accordingly.  

Check one of the options and click [OK] to enable this tool:
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The Rule Builder

•This tool allows you to build custom sets of MIDI rules into an instrument.  

•It can take any incoming MIDI event at any range and have it trigger any other  
  kind of MIDI event with its own range of settings.  

•You can also monitor incoming MIDI events in real time at the bottom of the  
  screen.  

•It is the equivalent of having a built in high end MIDI processor. 

•The rule builder enables library developers to create custom MIDI responses and  
  filters for their instruments.  
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Design a Custom Filter:

This is the section where MIDI rules are designed.

Incoming MIDI: Event

Incoming MIDI: Data-1

Incoming MIDI: Data-2

Select an incoming MIDI event type from the drop down list.  

•This will change depending on the type of incoming MIDI event.  
•For Note On & Off the data will be in Note Names. (C-1 – G9)
•For all the other controllers the data will be in MIDI control numbers. (0-127)
•Set a minimum and maximum value.  Use the incoming MIDI data window at  
  the bottom of this window to help figure out what Notes or MIDI controller
  numbers to use.

•This will also change depending on the type of incoming MIDI event.
•For Note On & Off the data will be Velocity Levels. (0-127)
•For all the other controllers, the data will be in MIDI control numbers. (0-127)
•Set a minimum and maximum value.

Filtered MIDI: Event

Select the outgoing MIDI event type from the dropdown list.

Use Data 1 from incoming:

This overrides the values entered here and lets whatever values are in the Incom-
ing Data-1 section determine the range instead
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Filtered MIDI: Data-1

Use Data 2 from incoming:

•This will change depending on the type of Filtered MIDI event.  
•For Note On & Off the data will be in Note Names. (C-1 – G9)
•For all the other controllers the data will be in MIDI control numbers. (0-127)
•Set a minimum and maximum value.  Use the incoming MIDI data window at  
  the bottom of this window to help figure out what Notes or MIDI controller  
  numbers to use.

This overrides the values entered here and lets whatever values are in the Incom-
ing Data-2 section determine the range instead.

Filtered MIDI: Data-2

•This will also change depending on the type of Filtered MIDI event.
•For Note On & Off the data will be Velocity Levels. (0-127)
•For all the other controllers, the data will be in MIDI control numbers. (0-127)
•Set a minimum and maximum value.

Use Data 1 from incoming:

This works like before and overrides the values entered here and lets whatever 
values are in the Incoming Data-1 section determine the range instead.

Use Data 2 from incoming:

This works like before and overrides the values entered here and lets whatever 
values are in the Incoming Data-2 section determine the range instead.

Add New Filter:

Click to add the current filter to the Filter List.  You can add several filters at once,
each with their own custom settings.

Modify Existing Filter:

Choose an existing Filter from the Filter List to edit it.  This avoids having to cre-
ate an existing filter from scratch.
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Delete & Up/Down arrows:

Select any Filter from the Filter List and delete it or move it up & down with these but-
tons.

Filter List:

All the filters that are created and added appear in this list. From this list, you can select,
delete and reorder the filters.  The menus in the Filter List reflect the various settings
from the Filter Design area.  

MIDI Activity Window:

•This window tracks every incoming MIDI event and puts it in this list.  
•This is real helpful for discerning the MIDI controller numbers.  Just play a note or  
  controller and look at the list to see what it is.  
•To clear the list, close the interface and reopen it.

Experiment away with this tool.  The possibilities are endless!


